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Preface

The Oracle Retail Price Management User Guide describes the application’s user
interface and how to navigate through it.

Audience

This document is intended for the users and administrators of Oracle Retail Price
Management. This may include merchandisers, buyers, and business analysts.

Related Documents

For more information, see the following documents: in the Oracle Retail Price
Management Release 12.0.3 documentation set:

*  Oracle Retail Merchandising Batch Schedule

=  Oracle Retail Merchandising Implementation Guide
=  Oracle Retail Price Management Release Notes

= Oracle Retail Price Management Installation Guide
=  Oracle Retail Price Management Operations Guide
=  Oracle Retail Price Management Data Model

*  Oracle Retail Price Management Online Help

Customer Support

=  https://metalink.oracle.com

When contacting Customer Support, please provide:

= Product version and program/module name.

=  Functional and technical description of the problem (include business impact).
* Detailed step-by-step instructions to recreate.

= Exact error message received.

=  Screen shots of each step you take.

Conventions

Navigate: This is a navigate statement. It tells you how to get to the start of the procedure
and ends with a screen shot of the starting point and the statement “the Window Name
window opens.”

Note: This is a note. It is used to call out information that is
important, but not necessarily part of the procedure.

This is a code sample
It is used to display examples of code

A hyperlink appears like this.-
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Welcome to Oracle Retail Price Management

Oracle® Retail Price Management (RPM) is a strategy based pricing solution that
suggests and assists with pricing decisions. With RPM, you are empowered to automate
and streamline pricing strategies across the organization and yield a more predictable
and profitable outcome. It provides decision support to all pricing-focused business
information at your fingertips to validate and approve pricing and markdown
suggestions. This approach results in higher margins, increased sales and strengthened

productivity, all while remaining competitive.

Business Process

System Options

Pricing

System Options

Codes
Calendars

Price Guides
Candidate Rules
Zone Structures
Location Move

Retrieve an Item Price

Pricing Strategies

Worksheets

Price Strategies

Area Differential Pricing

Clearance Pricing

Clearance Defaults Pricing

Create a competitive pricing strategy
Margin Pricing

Maintain Margin Pricing

Worksheet

Welcome to Oracle Retail Price Management 1



Business Process

Price Changes
= Retrieve an Item Price

=  Price Changes

Clearances

= (Clearance

Promotions
=  Promotions

2 Oracle Retail Price Management



2
Navigate RPM

Navigate RPM

This section provides instructions on how to navigate through RPM:
= Access the Workspace

= View the Workspace

= Resize Elements of the Workspace

= Look up Field Level Data

= Search For and Filter Records
Access the Workspace

Log in to RPM

How you access Oracle Retail Price Management depends on how the application is set
up at your location. Contact your system administrator for instructions. Use the exit
procedure when you are done using the application.

Exit RPM

There are a few ways you can log out of and close RPM. You can:
= (lick Logout in the global links area of the header.
= Select Close Window from the File menu.

= Select Exit from the File menu.

= (Click the close button on the title bar.

If any tasks are open, you are prompted to confirm your decision to log out.

Navigate RPM 3



View the Workspace

View the Workspace

After logging into RPM, you have access to the application window. The primary
elements in the application window are as follows:

A =]k

Walcama: Alain Frecon

h Create Price Change D

Tasks
(=N rom 'l =) Price change st H

Sy by Opticns r
Foundabion Prca Changa J'

Agyregaticn Lawel
:::::::" | Filber by 3 Fiter by EI Filgr by
Calasridar
Cardidats fudes
Closrances

Promaticn Evants
Proiathens

Promotien Threshold
Promotion Densbrainks
Wandor Fundeng Daleults
Pricirsg $lrategy

m | Liakk Codle | T :H Thess Diesariph Thems Lewel | Dillf 1D | Dt 10 nm.-1 Lecatson | L«.u-tnl]thi Ladation l\':pF
] =

Fiker by T | Al b T | Sver by 3 Filear by )| Filter by vI Fubgr by vI Filer by

Worksheat

Link Coas

Markat Baskat Codes 1 | N
,,,,,, b ] =]

« Maintain Price Charges | fav
o Aute Approve Results | () Price Change Haintenance

cancel || save + Fepeat ][ pone |
[ Erita Prica changa | F %[ ] || -
The RPM Workspace
The workspace is comprised of all the elements within the application window. You
manage the application and perform tasks within the workspace. Many of the elements
within the workspace can be minimized, maximized, or manually resized. This allows
you to customize the workspace to fit your work habits. Any changes you make are
remembered by the application. The next time you log in, the elements appear as you last

left them.

Element Purpose

A Title bar Located at the top of the window. The title bar displays the product name. The
three buttons at the far right on the title bar allow you to minimize, restore,
maximize, and close the application window.

B Header Located below the title bar. The header provides access to commands that
remain static across all tasks. The menu bar and welcome message appear here.

C Toolbar Located below the header. The toolbar contains paging control icons.

D Workspace Located next to the task pad and below the toolbar. What appears in the
workspace depends on what you select on the task pad. The workspace is
where you complete the tasks assigned to you.

4 Oracle Retail Price Management



Navigate RPM

Element Purpose
E Task pad Located on the left side of the application window. From top to bottom, you can
access an application, a task group, and then a task. When you select a task, the
contents of the task are displayed in the workspace.
Note: The Simplified RPM task pad may display a different navigational menu.
ORACLE’
Elrem =
Foundation
Link Codes
Zone Structure
Price Guides
Price Changes
tlearances
Promotion Events
Promotions
Promotion Threshold )
Promotion Constraints
Vendor Funding Defaults |
Conflict theck Results
View Tasks
Price Inquiry 4
(= system Dpﬁnn;
» System Dptions Edit
+ System Dptions View
+ System Defaults Edit
. System Defaults View
Simplified RPM Task Pad
F Task bar Located at the bottom of the window. Task buttons, located on the task bar

G Status bar

H Pane

Task

allow you to switch between open tasks.

Located at the bottom of the window. The status bar lists the status of a task and
gives other information.

A sub-section of a window that appears in the work space. Multiple panes may
appear in the workspace when a task is selected.

A pane or a group of panes that appear in the workspace, allowing you to work.

Navigate RPM 5



Resize Elements of the Workspace

Resize Elements of the Workspace

The benefits of resizing become apparent as you customize the workspace to fit your
work habits. You can hide or minimize elements that do not pertain to the current task.
You can show or maximize the elements that are of greater importance.

The RPM Window

You can resize the RPM window in order to increase or decrease the amount of space it
occupies on your desktop.

* To manually resize the window, place the cursor over the edge of the window. When
the cursor changes to a double arrow, press and hold the left mouse button. Move the
cursor until the window is the desired size. Release the left mouse button.

(] [ ¢

Minimize and maximize the RPM window

= To minimize the window, click the minimize icon (A).
* To maximize the window, click the maximize icon (B).
= To restore the window to its previous size, click the restore icon (C).

= As an alternative method for resizing the window, right click on the RPM button
found on the Microsoft Windows task bar. On the context menu that appears, select
Restore, Minimize, or Maximize.

Toolbar

Although the toolbar occupies relatively little space in the window, you can choose to
hide it or show it.

=) [O] ¢

Alerts | Logout (=)

RPM toolbar

= To collapse the toolbar (A), click the expand/collapse toolbar icon (B). The icon is
located on the far right side of the header.

= To expand the toolbar, click again on the same icon.

6 Oracle Retail Price Management
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Workspace

The workspace is likely to be the most used element in the application. As such, you may
want to maximize its size. Should you need to access the task pad, restore the content
area to its original size.

Yiew

(= |remMm B2

Foundaton

Aggregation Level

Yiew Wealcam

RPM workspace

= To expand the workspace (A), click the explode icon (B). The icon is located on the
upper left corner of the content area. The content area expands to the width of the
window. The task pad and the toolbar disappear.

= To restore the window to it’s original size, click again on the same icon. The task pad
and toolbar reappear.

Navigate RPM 7



Resize Elements of the Workspace

Task Pad

The task pad provides access to the tasks assigned to you. Once you are working on a
task, you may want to reduce the size of the task pad. You may want to increase the size
of the task pad in order to see the full names of the task. As you increase or decrease the
width of the task pad, the width of the workspace is resized proportionally.

Note: The Simplified RPM task pad may display a different
navigational menu.

ORACLE: 1R

File Viaw Help Welcarne: Alain Fracon Alerts | Logout i

El|rem =
Foundation

Link Codes

Zone Structure

Price Guides

Price Changes

tlearances

Promotion Evants

Promotions

Promotion Threshold

Promotion Constraints A
Vendor Funding Defaults (|
conflict theck Results

View Tasks

Price Inquiry B

(=’ System Options

. System Dptions Edit

+ System Dptions View
- System Defaults Edit
. System Defaults View

= i

Simplified RPM Task Pad

= To maximize the task pad, click the right arrow on the separator bar (A). To
minimize the task pad, click the left arrow. Note that the width of the task pad can be
one of three sizes:
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e =]
Foundation

Aggregation Level
fone Sbucture
Price Guides

Calendar
Candidate Rules

Price Changes

Clearances

Promobon Events

Promobons

Promotion Threshold
Promobon Constraints A
= n\‘
Yendor Funding Defaults
Pricing 5trategy
Worksheet
Link Codes
Market Basket Codes

R ——

E System Dplions

+ Systermn Dptons Edit

+ System OpbHons Wiew
+ Systemn Defaults Edit
+ Systemn Defaults ¥Wiew

>’a

e

U

RPM task pad
— maximized to the width of the application window.

— minimized to where it is no longer visible.

— restored to its previous size.

To manually resize the width of the task pad or the length of the work areas within
the task pad, place the cursor over the desired resizer (B). When the cursor changes
to a left/right (or an up/down) arrow, press and hold the left mouse button. Drag
the resizer until the task pad or work area is the desired size. Release the mouse

button.
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Look up Field Level Data

Pane

One or more panes appear in the workspace when you select a task on the task pad. You
can collapse a pane so that it does not distract you from the panes you want to work in.
Only the title bar of the container is displayed after you collapse it. When you are ready
to work in the collapsed container, you can then return it to its regular size.

B3 create Price Change

I"'C;_‘f_:i_ce Change List A |
——
Price Change B " &
I Link Code Item Item Descript ITtem Level Diff ID Diff ID Descri| Location Location Desq Location Typd

Fitker by E | Filkar by:a | Filkar by:E | Fitkar by:E | Fitker by E | Filkar by:a | Filkar by:E | Fitkar by:E | Fitker by E | Filkar by:a

4] 1 2
= 1
/C
| / Mew |
I-"(_‘-ﬂ’;ri:e Change Maintenance A |
RPM pane

= To collapse a pane (A), click the collapse icon (B).

= To expand a pane, click the expand icon (C).

Look up Field Level Data

The basic method for entering data in a text field is to type the text in the field. Some
fields are restricted, however, as to the type of data that may be entered. The options for
entering or selecting data depend on the type of data that may be required or permitted
in the field. For example, some fields permit only numeric data, while others permit only
alphabetic or alphanumeric data. Some fields require a date to be entered in a specific
format. Some fields permit only one value, while others permit multiple values.

Calendars, drop-down lists, lists of values, and transfer boxes provide you with access to
preformatted, predefined values. Instructions for using these tools are provided below.
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Drop-down List

Some fields are restricted to a predefined list of values. You access a drop-down list from
which you can pick the desired value.

Itern Lavel

Tran Level

Parent Level
Ciffl Level
Ciffz Level
Ciff3 Level

fhar by :l FitaDiff4 Level

ice Change Indici Con

=T

Ciff Type Level
I I

Drop-down list
1. Click on the drop-down arrow (A) next to a field. A list of predefined values appears.

2. Scroll through the list until the desired value appears. Select the value. The field is
automatically filled in with the selected value.

List of Values

When a drop-down list has many values, you can typically access them from the list of
values (LOV) button.

Navigate RPM 11



Look up Field Level Data

@ Price Guide Create

I

LR

List of values

12 Oracle Retail Price Management

USD | %Tus Dollar |
I,

Code Descripton

Filker by B Filkar by : b
ADP Andorran Peseta 3
AED UAE Dirham

AFA Afghani |
ALL Lek

AMD Armenian Dram

AMG Metherlands Antillian Guilder

ACA Kwanza

ARE Argentine Peso

ATS Schilling

ALD australian Dollar

AlG Aruban Suilder

AZM Azerbaijanian Manat

B A Convertible Marks

BELD Barbadaos Dollar

BDT Taka

BEF Belgian Franc

BiSL Leuw

B Bulgarian Lew

BHD Bahraini Dinar -
FC D 1-123 of 122

| Cancel Il Salact I




Navigate RPM

1. Click the LOV &l button next to a text field (A). The list of values opens. The number
of values in the list and the total number of values appears at the bottom (D) of the
LOV.
= Click the page icon (C) to open the Paging Configuration window and adjust the

page size and page links.

Paging Configuration ['5_<|

Page Size 1|:||:| |

Visible Page Links |5 |

Cancel

Paging Configuration window

2. To find a value, use one or a combination of the following methods:
=  Scroll through the list.

= Enter a partial value in the Filter by text box (B) and press Enter. Select the
desired value from the results.

= Select the down arrow next to the Filter by text box (B) and use the Advanced
Filter option. Enter conditions in the Advanced Filter and click OK.

= Enter the wildcard (%) and letters before or after it in the Filter by text box (B) to
limit values.

3. Select the value and click Select. The field is automatically filled in with the selected
value.
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Multi-select List of Values

Some lists of value allow you to select more than one value. Multi-select LOV B+ button
allows a user to select multiple rows in a single block by using the Shift and Control keys.
The functionality is similar to the select functionality of other Windows applications.

&%,
In Description
Fitbar by E Filkar by =
f f B
T Acé
SIMREEG1 Externally generated Price Change
tast tast o
AREADIFFA& Area Diff Aute Approve Price Change
Joes Code Joes Drescription
RegCodeMew newlbesc =
= 1-16 of 16
I |
1] | Description
Filkay by * " Filkay by b
Cancel || Select

Multi-select list of values

Open the Multi-select LOV

= (Click the LOV % button next to a text field, or click the down arrow. The list of
values opens.

Select Continuous Information
1. Selectarow.
2. Press Shift and click on another row to select all the rows in between, inclusively.
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Select Non-Continuous Information
1. Select a row.

2. Control click on rows to select or clear the individual rows clicked on (depending on
whether they are currently selected) while leaving the other selected rows still
selected.

Add the Values
1. Click the down arrow to add the value to the selected area.

2. Click the up arrow to remove a value from the selected area.

Search For and Filter Records

You search for records when none are displayed. By entering search criteria, you indicate
which records must be displayed for your use. Filtering, on the other hand, allows you to
reduce the number of records (or values) displayed. Again, you enter criteria indicating
which of the currently displayed records must remain visible. The unwanted records are
hidden from view. In either case, you are restricting the number of records (or values)
displayed to a more manageable and useful number.

Filter Records in a Table
Column-level filtering is available in tables that have drop-down lists.
= To use a simple filter:

a. Enter a partial string in the active cell. For example: Enter D or d to retrieve all
records that begin with D, such as Department.

Merchandise Level | Merchandise ID

Departrnant Bl d (RS- *

Clear Filker aa
| clear all Filters
| Advanced Filter...

e

Lepartrment
Departrnent -
Simple Filter
b. Press the Enter key. The records that match the filter criterion are displayed in
the table.
c. Toshow all records again, click on the down arrow in the active cell and select
Clear Filter.

Navigate RPM 15



Search For and Filter Records

=  To use the advanced filter tool:

a. Click the down arrow in the active cell and select Advanced Filter. The
Advanced Filter window opens.

Advanced Filter [‘5_(|

Show rows where

Merchandise Level |is equal to

[~]
| =]
[~]

|(nnnej

| Cancel || (1] 4 |

Advanced Filter

b. Select a relational operator in the first list box. Then select a value in the second
list box.

c. If another condition is necessary, select a logical operator (And or Or). Then
select the second relational operator and value.

d. Click OK. The records that match the conditions are displayed in the table.

e. To show all records again, click on the down arrow in the active cell and select
Clear Filter.

= Toreuse afilter:
a. Click the down arrow in the active cell.
b. Scroll through the list of recent filters; then select the desired filter.

c. To show all records again, click on the down arrow in the active cell and select
Clear Filter.
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System Options

System Options

The system options workspace allows you to configure RPM to maximize the system for
your company. System options allow you to customize various parameters, defaults, and
constants that are used throughout the system. Normally, these elements are set when
RPM is installed by the system or database administrator. They tend to remain fixed
unless a business practice is changed which necessitates a change in RPM. System
options are the values used in your system that define the overall configuration of the
system.

System Defaults

The System Defaults Edit workspace allows you to configure RPM to maximize the
system for your company. Select the values that should be should be initially displayed
when a user enters the workspace. This helps the user save time as they do not have to
select the appropriate value each time they complete a task. The values entered will
appear in other areas of the application. The table below describes the system defaults.

Aggregation Levels

The Aggregation Level Settings workspace allows you to define system parameters that
vary for price strategies and price worksheet. When a department is created in the
merchandising system, Oracle Retail Price Management assigns the default value for
each parameter to the default or default level defined in the system. You may choose to
define the aggregation level at a different parameter than the default. When a price
strategy exists for a department, parameters are disabled and cannot be changed.

System Options Definitions

System Option Definition

Sales Calculation Method The method used by the merchandise extract program to
populate the Projected Sales column in the worksheet.

Multiple Item/Loc Promotions When selected, an item/location can exist on more than
one promotion (and more than one component within
the promotion).

Update Item Attributes When selected, the merchandise extract program should
update certain item attributes during each extract that
occurs during a worksheet review period.

Price Change/Promotion Overlaps When selected, indicates an item/location can have a
price change occur during the middle of an active
promotion.

Cost Calculation Method The way cost is determined for the zone. Choose Highest

Location Cost or Average Location Cost.

Clearance/Promotion Overlaps When selected, indicates an item/location can be on
clearance and promotion at the same time.

System Options 17



System Options Definitions

System Option

Definition

Recognize WHs as Locations

Allow Complex Promotions

Open Zone Use

Exact Deal/Funded Promotion Dates

Purge Reset Clearance Months

Default Out of Stock Days

# of Days Reject Held

Default Reset Date

Promotion # Days Rejects Held

Price Change Processing Days

Promotion History Months

Ends in Digits for Zero Decimal
Currencies

Event ID Required

External Prices Allowed

18 Oracle Retail Price Management

When selected, indicates warehouses can be assigned to
regular and clearance price zones. They cannot be
assigned to promotion price zones.

When selected, indicates all promotion types are
available.

When selected, indicates a zone can be used across
different types of pricing, regardless of zone type.

When selected, indicates that the dates of a deal
associated with a vendor funded promotion must match
the promotion component dates exactly. When selected,
only deals with the same begin and end dates as the
promotion component being created will appear in the
deal

The number of months RPM will retain clearance price
events that have reset before purging them.

The number of days that should be added to an items
clearance effective date in order to calculate the Out of
Stock date. The default is applied to generate the out of
stock date when the clearance is first created.

The number of days after the effective date of a rejected
price change or clearance that it is purged from the
system.

When selected, indicates a reset date should be defaulted
when a clearance is created. The reset date is defaulted to
one day greater than the out of stock date.

The number of days, set in system options, after the end
date (or start date for promotions with no end date) of a
rejected promotion that it is purged from the system.

The number of days, set in system options, between the
creation date of a price change and the first date it can
become effective. It allows the retailer to insure that price
changes are created with enough advance timing that
stores and other process areas can react.

The number of months, set in system options, after a
promotion is completed that is purged. This parameter is
also used to purge cancelled promotions.

The number of digit fields, set in system options, that are
available in the Ends In definition area. This field is used
for currencies that do not contain a place after the
decimal point. For currencies that contain places after the
decimal point, the digit fields that are available.

When selected, a promotion event must be assigned to
the promotion.

When selected, RPM will accept pricing events created in
other systems.



System Options

System Option

Definition

Zone/Parent Ranging

Apply Promo Change Type 1st
Location Move Lead Time

Location Move Purge Days

Dynamic Area Differentials

Allow Buy Get Cycles

Display Promotion Header Markup
%

Background Conflict Check

When selected, RPM should perform ranging checks for
price changes, promotions, and clearances that are
created at a higher level than transaction/location. If the
indicator is set to yes, the system will not let you create a
price change at the parent or zone level if none of the
transaction item/location combinations are ranged. If the
indicator is set to no, the system will let you create a price
change at the parent or zone level even if none of the
transaction item/location combinations are ranged.

Allows you to indicate, in system options, which type of
promotion change type should be applied first.

The number of days, set in system options, required
before a location can be moved between zones in RPM.

The number of days RPM will retain location moves that
have either successfully completed or are the same
number of days past the scheduled effective date but
have had no action taken on them.

When selected, allows the worksheet to dynamically
update secondary locations based on changes to the
primary location.

When Selected allows Buy Get Promotions to contain
multiple identical items to be in the buy and get lists. It
also allows items to be on the buy list of one promotion
and the get list of another. The Point Of Sale system used
must be able to manage cycles for this option to work as
intended.

When selected, the total markup percentage for the
promotion will appear on the promotion header.

When selected, conflict checking of worksheets, price
changes, promotions, and clearances occur in the
background, or when the system is idle.
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Edit System Options

Edit System Options

Navigate: From Task Pad, select System Options > System Options Edit. The System
Options workspace opens.

B sSystem Options

I@ Options | :I

* Sales Calculation Method

* Multiple Item/Loc Promotions

* Update Item Attributes

* price Change/Promotion Ouerlaps

* Cost Calculation Mathaod lAuerage Location Caost lzl

* Clearance/Pramotion Overlaps

& Recognize WHs as Locations
* allow Complex Promotions

& Cpen Zone Use

Exact Deal f Funded Prormotion Dates O
¥ purge Reset Clearance Months |1 |
* Default Out of Stack Days |120 |
* ¢ of Days Rejects Held |30 |
¥ Default Reset Date O
¥ Prornotion # Days Rejects Held |30 |
* price Change Processing Days |3 |
* promotion History Months |6 |

* Ends In Digits For Zera Decrnal Currencias o

* Event ID Required

External Prices Allowed

ZonefParent Ranging
Apply Prorno Change Type 1st lermount Off lz‘
* Location Move Lead Time |1 |
¥ Location Move Purge Days |1 |
Dynamic Area Differentials
Lo By ot el hd

Cancel Save

System Options workspace
1. Update any enabled fields as necessary.

2. Click Save to commit any changes and close the workspace.

20 Oracle Retail Price Management



System Options

View System Options

Navigate: From Task Pad, select System Options > System Options View. The System
Options View workspace opens.

@ Dptions F

¥ gales Calculation Method |Srn00thed Auerage SalesE

¥ Cost Caleulation Method IAuerage Location Cost |z|

_Apply Promo Change Type 25t larnaunt off [
* Location Move Lead Time |1 |
¥ Lacation Mave Purge Days |1 |
tebves Bveromdsls
Lo o =

System Options View workspace
= Click Close to exit the workspace.
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System Defaults

System Defaults Definitions

System Default

Definition

Options

Item Level

Pricing Strategy

Diff Type

Type

Currency

Maintain Margin Strategy
Method

Default Price
Change/ Clearance List
View

Ignore Constraint
Handling

The level of an item in an item group.

The pricing strategy is the default strategy
type displayed for the user when entering
the Pricing Strategy workspace.

The category that a diff belongs.

The type is the default price change type
displayed when creating a price change.

The primary currency used in RPM.

Defines the default method used when

creating a maintain margin pricing strategy.

Defines weather the Markup columns
appear on Price Change and Clearance
windows. Having the system calculate and
display this field may slow performance.

Defines whether or not promotion
constraints will be taken into account when
conflict checking is performed in the
worksheet.

- Parent Item

- Parent Item/ Diff

- Transaction Level
Item

- Area Differential

- Clearance

- Competitive

- Margin

- Maintain Margin
Valid diff types from
the Merchandising
System.

- Change by Amount
- Change by Percent

- Fixed Price

]
See LOV =!I button on
System Default screen
for code and
description.

- Market Basket
Margin

- Current Margin

- Standard Column
View

- Markup Column
View

Select/ Clear checkbox
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Edit System Defaults

Navigate: From Task Pad, select System Options > System Defaults Edit. The System
Defaults Edit workspace opens.

@ Defaults

* Itern Lavel - celect -

|C|earance

|Co|or

|Change By Arnount

[usp | & [us pollar

|- Salact -

|Standard Column Wiew

System Defaults Edit workspace
1. Update enabled fields as necessary.

2. Click Save to commit any changes and close the workspace.

View System Defaults

Navigate: From Task Pad, select System Options > System Defaults View. The System
Defaults View workspace opens.

@ Defaults

¥ Itern Level

I'I'ransaction Level Item

|C|earance

DlFF Type |Co|0r

* Type [change By Amount

* curreney [usp | B [us pollar
Maintain Margin Strategy Methaod |- Select -

Ignore Constraints

System Defaults View workspace
= Click Close to exit the workspace.
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Aggregation Levels

Maintain Aggregation Level Settings

Navigate: From the Task Pad, select Aggregation Level > Maintain Aggregation Levels.
The Aggregation Level Settings workspace opens.

%9 Aggregation Level Settings

(& Aggregation Level Settings ]

1111| *Grocery Mon ... | Bepartment Department Week

Current-Hew

2222| *peli Department Department Week

Current-Hew

&000| ¥*Health&Reauty | Department Department Weak

Currant-Hew

6100| General Merch.., | Department Department Week

(4
1 Department Nanj Lovrest Definablj Worksheet Leve| Historical Sales | Regular Clearance Promotion Include WH Invel Include On orde: Pri(:ChingEAn4
22| DW working dept| Departmeant Departmeant Week Current-Hew Z
TT77| Retail Dept Departmant Departmant Week O O O | O Current-Hew
TT7E| Cost Dept Departmant Departmant Wezk O O O O O Current-Hew
3457|jap dept Subclass Subclass Weak O O O O O Current-MHew
20| Merch Extract .| Department Department Week O O O O O Current-Hew
1234 Glassware Subclass Department Week O O O O O Current-Hew
T000| DOC Test Dept | Department Department Week O O O O O Currant-Hew
7001| DOC Test Dep...| Class Class Week O O O O O Current-Hew
13| SLH Test Dep... | Department Departmeant Week O | | O O Current-Hew
5004 *Women Appa... | Department Departmant Week O O O O O Current-Hew
1104| *Test Depart.. | Department Departmant Week | | O | | Current-Hew
1704| *Candidate Ru...| Department Departmeant Weak O O O O O Current-Mew  |—1
2000 djm_dept1 Department Department lieek O O O O O Current-Mew
TTT| *Dairy Department Department Week O O O O O Current-Mew
| | | | |
m| | | | m|
| | | | |
| 0 | | |

Current-Hew [

Cancel Done

Aggregation Level Settings workspace

1. Select the record you want to update.

2. (Click in the field that you want to change.

Lowest Definable Level: Select the lowest level of the merchandise hierarchy for
which a price strategy can be defined.

Worksheet Level: Select the level of the merchandise hierarchy at which
worksheets will be generated.

Historical Sales: Select the sales period RPM should represent as historical on
the worksheet.

Regular: Select the check box to indicate that regular sales should be included as
part of historical sales in the price worksheet.

Clearance: Select the check box to indicate that clearance sales should be
included as part of historical sales in on the price worksheet.

Promotion: Select the check box to indicate that promotional sales should be
included as part of historical sales in on the price worksheet.

Include WH Inventory: Select the check box to indicate that warehouse
inventory should be included in the calculations for sell through and price
change impact in the price worksheet.

Include On Order In Sell Thru: Select the check box to indicate that inventory
ordered is included in the sell through calculations on the price worksheet.
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=  Price Change Amount Calc: Select the method of calculating the price change
amount on the price worksheet.

— New-Current: The current price is subtracted from the new price.
— Current-New: The new price is subtracted from the current price

= Past Retail Change Highlight Days: Enter the number of days previous retail
changes will cause the Last Price Change column of the pricing worksheet to be
highlighted.

= Past Cost Change Highlight Days: Enter the number of days previous cost
changes will cause the Last Cost Change column on the pricing worksheet.

* Pending Cost Change Window Days: Enter the number of days into the future
the system should look for pending cost changes.

* Pending Cost Change Highlight Days: Enter the number of days into the near
future the system should look for pending cost changes. The Pending Cost
Change column on the worksheet will be highlighted if a cost change falls within
the Pending Cost Change Highlight Days.

Note: Pending Cost Change Highlight Days must be less
than or equal to Pending Cost Change Window Days.

Click Done to save any changes and close the workspace.
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Pricing

Pricing

Below are the steps to set up pricing in RPM. Your organization may not use all of the
functions below.

Retrieve an item price
Set up Price Guides
Set up Candidate Rules

Set up Zone Structure

= Setup Codes
= Set up Calendars

Retrieve an Item Price

The Price Inquiry workspace allows you to look up the price of an item for a selected
date and location. The following information appears in the Price Inquiry Results table:

Column Description

Item ID/Description The transaction or parent level items found based on the selected
criteria.

Diff ID The differentiators for the parent item if Parent Item/Diff type is
selected.

Location/Description The selected locations, zones, or zone groups depending on selected

Primary Zone

Date

Regular Retail

Regular Retail UOM
Regular Multi-Units
Regular Multi-Units Retail

Regular Multi-Units Retail
UOM

Clearance Retail
Clearance Retail UOM
Promotional Retail
Promotional Retail UOM

Complex Promotion

criteria.

Selected if the zone is within the primary zone group.

The selected date. The date the item/location price is valid far.
The regular price of the item/location for the specified date.
The unit of measure of the regular item/location.

The regular multi-units of the item/location.

The regular multi-unit price of the item/location.

The unit of measure of the regular item/location multi-unit.

The clearance price of the item/location for the specified date.
The unit of measure of the clearance item/location.

The promotional price of the item/location for the specified date.
The unit of measure of the promotional item/location.

Selected if the item/location is included on a complex promotion.

Regular retail and multi-unit prices are calculated as follows:
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Retrieve an Item Price

Location hierarchy

Transaction Level ltem

Parent Iltem

Parent Iltem/Diff

Location

Zone

Primary Zone

Transaction level price at the
location.

Average of transaction level
prices for all locations in the
zone.

Primary zone price.

Average of prices for all
transaction level items under
parent at the location.

Average of prices for all
transaction level items under
parent at all the locations in
the zone.

Average of prices for all
transaction level items under
parent in the primary zone.

Note: "Price" refers to Regular Retail or Regular Multi-Units Retail.

Average of prices for all
transaction level items under
parent/ diff at the location.

Average of prices for all
transaction level item sunder
parent/ diff at the locations in
the zone.

Average of prices for all
transaction level items under
parent/ diff in the primary
zone.

Clearance and promotion prices are calculated as follows:

Location hierarchy

Transaction Level Item

Parent Iltem

Parent Item/Diff

Location

Zone

Note: "Price" refers to Clearance Retail or Promotional Retail.

Transaction level price at the
location.

Average of transaction level
prices for all locations in the
zone.

Average of prices for all
transaction level items under
parent at the location.

Average of prices for all
transaction level items under
parent at all the locations in
the zone.

Average of prices for all
transaction level items under
parent/ diff at the location.

Average of prices for all
transaction level item sunder
parent/ diff at the locations in
the zone.
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Retrieve an Item Price

Navigate: From Task Pad, select Price Inquiry > Retrieve Item Price. The Price Inquiry

workspace opens.

E Price Inquiry
I@ Price Inquiry |:|
rFilter
8 |
8 N E— T
Itermn Type |Item lEI * Date
Ttern Level I'I'ransaction Lavel Item lzl
S ] T
a8
Clear | | Retrieve Price |
Price Inquiry Results " &
Item ID Ttem Descripf Diff ID Location Location Desq Primary Zone| Date Regular Retai| Regular WOM | Regular Multi
| Filker by.‘lzl | Filkey by.‘lzl | Filker by.‘lzl | Filkey by.‘lzl | Filker by.‘lzl | Filkey by.‘lzl | Filker by.‘lzl | Filkey by.‘lzl | Filker by.‘lzl | Filkey by.‘lzl
b
Price Inquiry workspace
1. Enter criteria as necessary to restrict the search to the price changes you want to
maintain.
Field Criteria
Merchandise Level  Select criteria in the following fields to search for prices in a specific
merchandise level:
* Department
= C(lass
=  Subclass
= Jtem Type
= Item Level
= Diff Type
= Jtem
= Diff
Zone/Location Select Zone Groups, Zones, and Locations to search for prices from specific

zones or locations.

Date Select the date you need to retrieve a price for.
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Retrieve an Item Price

2. Click Retrieve Price. Your results appear in the Price Inquiry Results table.

Price Inquiry Results " &
Item ID Diff ID Location Location Desd Primary Zone| Date Regular Retai] Regular WOM | Regular Multi| Regular Mu
Fitker by | W | Filber by T | Fitker by | ¥ ||| Fitker by | ™ | Fitker by:|™ | Fitker by | ||| Fitker by:| TN | Filbar by:| ® ||| Fitker by | ™ | Filker by:l:
2444 g Z1 D 08/10/2005 $200.00| EA z
100256126 =l Z1 D 08/10/2005 $6.88| EA

1001324196 =l Z1 D 08/10/2005 $220.00% EA

100134145 =l Z1 D 08/10/2005 f10z.20% EA

100256142 2 21 D 0g/10/2005 $5.25| EA

100134161 g Z1 D 081 0/2003 $200.00| EA

1001324170 =l Z1 D 08/10/2005 $200.00| EA

100256011 =l Z1 D 08/10/2005 $6.88| EA

10013241532 g Z1 D 08/10/2005 $200.00| EA

1001241828 =l Z1 D 08/10/2005 $200.00| EA _
1001324209 =l Z1 D 08/10/2005 $248.00% EA

1001324137 =l Z1 D 08/10/2005 +200.00| EA

100256089 g 21 D 081 0/2005 $5.85 EA

100134250 2 Z1 D 081 0/2005 $1,000.00| EA

100236020 g 21 D 08/10/20035 $6.28 EA

100134233 g Z1 D 08/10/2005 $192.80% EA

100134129 g Z1 D 08/10/2005 $200.00| EA

100256193 =l Z1 D 08/10/2005 $6.88| EA

100256062 =l Z1 D 08/10/2005 $6.88| EA -
4 I IED

Price Inquiry Results table
Export Price Inquiry Results

1. Select the row you want to export by clicking the box :I to the left of the row. Press
and hold the Ctrl key while selecting to select multiple rows.

2. Click the Export ['E button. The Save window opens.

Save

Save In: |B Termp lzl E

3 wards.0 [3 {ca532E73-1BE7-1108-906A-00010240CES5}
[ {00761b0&-802d-11d4-9790-00c04fEecbzs) | SREEIE

[ {46891FF9-Fa43A-4AEE-B3F2-5CEFD4CC4BELY
3 {68249BEE-BF14-1107-82ES-00500AZ1TSTEN
[ {7145F0A8-65813-11D6-AF7B-00B0DO142030}
[ {a5bal4e0-7384-11d4-bae7-00409631a2cE}
3 {a2833100-14581-11d4-9731-00c04fB2cb35]}
3 {abda%912-5d00-11d4-bae7?-9367cals 7955}

File Harme: IterruF'r'i-:Ell

Files of Tepe: |’*‘.|:s-.I IEI

Save || Cancel |

Save window
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Select a location to save the file to from the Save In drop-down.

Click Save. The file is saved.

3

4. Enter a name for the file in the File Name field.

5

6. Open the file in the program of your choice such as a spreadsheet or word processor.

Price Guides

Price Guides

A price guide allows you to create a uniform price strategy. You can use them to
maintain consistent price points. You can determine if the prices in a guide should be
rounded in the same manner or if they should all end in the same digits.

Price guides can be set up at the corporate level or at the department level. A corporate
level price guide is created and maintained at the corporate level, but can be referenced
by many departments. If any changes are made to a corporate price guide, all
departments that are linked to the corporate guide will reflect the updated changes. A
department-level price guide is created and maintained at the department level.

After price guides are defined, they can be used when setting up pricing strategies, price
changes, clearances, and promotions. Price guides are also used when creating the
primary zone group for a merchandise level. When a price guide is attached to a primary
zone group definition, it will be applied to the initial prices proposed by RPM during the
initial price setting process in RMS (if the proposed price falls within one of the defined
intervals on the guide).

Create a Price Guide

Navigate: From the Task Pad, select Price Guides > Create Price Guide. The Create Price
Guide workspace opens.

%39 create Price Guide

I‘[’—“ Price Guide Create

Price Guide Type [corporate =l

* Gurrenc, ¥ [usp & us pailar

Add Details |

cancel_|[_save #Repeat ][ _Dane

Create Price Guide workspace
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A wDNh PR

In the Price Guide Type field, select the type of price guide you are creating.
In the Name field, enter the name of the price guide.

In the Description field, enter a description of the price guide.

In the Department field, enter the ID of the department, or click the LOV &l button
and select a department.

Note: This field is available only if you selected Department
in the Price Guide Type field.

In the Currency field, select the currency for the price guide.
Click Add Details. The Price Guide Details Create pane opens.

|(: Pric

e Guide Details Create

From

To New Retail ‘

5.00| 5.45) 5.00( &

Al

5,50 5.9 5.50f

£.00| £.43) £.00]

Autofill

£,50] 6,99 50|

7.00| 749 7.00|

7.50| 7.99| 7.50]

200 2.45) 2.00|

250 8,99 2,50

2,50 2,95 2,50

10,00 10,43 10,00|

10.50] 10,99 10,50 ¥|

From: I:l To: I:l

Mew Retail: I:l Add Mew Retail Ends In: l:l l:l

[ ] pelete mtervals | [ [ validate mtersals |

Price Guide Details Create pane

Add Price Intervals Individually

1.
2.

3.
4.

In the From field, enter the low price of the interval.
In the To field, enter the high price of the interval.

Note: The value in the From field must be lower than the
value in the To field.

In the New Retail field, enter the price that all values in the interval adjust to.
Click Add. The information is added to the table.

Add Multiple Price Intervals

1.

2
3.
4

In the Start Price field, enter the low price of the block of intervals.
In the End Price field, enter the high price of the block of intervals.
In the Increment field, enter the amount each interval should increase by.

In the New Retail Based On field, select how the new retail price should be
determined:

=  From Price: The new price will be set to the same value as the value in the From

column on the list of intervals.

= To Price: The new price will be set to the same value as the value in the To
column on the list of intervals.

= Average Price: The new retail will be set to the average value of values in the
From and To columns on the list of intervals.
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5. Click Autofill. The information is added to the table.

Note: If the End Price is not divisible by the value in the
Increment field, RPM will suggest the last valid price in the
range. Click Yes to accept the price and continue, or No to
cancel the process.

Define Ends in Values

1. Select the intervals you want to add an ends in value.

2. Inthe New Retail Ends In field, enter the digits the price ends in.

Note: The number of fields available are determined at
system set up. If your currency uses decimals the number of
fields corresponds to the number of decimals used in the
currency. If you currency does not use decimals, the number

of digits is determined at system set up.

3. Click Apply. The New Retail field on the selected intervals in the table is updated

with the Ends In Digits specified by the user.

Complete the Price Guide
= Click Done to save any changes and close the workspace.

Copy a Price Guide

Navigate: From the Task Pad, select Price Guides > Copy Price Guide. The Copy Price
Guide workspace opens.

%39 copy Price Guide

I.‘_’J Pricing Guides Drigin

(@) Corporste Pricing Guides

() Department Pricing Guides

(@ Pricing Guides Destination

(@) Corparsts Pricing Guides

() Department Pricing Guides

I(J Create Copy Price Guide

Guides Il
Guide Type ‘ Name Description | Currency Linked ‘
Filter By =l =l ‘
Cotporate Jodi's 2nd copy Jedi's 2nd copy uso (]
Corporte HL-corporate HL-carporate uso

Corporite foo foo uso

Corparate SLH guide tast guide usp

Corporate DW Carp Guide Prices so low we call it crazy .. usD

Corporate corin's corporate hi usD =

Cancel _|[_save + Repeat |[_Done |

Copy Price Guide workspace
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1. In the Price Guides Origin pane, select the price guide type of the price guide you are
copying.
= If you select Department Pricing Guides, enter the department ID in the field to
the right, or click the LOV &l button and select a department.

Note: Price guides that match the criteria entered appear in
the Create Copy Price Guide container.

2. In the Price Guides Destination pane, select the price guide type of the price guide
you are creating.

= If you select Department Pricing Guides, enter the department ID in the field to
the right, or click the LOV &l button and select a department.

In the Create Copy Price Guide container, select the price guide you want to copy.
Click Copy. The Pricing Guide Copy Details pane opens.

= Pricing Gusis Copy Duatals

w0

Feura s P Rt

® T —

Pricing Guide Copy Details pane
5. Maintain the price guide as necessary.

6. Click Done to save any changes and close the workspace.
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Link a Price Guide

Navigate: From the Task Pad, select Price Guides > Link Price Guide. The Link Price
Guide workspace opens.

%3 Link Price Guide

((—1 Department To Link

Departrnent 7000 EH+00oc Test Dept
(@ Price Guides List |
Guides (V-4
Name Description Cunency Linked
ot B @ et B s use x
HL-corparate HL- corporate UsD. x
fon fan UsD
SLH guide rest guide UsD
corin's corporste | hi usp x
Jadi's Carp Price G.., | Jodi's Corparate Pro.| USD 7]

cancel |[_save + Repeat |[_pone |

Link Price Guide workspace
1.

to.

In the Department field, enter the ID of the department you want to link to a
corporate price guide.

In the Price Guides List container, select the corporate price guide you want to link

Click Link. A red X appears in the Linked column, indicating the corporate price
guide has been linked.

Click Done to save any changes close the workspace.
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Maintain a Price Guide

Navigate: From the Task Pad select, Price Guides > Maintain Price Guide. The Price
Guides Maintenance workspace opens.

%3 Price Guides Maintenance
Ol
ID Pricing Guides List ‘
Guides |l ®
Guide Type | Name Description Dept. J Currency Linked |
Fiter by | Fiber by | |
Department Corin's Rockin PG Swestness 8001 - *Meat UsD -
Deparment Huh? Whar? 1704 - *Candidsts Rules Dep | USD
Department PG for PC & Clear Tasting PG for PC & Clear Testing 1704 - *Candidsts Rules Dep | USD
Dapartment PG Diff cur (AUD) AUD 1704 - *Candidate Rules Dep | AUD
Barpeosie Tedlfs Znd @apy Tedlfs Endl @y Use 7]
X ]
e ]|
cancel || save + Repest |[ Done |

Price Guides Maintenance workspace
1. Select the price guide you want to edit.

Note: Linked department price guides cannot be

edited. They can only be viewed. The details of a linked
department price guide are owned at the corporate level, so
changes must be made to the corporate price guide.

2. Click Edit. The Price Guide Maintenance Details pane opens.

(f'—’ Price Guide Maintenance Details

* Hama [1= nam |
* Description [t le desaription ¢a =]
* pepartment 7001 B +ooc Test Dept. 2
* Currency uso B vz collar
g, | stereprice: l:l
From To New Retail (ene] FilE=0 l:l
100,00 104,93 100.00f Increment: l:l
105,00 109,99 105.00 Mew Retail Based on: | gelect-  |¥)
110,00 114,99 110.00)
115,00 119,99 115.00)

120,00

125,00 129,99

120,00 134,99 130,00
135,00 139,99 135,00
140,00 144,99 140,00
145,00 149,99 145.00f

Fram: l:l Ta l:l Hew Retail: l:l Hew Retail Ends Int l:“:l
‘ Izoelata Intarvals | \}a\idate Intaryals ‘

Price Guide Maintenance Details pane
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Edit the enabled fields as necessary.
4. Update the intervals as necessary.

= Add price intervals individually.

= Add multiple price intervals.

= Define the ends in price.
5. To delete an interval:

a. Select the intervals you want to delete.

b. Click Delete Intervals. The intervals are removed from the table.
6. To verify the intervals are sequential:

a. Click Verify Intervals. If non-sequential intervals exist, an error message
appears.

b. Click OK. The non-sequential values are highlighted in red.
c. Correct the intervals as necessary.

— Add price intervals individually.

— Delete an interval.

7. Click Done to save any changes and close the workspace.

Candidate Rules

Candidate Rules

The pricing office of your organization determines the optimum strategies for using RPM
in your business. After these strategies are decided, you can define the candidate rules
and set up the following parameters:

= Candidate rules
= Variables for candidate rules

You use candidate rules to search the database for items that need to be highlighted for
pricing review. Candidate rules determine which item/locations will have retail prices
proposed in clearance worksheets. In other types of worksheets they provide a way to
identify and track specific items during the worksheet review process.

Candidate rules are defined at the corporate level. You can modify any of the candidate
rule parameters. Some rules have variable values. These values are assigned and can be
modified at the department level.

Note: Rules that have variables defined are run only against
items in Departments where a value has been assigned to the
variable. If there is no variable value for a Department, the
candidate rule will not run against items from that
Department.
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There are two types of candidate rules: Inclusion and Exclusion. Exclusion rules are
always run first and identify items that will not be included in the worksheet review.
Inclusion rules can contain a variable for Department level differences in the value to be
searched against. Items that meet an inclusion candidate rule are flagged on the
worksheet. Items that meet an exclusion candidate rule do not appear on the worksheet.

Note: Candidate rules are run against the worksheet when it
is first created. They are not run again if the worksheet is
updated.

Set up a Candidate Rule and Define a Variable for the Rule

Navigate: From the Task Pad, select Candidate Rules > Create Candidate Rules. The
Create Candidate Rule workspace opens.

B3 create candidate Rule

I-'@ Create Candidate Rule
rCandidate Rule Maintenance
¥ Narne || |
Crescriptian | |@
Type (® Inclusion
() Exccluzion
Status -:- Inactive
(@) Active
rCondition Definition
Field Dperatar “Wariable Walue
e R —
r Conditions
Cancel || Save + Repaat || Crone

Create candidate rule workspace
1. In the Name field, enter the name of the candidate rule.

2. Inthe Description field, enter a description of the candidate rule. This description can
be up to 250 characters.

In the Type, select the kind of candidate rule that you are creating.

In the Status field, select the active status of the rule. Only active rules are run during
a review period.
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5. In the Field column, select the field to which the candidate rule is applied.

6. In the Operator field, select the relationship that the Field item has to the Value or
Variable Name.

Note: All options may not be available for some field types.

Operator Relationship

= Equal to

< Less Than

> Greater Than

<= Less than or equal to
>= Greater than or equal to

Not equal to

7. In the Value field, enter the ID of value or click the LOV button and select a value.

Note: If you enter a Value, the rule runs against all
Departments that use this value in the rule. If you enter a
Variable, you can assign the value of the Variable by
Department.

Assign a Variable Value
1. Select the Variable check box.
2. If the Variable is a new variable, select the New check box.

3. In the Value field, enter the name if it is a new variable or click the LOV [l button
and select an existing variable.

Complete the Candidate Rule
1. Enter additional conditions as necessary.

2. Click Add. The condition opens in the conditions area.

Note: A single rule can have multiple conditions. If multiple
conditions exist for a rule, an item must meet all of the
conditions in order for the rule to be met.

3. Click Done to save any changes and close the window.
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Maintain Rule Variables by Variable or by Department

Navigate: From the Task Pad, select Candidate Rules > Maintain Rule Variables. The
Rule Variable Maintenance workspace opens.

3 Rule Yariable Maintenance

I-'@ Rule Yariable Maintenance

ethod by varsbie 5]
Rule Wariable Maintenance By Yariable || &
Department | Description ¥ariable ¥alue |

Cancel Il Save + Repeat Il Done I

Rule variable maintenance workspace
1. Inthe Method field, select how you want to update the rule variables

2. Inthe Variable/Department field, select the value you want to use to update the rule
variable.

3. In the Variable Value field, enter the value to be associated with the variable when
the rule is run against items in the department.

4. To update the values for multiple departments:
a. Multi-select the departments you want to update

b. In the Value field below the Rule Variable Maintenance By Variable table, enter
the value to be associated with the variable when the rule is run against items in
the department.

c. Click Apply.
5. Click Done to save any changes and close the workspace.
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Delete a Candidate Rule Variable

Note: If the variable is attached to a candidate rule, you must
delete the candidate rule before you can delete the variable.
To delete the candidate rule, see the Delete a candidate rule
procedure.

1. In the Department field, enter the Department number or click (LOV) and select
from the list of values.

Click View. A list of the defined variables with their assigned values appears.
Select the radio button for the candidate rule variable that you want to remove.

4. Click Delete. A message appears, “This variable will be deleted for all Departments.
Do you want to continue?”

5. Click OK. The variable is removed from the list.

Note: To leave the window without making changes, click
Cancel.

Update a Candidate Rule Variable

Note: Rules that have variables defined are run only against
items in Departments where a value has been assigned to the
variable. If there is no variable value for a Department, the
candidate rule will not run against items from that
Department.

1. In the Department field, enter the Department number or click (LOV) and select
from the list of values.

2. Click View. A list of the defined variables with their assigned values appear.

Note: To apply the same variable to more than one
Department, select the desired Departments from the list.
For more information on selecting multiple items from a list,
see the Select multiple options from a list procedure.

3. Inthe Value field for the candidate rule variable that you want to edit, enter the
appropriate value.

4. Click Save. The information is saved.

Note: To leave the window without making changes, click
Cancel.
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Maintain a Candidate Rule

Navigate: From the Task Pad, select Candidate Rules > Maintain Candidate Rules. The
Maintain Candidate Rules workspace opens.

5 Maintain Candidate Rules

@ |
candidate Rule List |
Name Text ¥ariable Type Status |
SLL Second Retest test Projected Sales < [FU... @ Inclusion Active Z
SLL Retest 4198 Candida...[Sell Through = 0.2: .., @ Inclusion Active
Test Candidate Rules Department = 1818 Clas... Inclusion Active
Dept 2 Department = 2 Inclusion Active
Test2 Season Code = Sprin... @ Inclusion Active
Tast 3 Market Basket Code = 00.., Incluzion Active -
Dept 1704 Departrient = 1704 Inclusion Active ]

Cancel Il Save + Repeat Il Done I

Maintain candidate rules workspace

1.
2.

Select the candidate rule you want to change.

Click Edit. The Candidate Rule Maintenance workspace opens with information
about the selected candidate rule.

Change information in any of the fields, as necessary.

Note: See the Set up a candidate rule and define a variable

for the rule procedure for additional information.

If you want to use the value as a variable:

a. Check the box in front of Use value as variable.

b. Enter or Click & (LOV) to display a list of existing values.

c. Select an appropriate value from the list.

42 Oracle Retail Price Management




Pricing

5. If you want to edit only the Condition portion of a rule:

Note: To add a new Condition to a rule without changing
any existing Conditions, follow steps c-d below.

In the Conditions box, select the Condition that you want to change.

Click Edit. The components of the selected condition display in the Field,
Operator, and Values or Variable Name fields.

c. Enter the appropriate information in the Field, Operator, and Values or Variable
Name fields.

d. To include the new or updated Condition without removing the existing
Condition, click Add.

Or

To substitute the existing Condition with the one you just created or edited, click
Replace.

6. To return to the Candidate Rules window, click Cancel. All information that you did
not save in the Candidate Rule Maintenance window is lost.

To delete a condition, select the condition in the Conditions box.
Click Delete. The condition is removed.

To apply all of the changes that you made in this window, click Save. You are
returned to the Candidate Rules window.
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Delete a Candidate Rule

Navigate: From the Task Pad, select Candidate Rules > Maintain Candidate Rules. The
Maintain Candidate Rules workspace opens with all of the current candidate rules listed.

%5 Maintain Candidate Rules

@ |
tandidate Rule List (=4
Name Text ¥ariable Type Status |
SLL Second Retest test Projected Sales < [FL.., @ Inclusion Active Z
SLL Retest 4198 Candida... [Sell Through = 0.2:C.., @ Inclusion Active
Test Candidate Rules Department = 1518 Clas.., Inclusion Active
Dept 2 Departrent = 2 Inclusion Active
Test 2 Season Code = Sprin.., @ Inclusion Active
Test 2 Market Bazket Code = 00... Inclusion Active ||
Dept 1704 Departrnent = 1704 Inclusion Active -

Cancel || Save + Repaat || Crone

Maintain candidate rules workspace
1. Select the candidate rule you want to delete.

2. Click Delete. A message appears, “Are you sure you want to delete the selected
rule?”

3. C(Click OK to delete the rule. The rule is removed from the list.

Note: Variables are not deleted if you delete a rule that has a
condition with variables and values assigned at the
Department level. This feature allows you to use the
existing variables and assigned values when you create a
new rule. To delete the variables, see the Delete a candidate
rule variable procedure.
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Zone Structures

Zone Structures

Zone structures allow you to group locations that are priced the same. Additionally, you
identify the types of pricing the zone is used for; Regular, Promotional, or Clearance.
There are several components that you need to define in order to use zone structures.

Zone Groups

Zone groups are a collection of zones. You can define multiple zone groups that are
suited to your business. After you define the zone group, you can define the zones in the
zone group. A location (store or warehouse) can only exist once in a given zone group.
Multiple currencies may exist within a zone group.

Zones

A zone is a group of locations that are priced the same within a zone group. Locations
within a zone must have the same currency. Not all locations must be assigned to a zone.

Primary Zone Groups

The primary zone group is used to determine how items are initially priced in the
merchandising system. When you create a primary zone group, you identify the
merchandise hierarchy level, the zone group, the markup percent, the markup type, and
the price guide. The merchandise hierarchy assigned to a new item in merchandising
system will determine the primary zone group definition in RPM used to initially price
the item. Based on the information associated with the primary zone group and the cost
of the item, as entered in the merchandising system, prices will be proposed.
Additionally, price changes that are created against a zone in the primary zone group are
stored at the zone level. These price changes can be displayed in the Price Inquiry
window.

Create a Zone Group

Navigate: From the Task Pad, select Zone Structure > Create Zone Group. The Create
Zone Group workspace opens.

B9 Create Zone Group

I(—“ Create Zone Group
Zone Group 1D Zone Group Mame Type Like Group
N —
Zone ID  Zone Narne Currency
e ) 1 E

Zone ID ‘ Name | Currency Location Count Base ‘

Save || Locations || Delete \|

cancel |[_save + Repeat |[_pon=

Create Zone Group workspace
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1. Inthe Zone Group ID field, edit the generated Zone Group ID field as necessary.

Note: The Zone Group ID field appears with the next
available number. If you choose to update the field, you
must choose a unique ID.

In the Zone Group Name field, enter a description of the zone group.

In the Type field, enter the type of pricing this zone group is used for, or click the
LOV E button and select a type.

4. Click Next. Your zone group is created.

Add Zones to a Zone Group
1. Inthe Zone ID field, edit the generated Zone Group ID field as necessary.

Note: The Zone ID field appears with the next available
number. If you choose to update the field, you must choose a
unique ID.

2. Inthe Zone Name field, enter a description of the zone.

3. In the Currency field, enter the currency for the zone, or click the LOV &l button and
select a currency.

Click Apply. Your zone is added to the table.
Add the appropriate number of zones for your zone group.

Add Locations to a Zone
1. Select a zone.

2. Click Locations. The Price Zone - Location Assignment pane opens.

(& Price Zone - Location Assignment

Tep [ =l
| &
Location ‘ Name | Location Type New Zone New Zone Name Effective Date Status

|

Price Zone — Location Assignment pane
3. In the first field, select the type of location you want to add to the zone.

4. In the Value field, enter the ID of the location or location group, or click the LOV
button and select a location or location group.

Click Apply to add the location or location group to the list of locations.
6. Click Save to commit any changes.

Click Done to save any changes and close the workspace.
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Copy an Existing Zone Group
1. Inthe Zone Group ID field, edit the generated Zone Group ID field as necessary.

Note: The Zone Group ID field appears with the next
available number. If you choose to update the field, you
must choose a unique ID.

In the Zone Group Name field, enter a description of the zone group.

3. Inthe Type field, enter the pricing strategy that the zone group will use, or click the
LOV El button and select a type.

4. Select the Like Group check box.
Click Next. The Like Group container opens.

6. Enter the ID of the zone group that you want to copy, or click the LOV &l button and
select a group.

7. Click Done to save any changes and close the workspace.

Note: To edit the newly created Zone Group, see the
Maintain a zone group procedure.

Maintain a Zone Group

Navigate: From the Task Pad, select Zone Structure > Maintain Zone Group. The
Maintain Zone Group workspace opens.

%5 Maintain Zone Group

I(D Price Zone Group List

Zone Group 10 Name Type Location Count |

119| DW currenc Y Reqular

130[ SLH Regular

131[DW USD Regular

199[26-0009 Clearance; Regular Prometien

393( 1221 Warehouzes Reqular

7
3
ksl
124 Jodi's 1221 78 Reqular &
2|
El
1

402| corin test Reqular

cancel |[_gave +Repeat |[_Done |

Maintain Zone Group workspace
1. Filter for the records as necessary:

a. Inthe Location, Currency, and Type fields, enter the criteria you want to filter
for.

b. Click the filter button. Zone groups that match your criteria appear in the
table below.

Note: Click the clear filter button to remove the filter
criteria. All zone groups appear in the table below.
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2. To delete a zone group:

a. Select a zone group.
b. Click Delete. The zone group, zones, and locations are removed.
Edit Zones

1. Select a zone group.

2. Click Edit. The Maintain Zone Group pane opens.

‘-"(—‘- Maintain Zone Group

Zone Group ID Zone Group Name Type

oo ] C
Zone ID Zone Name Currency
T ! [=

Zone ID | Name ‘ Currency ‘ Location Count | Base

533‘ FRANCAS |CAD |

381‘,&1 |LISD |

Maintain Zone Group pane

Save  |[ Lacations |[  pelete “

3. After the Zone has been added to the Zone Group the currency cannot be changed.

The zone with the incorrect currency can be deleted and then re-created with the
correct currency.

Note: If there are no locations in the zone the currency field

is editable. If locations exist in the zone than the currency
field is NOT editable.

Add zones to the zone group.
To delete a zone:

a. Select a zone.

b. Click Delete. The zone is removed from the list of zones.

Note: You must first delete all locations from the zone before
you can delete it.
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Edit Locations
1. Selecta zone.
2. Click Locations. The Price Zone - Location Assignment pane opens.

(@2 Price Zone - Location Assignment

Type [stare
Location | Name [ Location Type New Zone New Zone Name Effective Date Status

Price Zone - Locations Assignment pane
3. Add locations to the zone.

Note: When you add a location to a zone that was previously
saved, a location move is scheduled. Go to the Maintain
Location Move workspace to view the location move.

4. To delete a location from a zone.
a. Select a location.
b. Click Delete. The location is removed from the list of locations.

Note: When you delete a location from a zone a location
move is scheduled. Go to the Maintain Location Move
workspace to view the location move.

Complete the Zone Edits
= (Click Done to save any changes close the workspace.
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Create a Primary Zone Group

Navigate: From the Task Pad, select Zone Structure > Maintain Primary Zone Groups.
The Maintain Primary Zone Group workspace opens.

% Maintain Primary Zone Group

I@ Zone Retail Definition List | =

Zone Retail Definition List | &

Dept. Dept Description | Class Class Description | Subclass Subclass Descriptiy Regular Price Zong Regular Price Zond Initial Price Setti Markup Type

Retsil Markup

z2 D working dept 1z HL-regular 209%| Retail Markup

1 Corin's Drepartm.., 13 Corin's 2G 509 Retail Markup

1221 Kirchenware 1z HL-reqular 100%| Retail Markup

Fooo DOC Test Dept 402 corin tast S09%| Retail Markup

4367 Womens shoes 12 HL-regular 19| Retail Markup

7001 DOC Test Dept. 2 131 DW USD 259 | Retail Markup =
pelete [ Edit |[ Add ||

]

cancel || Save + Repeat |[ pore |

Maintain Primary Zone Group workspace
1. Click Add. The Zone Retail Definition Maintenance pane opens.

|@ Zone Retail Definition Maintenance

Merchandise Lavel Requlsr Price Zone Group

. e —
8

Initial Price Settings

Markup % l:l (® Retail Markup () Cost Markup

| Coenr |
Zone Retail Definition Maintenance pane

2. Inthe Department field, enter the ID of the department, or click the LOV B button
and select a department.

3. In the Class field, enter the ID of the class, or click the LOV E button and select a
class.

4. In the Subclass field, enter the ID of the subclass, or click the LOV E button and
select a subclass.

Note: You must select the merchandise hierarchy levels
above class and subclass before you can identify class and
subclass. Class and subclass are not required. You can define
a primary zone group at the Department level.

5. Inthe Zone Group field, enter the ID of the zone group you want to associate with

the selected merchandise hierarchy level, or click the LOV % button and select a
zone group.

Note: Regular price zone groups are the only type of zone
groups that can be attached to a primary zone group.
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6. In the Initial Price Settings container:

a. Inthe Markup % field, enter the percent of markup that is applied to the cost of
the item.

b. Select either Retail Markup or Cost Markup to indicate how the markup is
calculated.

7. To add a price guide, click Price Guides. The Price Guide Definition window opens.

Price Guide Definition x|

fone Currency Price Guide
UsD | |

| Cancel || (a]'4 |

Price Guide Definition window

8. For each currency, enter a price guide ID, or click the LOV El button and select a
price guide.

Note: Only price guides that are associated with the
department selected in the Zone Retail Definition
Maintenance container appear. For each currency, you can
select a price guide, if a price guide has been set up for the
currency and department.

9. Click OK to save any changes and close the window.
10. Click Apply to add your changes to the table.
11. Click Done to save any changes and close the workspace.
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Maintain a Primary Zone Group

Navigate: From the Zone Structure menu, select Maintain Primary Zone Groups. The
Maintain Primary Zone Group workspace opens.

% Maintain Primary Zone Group
a
(@ zane Retail Definition List |—I
Zone Retail Definition List |l
Dept. Dept Description | Class Class Desaription | Subclass Subclass Descripti| Regular Price Zond Regular Price Zond Initial Price Setti] Markup Type
Retail Markup
22 D working dept 12 HL-regular 20%| Retail Markup
1 Corin's Departm.., 12 Corin's 26 50%| Retail Markup
1221 Kitchenuare 12 HL-ragular 1009| Retail Markup
7000 DOC Tast Dapt 402 corin test 50%| Retail Markup
4867 Womens shoes 12 HL-regular 15| Retail Markup
7001 DOC Test Dept. 2 131 D USD: 259%)| Retail Markup [
pelete [ Edit |[ Add ||
=
cancel || Save + Repeat |[ pore |

Maintain Primary Zone Group workspace
1. Click Edit. The Zone Retail Definition Maintenance pane opens.

I@ Zone Retail Definition Maintenance

Merchandize Level Regulsr Price Zone Group
B-

Initial Price Settings

Markup % l:l (® Retail Markup () Cost Markup

| Coenr |
Zone Retail Definition Maintenance pane

2. Edit the enabled fields as necessary.
3. Click Apply.

4. Click Done to save any changes and close the workspace.

Delete a Primary Zone Group

1. Select a primary zone group.
2. (Click Delete. Your changes are removed from the table.

3. Click Done to save any changes and close the workspace.
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Codes

Codes

The foundation area allows you to maintain reason codes and link codes. Reason codes
are used to explain the rationale for clearances and price changes. Link codes are used to
associate items to each other at a location and price them exactly the same.

Link Codes

The maintain link codes area allows you to assign link codes to a transaction level
item/location. The items can be associated to the code through the merchandise
hierarchy, at the item level, or through item attributes such as diff or diff type. Locations
can be associated to the code through the zone group or zone or by entering the location
directly.

Market Basket Codes

The maintain market basket codes area allows you to assign market baskets codes to an
item/zone. The items can be associated to the code through the merchandise hierarchy,
at the item level, or through item attributes such as diff or diff type.

Create a Code

Navigate: From the Task Pad, select Foundation > Code Maintenance. The Code
Maintenance workspace opens.

I@ Code Maintenance |

Code Maintenance " y;
Type Code Description 5IM |
Link Code il biea o]
Reqular Price e Acé ':'

Link Code Code Lala

Reqular Price ReglodeMaw newDasc ':'

Link Code Link 12 T

Link Code SD-1704 Single Dept LT

Link Code M-Dept Multi Dept-1704-1254-1221

Link Code Farant-LC Farent Link Code

Link Code MZ-50 Multiple Zone

Link Code LS for WH Link Code for WH testing

Link Code Crrop It nly On the left side L
Link Code Hodi Zone Hodi Zone

Feqular Price Code3333 Farmland Milk (O}

Reqular Price Code 46 Andy Dufresne

Link Code Fizza Code used for all frozen pizzas

Link Code what If Link Code for What If stories

Regular Price Code 2 &l Code

Clearance Price Code Clear Surnmer Everything Clearance

Clearance Price Code Blue Code Blue Sale??? ) -

vew [ osiete ||

Code Maintenance workspace
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Click New. The next line on the table is enabled.
In the Type field, select the type of code you are creating.
In the Code field, enter a unique identifier for the code.

In the Description field, enter a description of the code.

a r wbdhPRE

In the SIM field, select the radio button to indicate that the reason code is used
exclusively by Store Inventory Management (SIM).

Note: Only one reason code for price changes and clearances
can be assigned as a SIM reason code.

6. Click Done to save any changes and close the workspace.

Edit a Code

Navigate: From the Task Pad, select Foundation > Code Maintenance. The Code
Maintenance workspace opens.

I'/C; Code Maintenance |

Code Maintenance " d;
Type Code Description SIM |
Link Code v 8 4]
Regular Price igd Acé .:.

Link Cade Code Lala

Reqular Price ReqCodeMaw newDesc ':'

Link Cade Link 12 T

Link Code SD-1704 Single Dept LT

Link Code M-Dept Multi Dept-1704-12324-1221

Link Code Parant-LC Parent Link Code

Link Code MZ-5D Multiple Zone

Link Code L for WH Link Code for WH testing

Link Code Drop It Dnly On the left side ]
Link Code Hodi Zone Hodi Zone

Feqular Price Code3333 Farmland Milk O

Raqular Price Code 46 Andy Dufresne ':'

Link Code Fizza Code used for all frozen pizzas

Link Code lhat If Link Code for What If stories

Feqular Price Code 2 Alli Code )

Clearance Price Code Claar Summer Everything Clearance ':'

Clearance Prica Code Blue Code Blue Salar?? ) -

vev [ pelets ]|

Code Maintenance workspace
1. Select the field you want to edit.
2. Make necessary changes.

3. In the SIM field, select the radio button to indicate that the reason code is used
exclusively by Store Inventory Management (SIM).

Note: Only one reason code for price changes and clearances
can be assigned as a SIM reason code. You are prompted to
confirm your choice to change the SIM reason code.

4. Click Save + Repeat to commit your changes.

Click Done to save any changes and close the workspace.
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Delete a Code

Navigate: From the Task Pad, select Foundation > Code Maintenance. The Code

Maintenance workspace opens.

I@ Code Maintenance

Code Maintenance " y;
Type Code Description 5IM I
Link Code il biea o]
Reqular Price e Acé ':_"

Link Code Code Lala

Feqular Price ReqTodaMew newDesc )

Link Code Link 12 T

Link Code SD-1704 Single Dept LT

Link Code M-Dept Multi Dept-1704-1254-1221

Link Code Farant-LC Farent Link Code

Link Code MZ-50 Multiple Zone

Link Code LS for WH Link Code for WH testing

Link Code Crrop It nly On the left side L
Link Code Hodi Zone Hodi Zone

Reqular Price Code3333 Farmland Milk

Reqular Price Code 46 Andy Dufresne 'Z':_.'

Link Code Fizza Code used for all frozen pizzas

Link Code what If Link Code for What If stories

Regular Price Code 2 &l Code [ :'

Clearance Price Code Clear Surnmer Everything Clearance ':_"

Clzarance Price Code Blue Code Blue Sale?r? 'Z_:_" -

vew [ osiete ||

Code Maintenance workspace

1. Select the record you want to delete.

2. Click Delete. The record is removed from the table.

Note: You cannot delete a reason or link code that is in use.

3. Click Done to close the window.
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Maintain Link Codes

Search for a Link Code

Navigate: From the Task Pad, select Link Codes > Maintain Link Codes. The Maintain
Link Codes workspace opens.

%5 Maintain Link Codes

(B Uik codes search

rLink Code

8 8

5 N
temn Type  [iem | Link Code I:I 8+
Ttern Level 'Transaction Level Ttern lzl
N E—T

8

Maintain Link Code workspace

1. Enter criteria as necessary to restrict the search to the link codes you want to
maintain.

2. Click Search. Your results appear in the Maintain Link Codes table.
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(C—‘) Maintain Link Codes

rLink Code

Departrment
Class
Subclazs

Itern Type

Itermn Level

[ 18+
B8+
B8+

Zone

Location

|Item

|Transacti0n Lewvel Itern

M

Link Code

B8+

[ 18

[ 18

Diff Type - Selact -

N m— -

Diff .+

I

Item Item Description | Parent Item Parent Item Desc Location Location Descripti Link Code Link Code Descrip
Fitker by ¥ ||| Fitrer by ¥ ||| Fitter by ¥ ||| Fitker by ¥ ||| Fitter by ¥ ||| Fitter by || Aoy by Fitker by w7
100000008 Test Item 100.., 3 Western Physic.. | Prakazh b Prakazh CodeZ2 —
100000008 Test Itemn 100.., 4 Western Physic.. | Prakazh b Prakazh CodeZ2
100000008 Test Item 100.., 5 Western Physic.. | Prakazh b Prakazh CodeZ2
100000008 Test Item 100.., [ Western Physic.. | Prakazh b Prakazh CodeZ2
100000008 Test Itemn 100.., 7 Western Physic.. | Prakazh b Prakazh CodeZ2
100000008 Test Itemn 100.., 22 stare Lo 1 T Link Code 1
100000016 Test Item 100.., 3 Western Physic.. | Prakazh b Prakazh CodeZ2
100000016 Test Itemn 100.., 4 Western Physic.. | Prakazh b Prakazh CodeZ2
100000016 Test Itemn 100.., 5 Western Physic.. | Prakazh b Prakazh CodeZ2
100000016 Test Itemn 100.., [ Western Physic.. | Prakazh b Prakazh CodeZ2
100000016 Test Item 100.., 7 Western Physic.. | Prakazh b Prakazh CodeZ2
10000001 & Test Itern 100.., 23 store? LC 2 T Link Code 2
100000024 Test Itemn 100.., 8 Western Physic.. | Prakazh b Prakazh CodeZ2

Maintain Link Codes table
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Maintain or Override a Link Code

1. Search for and retrieve the link codes you want to maintain. Your results appear in
the Maintain Link Codes table.

I
Ttem Item Descripti{ Parent Ttem Parent Item D Location Location Descrl Link Code Link Code Desci
Filker by: lzl |F."!ter by lzl | Filker by : lzl | Filker by: lzl |F.".“ter by lzl |F."!ter by lzl |F.l'!ter by lzl |F."!ter by lzl
100002018 eph:Dark Blue 100005000| eph 1000000007| Fresno 1-sh T A
10000301 8| ephiCrark Blue 100002000 eph 100000001 3| Buffala 1-sh T
100005018 ephiDark Blue 100008000| eph 1000000022 Gmaha 1-sh T
100002018 eph:Dark Blue 100005000| eph 1000000025 Las Vegas 1-sh T
10000501 8| ephiCark Blue 100008000| eph 1000001000| Edina 1-sh T
100005018 ephiCrark Blue 100008000 eph 1000001001 Eagan 1-sh T
100002018 eph:Dark Blue 100002000| eph 1000001002 Mall of Armeri..| 1-sh T
100008026 eph:Crark Bro.., 100008000 eph 1111| Ithica 1-zh T
100005026| ephiCark Bro.., 100008000| eph 1000000000| Farga 1-sh T
100002026| aph:Dark Bro.., 100002000| eph 1000000001 | Minneapolis 1-sh T
100008026 eph:Cark Bro.., 100008000 eph 1000000002 Madison 1-zh T
100005026| ephiCark Bro.., 100008000 eph 1000000007 Fresna 1-sh T
100002026 eph:Dark Bro.., 100002000| eph 1000000013 Buffalo 1-sh T
100005026| ephiCark Bro.., 100008000 eph 1000000022 Gmaha 1-sh T
100008026 eph:Cark Bro.., 100005000 eph 1000000025 Las Vegas 1-zh T
100003026 eph:Dark Bro.., 100008000| eph 1000001000| Edina 1-zh T
100002026| eph:Dark Bro.., 100005000| eph 1000001001 | Eagan 1-sh T
100008026 eph:Cark Bro.., 100008000 eph 1000001002 Mall of Ameri.. | 1-sh T
100005034| ephiark Gre.. 100008000| eph 1111| Ithica 1-sh T -
Filter
Zone Sroup l:l %
a8

Maintain Link Codes table

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above.
You may enter more than one department, in which case
you cannot enter class or subclass.

2. Select the locations for the link code:
= Zone Group: Enter the ID of the zone group that contains the zones the link code
should apply to, or click the LOV B button and select a zone group.
=  Zone: Enter the ID of the zone that contains the locations the link code should
apply to, or click the LOV B button and select a zone.

= Location: Enter the ID of the location the link code should apply to, or click the
LOV B button and select a location.
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3. Select the item type for the link code from the Item Type drop-down.

=  Jtem: Select an item or for the link code.

a.

In the Item Level drop-down, select Parent Item, Parent Item/Diff, or
Transaction Level Item.

If enabled, select a diff type from the Diff Type drop-down.

In the Item field, enter the ID of the item(s) you want the link code to apply
to, or click the LOV E button and select an item.

If enabled, enter the ID of the diff(s), or click the LOV B button and select a

diff.

= Ttem List: Select an item list for the link code.

Enter the ID of the item list you want the link code to apply to, or click the
LOV B button and select an item list.

4. Click Apply. The following may occur:

= A row is added to the table for each transaction level item/location that meets
the selected criteria.

= An existing row changes based on the selected criteria.

5. Click Done to save any changes and close the workspace.

Update Link Codes
1. Inthe Maintain Link Codes table select the rows you want to edit by clicking the box

to the left of the row. Press and hold the Ctrl key while selecting to select
multiple rows. Click Select All to select all the rows.

I
Item Ttem Descriptiq Parent Item Parent Item D¢ Location Location Descri Link Code Link Code Desc|
Filter by : lzl |Ef!ter by lzl |F.l'!ter by lzl |F.l!ter by lzl ‘F.l'!ter by lzl |F.l'!ter by lzl |F.l'!ter by lzl |F.l'!ter by lzl
100005015( eph:Dark Blue 100002000( eph 1000000007| Fresna 1-zh T —
100008018| ephiDark Blue 100002000 eph 1000000013| Buffala 1-zh T
10000801 8| eph:Dark Blue 100008000( eph 1000000022( Smaha 1-zh T
100005015( eph:Dark Blue 100002000( eph 1000000025 Las Vegas i-zh T
1000058015( eph:Dark Blue 100002000( eph 1000001 000( Edina i-zh T
100005015( eph:Dark Blue 100002000( eph 1000001001 | Eagan 1-zh T
100005015( eph:Dark Blue 100002000( eph 1000001002( Mall of Ameri..| 1-zh T
100005026( ephiDark Bro.., 100002000( eph 1111 Ithica 1-sh T
1000053026( eph:Dark Bro.., 100002000( eph 1000000000( Farge 1-zh T
100002026( ephiDark Bro.., 100002000( eph 1000000001 | Minneapalis i-sh T
100005026( ephiDark Bro.., 100002000( eph 1000000002( Madisan 1-zh T
100005026( eph:Dark Bro.., 100002000( eph 1000000007| Fresna i-zh T
100008026( eph:Dark Bro.., 100008000( eph 1000000013 Buffala 1-zh T
100008026( eph:Dark Bro.., 100008000( eph 1000000022( Smaha 1-zh T
100005026| ephiCrark Bro.. 100008000| eph 1000000025| Las Yegas 1-sh T
100008026( eph:Dark Bro.., 100008000( eph 1000001000( Edina 1-zh T
1000053026( eph:Dark Bro.., 100002000( eph 1000001001 | Eagan 1-zh T
100002026| eph:Dark Bro.. 100002000| eph 1000001002| Mall of Ameri..| 1-sh T
100005034| ephiDark Gre.., 100002000( eph 1111 Ithica 1-zh T -
Filter

8

Maintain Link Codes table
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2. Right click in the link code field. The Link Code dialog opens.

Current Yalue

1-=h

Edited Walue 1

-zh

| Apply

|| Cancel |

Link Code dialog

3. Enter the ID of the link code in the Edited Value field, or click the LOV % button and

select a code.

4. Click OK. Your changes appear in the table.

Delete a Link Code Relationship

1. Inthe Maintain Link Codes table select the row you want to delete by clicking the
box :I to the left of the row. Press and hold the Ctrl key while selecting to select

multiple rows. Click Select All to select all the rows.

I
Item Ttem Descriptiq Parent Item Parent Item D¢ Location Location Descri Link Code Link Code Desc|
Fifter by lzl |ﬁ!ter by lzl |F.l!ter By lzl |F.l!ter by lzl ‘F.l!ter By |F.l!ter By lzl |F.l!ter by lzl |F.l!ter By lzl
100005015( eph:Dark Blue 100002000( eph 1000000007| Fresna 1-zh T —
10000801 | eph:Drark Blue 100008000( eph 1000000013 Buffala 1-zh T
100008018( ephiDark Blue 100002000( eph 1000000022 Omaha i-zh T
100005015( eph:Dark Blue 100002000( eph 1000000025 Las Vegas i-zh T
10000801 8| eph:Dark Blue 100008000( eph 1000001000( Edina 1-zh T
100002015| eph:Dark Blue 100002000| eph 1000001001| Eagan 1-zh T
100005015( eph:Dark Blue 100002000( eph 1000001002( Mall of Ameri..| 1-zh T
100008026| ephiCrark Bro.. 100008000 eph 1111 Ithica 1-sh T
1000053026( eph:Dark Bro.., 100002000( eph 1000000000( Farge 1-zh T
100005026( ephiDark Bro.., 100002000( eph 1000000001 | Minneapolis 1-zh T
100002026( ephiDark Bro.., 100002000( eph 1000000002( Madisen i-sh T
100005026( eph:Dark Bro.., 100002000( eph 1000000007| Fresna i-zh T
100008026( eph:Dark Bro.., 100008000( eph 1000000013 Buffala 1-zh T
100008026( eph:Dark Bro.., 100008000( eph 1000000022( Smaha 1-zh T
100005026( ephiDark Bro.., 100002000( eph 1000000025 Las Vegas 1-sh T
100008026( ephiDark Bro.., 100002000 eph 1000001000( Edina 1-zh T
1000053026( eph:Dark Bro.., 100002000( eph 1000001001 | Eagan 1-zh T
100005026( ephiDark Bro.., 100002000( eph 1000001002( Mall of Ameri..| 1-zh T
100002034| eph:Dark Gre.., 100002000( eph 1111 Ithica i-zh T -
Filter

Zone

B8+

Maintain Link Codes table
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2. Click Delete. You are prompted to confirm your decision.
3. Click Yes. The link code relationship is deleted.

Maintain Market Basket Codes

Search for a Market Basket Code

Navigate: From the Task Pad, select Market Basket Codes > Maintain Market Basket
Codes. The Maintain Market Basket Codes workspace opens.

B5 Maintain Market Basket Codes

I@ Market Basket Codes Search

rMarket Basket Code

B+
8-+
8-+

Ttemn

E1|ET

Class

Subdass

Itern Type |Item

Itern Leval  [Transaction Level
Diff Type - Seledt -

Ciff

Margin Market Bazket Code

B+
B8+

[ 18
Cornpetitive Market Basket Code l:l %4.

8-+

Zone

Cancel

Maintain Market Basket Codes workspace

1. Enter criteria as necessary to restrict the search to the market basket codes you want

to maintain.

2. Click Search. Your results appear in the Maintain Market Basket Codes table.

(f—’ Maintain Market Basket Codes

rMarkat Basket Code

Zane

Class B
Eutrless B
Item Type  [[em

&

Item Level  [Transaction Level [tem

Diff Type - Select -
e
Diff

H-
Rermous Margin Market Baskst Cods
Margin Markst Basket Cods

Remous Compatitive Market Basket Code
Competitive Market Basket Code

|
L 18
0

L 18

B+

Maintain Market Basket Codes table

I,

Ttem Item Description | Parent Ttem Parent Item Description | Zone Group Zone Margin Market Basket Code | Margin Marke
[ier oy: [v] [ ier bp: []|[ Fiteer bp: [x] [ iteer oy [=]\[Fiteer ay: [x] [ Fiteer £y: [ [ iteer £y v | [Fiter 2y
1000040350 LH Sweaters:Br... | 100004025 LH Sweaters 1 1 ool MBC 1
100004050 LH Sweaters:Br.,. | 100004025 LH Sweaters 1 2 ool MBC 1 |
100004050 LH SweatersiBr.,, | 100004025 LH Sweaters 1 3 001 MBC 1
100004068 LH Sweaters:Br.. | 100004025 LH Sweaters i 1 001 MBC 1
100004068 LH Sweaters:Br... | 1000040235 LH Sweaters 1 z ool MBC 1
1000040682 LH Sweaters:Br.. | 100004025 LH Sweaters 1 3 ool MBC 1
100004076 LH SweatersiBr.,, | 100004025 LH Sweaters 1 1 001 MBC 1
100004076 LH Sweaters:Br.. | 100004025 LH Sweaters i z 001 MBC 1
100004078 LH Sweaters:Br... | 100004025 LH Sweaters 1 3 ool MBC 1
100004024 LH Sweaters:Br.,. | 100004025 LH Sweaters 1 1 ool MBC 1
100004084 LH SweatersiBr.,, | 100004025 LH Sweaters 1 s 001 MBC 1
100004084 LH Sweaters:Br.. | 100004025 LH Sweaters i 3 001 MBC 1

Pricing 61



Codes

Maintain Market Basket Codes

1. Search for and retrieve the market basket codes you want to maintain. Your results
appear in the Maintain Market Basket Codes table.

=4
Item Item Description | Parent Item | Parent Item Description | Zone Group Zone Margin Market Basket Code | Margin Marke
Fitter by: [ ¥ ||[Fiter bp: [ ||| Fteer by: [7]|[ Fter by [ l|[Fiteer by [ ] [ Fteer 2y: [+ ][ Futear by [ =] [Foteer by
100004050 LH SweatersiBr.. | 100004025 LH Sweaters 1 i ool MBC 1 z
100004050 LH Sweaters:Br.. | 100004025 LH Sweaters 1 2 ool MBC 1
100004050 LH SweatersiBr.. | 100004025 LH Sweaters i 3 ool MBC 1
100004062 LH Sweaters:Br.. | 100004025 LH Sweaters i i ool MBC 1
100004062 LH SweatersiBr.. | 100004025 LH Sweaters i 2 ool MBC 1
100004063 LH Sweaters:Br.. | 100004025 LH Sweaters i 3 ool MBC 1
1000040758 LH Sweaters:Br..| 100004025 LH Sweaters 1 i ool MBC 1
1000040758 LH Sweaters:Br.. | 1000040235 LH Sweaters i z ool MBC 1
100004078 LH Sweaters:Br.. | 100004025 LH Sweaters 1 3 ool MBC 1
100004054 | LH SweatersiBr.,, [ 100004023 | LH Sweaters 1 1 oo1 MBC 1
100004054 | LH SweatersiBr.,, [ 100004023 | LH Sweaters 1 z oo1 MBC 1
100004054 | LH SweatersiBr.,, [ 100004023 | LH Sweaters 1 3 oo1 MBC 1
100030063 Parent_tem-1:.. [ 100030055 Parent_tem-1 1 1 o1 MBC 1
100030063 Parent_tem-1:. 100030055 Parent_tem-1 1 1 o1 MBC 1
100030071 Parent_tem-1:.. [ 100030055 Parent_tem-1 1 1 o1 MBC 1
100030071 Parent_tem-1:. 100030055 Parent_tem-1 1 1 o1 MBC 1
100030080 Parent_term-1:.. [ 100030055 Parent_tem-1 1 1 o1 MBC 1
100030080 | Parent_tem-1:.. | 100030055 | Parent_tem-1 1 a ool MBC 1
100030098 | Parent_tem-1:.. | 1000320055 | Parent_tem-1 1 1 ool MBC 1 -
| I IED
Filter
e m— 1

Maintain Market Codes table
2. Enter the ID of the merchandise level you want to apply the market basket to, or click
the LOV & button and select the appropriate merchandise level.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above.
You may enter more than one department, in which case
you cannot enter class or subclass.

3. Select the zones for the market basket:
= Zone Group: Enter the ID of the zone group that contains the zones the market
basket should apply to, or click the LOV & button and select a zone group.
= Zone: Enter the ID of the zone the market basket should apply to, or click the
LOV B button and select a zone.
4. Select the item type for the market basket code from the Item Type drop-down.
= Item: Select an item for the market basket code.

a. In the Item Level drop-down, select Parent Item, Parent Item/Diff, or
Transaction Level Item.

b. If enabled, select a diff type from the Diff Type drop-down.
c. In the Item field, enter the ID of the item(s) you want the market basket
code(s) to apply to, or click the LOV B button and select an item.

d. If enabled, enter the ID of the diff, or click the LOV % button and select a
diff.
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8.

= Item List: Select an item list for the market basket code.

— Enter the ID of the item list you want the market basket code(s) to apply to,
or click the LOV B button and select an item list.

In the Margin Market Basket Code field, enter the ID of the code, or click the LOV E
button and select the code.
Or
Select the Remove Margin Market Basket Code checkbox to disassociate the margin
market basket code from the item(s)/zone(s) that meet the selected criteria.
In the Competitive Market Basket Code field, enter the ID of the code, or click the

LOV B button and select the code.

Or

Select the Remove Competitive Market Basket Code checkbox to disassociate the
competitive market basket code from the item(s)/zone(s) that meet the selected
criteria.

Click Apply. The following may occur:

= Arow is added to the table for each transaction level item/location that meets
the selected criteria.

* An existing row changes based on the selected criteria.

Click Done to save any changes and close the workspace.

Update Market Basket Codes

1.

In the Maintain Market Basket Codes table select the row you want to edit by clicking

the box :I to the left of the row. Press and hold the Ctrl key while selecting to select
multiple rows. Click Select All to select all the rows.

Il
Them Item Description | Parent Ttem Parent Item Description | fone Group fone Margin Market Baskel
Fitrer by | ||| Fitber by || Fiker by ||| Fitker by W | Fitber by || Fitber by | ||| Fitber by
100136001 test 115 554 aos E
100154058
100154074 Parent & DiffiLa..| 1001540686 Parent & Diff 115 215 oons
100154074 Parent & DiffiLa..| 1001540686 Parent & Diff 115 477 oons
100154074 Parent & DiffiLa,..| 100154066 Farent & Diff 113 456 alu}=) -
{ [ IED
Filter
Location l:l % IEI IEI

Maintain Market Basket Codes table
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2. Right click in the field you wish to edit:
* Margin Market Basket Code - The Margin Market Basket Code dialog opens.

Margin Market Basket Code r>_<|

=

Edited Walue |,:,|:,5 | %

| Apply || Cancel |

Margin Market Basket Code dialog
= Competitive Market Basket Code - The Competitive Market Basket Code dialog

opens.
Competitive Market Basket Code E'
S|
Editad Yalue ||:||:|2 | %

| Apply || Cancel |

Competitive Market Basket Code dialog

3. Enter the ID of the Market Basket Code in the Edited Value field, or click the LOV %
button and select a code.
Or
Clear the field to disassociate the market basket code from the selected record.

4. Click OK. Your changes appear in the table.
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Delete a Market Basket Code Relationship

1.

In the Maintain Market Basket Codes table select the row you want to delete by
clicking the box :I to the left of the row. Press and hold the Ctrl key while selecting
to select multiple rows. Click Select All to select all the rows.
=4
Item Item Description | Parent Item | Parent Item Description | Zone Group Zone Margin Market Basket Code | Margin Marke
Fitcer by: || Fiter sy: [ ||| Fitter by [ )| Fiteer by w | Fiter by: [ )| Fiirer sy [ ]| Fitter by MIE
100004050 LH SweatersiBr.. | 100004025 LH Sweaters 1 i ool MBC 1 z
100004050 LH Sweaters:Br.. | 100004025 LH Sweaters 1 2 ool MBC 1
100004050 LH SweatersiBr.. | 100004025 LH Sweaters i 3 ool MBC 1
100004062 LH Sweaters:Br.. | 100004025 LH Sweaters i i ool MBC 1
100004062 LH SweatersiBr.. | 100004025 LH Sweaters i 2 ool MBC 1
100004063 LH Sweaters:Br.. | 100004025 LH Sweaters i 3 ool MBC 1
1000040758 LH Sweaters:Br..| 100004025 LH Sweaters 1 i ool MBC 1
1000040758 LH Sweaters:Br.. | 1000040235 LH Sweaters i z ool MBC 1
100004078 LH Sweaters:Br.. | 100004025 LH Sweaters 1 3 ool MBC 1
100004054 | LH SweatersiBr.,, [ 100004023 | LH Sweaters 1 1 oo1 MBC 1
100004054 | LH SweatersiBr.,, [ 100004023 | LH Sweaters 1 z oo1 MBC 1
100004054 | LH SweatersiBr.,, [ 100004023 | LH Sweaters 1 3 oo1 MBC 1
100030063 Parent_tem-1:.. [ 100030055 Parent_tem-1 1 1 o1 MBC 1
100030063 Parent_term-1:.. [ 100030055 Parent_tem-1 1 1 o1 MBC 1
100030071 Parent_tem-1:.. [ 100030055 Parent_tem-1 1 1 o1 MBC 1
100030071 Parent_term-1:.. [ 100030055 Parent_tem-1 1 1 o1 MBC 1
100030080 Parent_term-1:.. [ 100030055 Parent_tem-1 1 1 o1 MBC 1
100030080 | Parent_tem-1:.. | 100030055 | Parent_tem-1 1 a ool MBC 1
100030098 | Parent_tem-1:.. | 1000320055 | Parent_tem-1 1 1 ool MBC 1 -
| I IED
Filter
Location I:I % IEI IEI

Maintain Market Basket Codes table

2.
3.

Click Delete. You are prompted to confirm your decision.
Click Yes. The market basket code relationship is deleted.
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Calendars

Calendars

Calendars are used to define review periods for your pricing strategies. A review period
is the amount of time you have to act on pricing events generated in the worksheet before

they expire.

After you create a calendar, you can maintain the different aspects of that calendar. You
can modify the name, description or end date of the calendar. You can also change the
rules and exceptions for future review periods.

Create a Calendar

Navigate: From the Task Pad, select Calendar > Create Calendar. The Create Calendar

workspace opens.

%5 create Calendar

I@ Calendar Setup

* Narne |

Description | |@
calendar Setup Review Period Setup
* Gtart Date l:l Fules Both  [7]
¥ End Date l:l Exception Frequency
*
bR s I:l Mew Calendar to Assign to Strategies When Calendar Expires

cancel |[_save +Repeat |[_pone

Create calendar workspace
1. Inthe Calendar Setup pane, in the Name field, enter a name for the calendar.

2. In the Description field, you can enter a description for the Calendar. Click the &
button to open an editing window.
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Setup the calendar

1.

In the Calendar Setup area, in the Start Date field, enter the date the calendar
becomes active, or click the calendar & button and select a date.

In the End Date field, enter the date the calendar is no longer active.
In the Review Period Duration field, enter the length of the review period in days.

In the Days Between Review Periods field, enter the number of days between review
periods.

Note: The last review period duration plus the days between
review periods must exactly reach the end date of the
calendar. If this is not the case, the system can automatically
adjust the end date, or you can chose to modify the Review
Period Duration, Days Between Review Periods or End Date
fields yourself.

Setup Review Periods

1.

In the Review Period Setup area, from the Rules drop-down, select the type of rules
to apply for the review period.

* Inclusion - I[tems that meet inclusion candidate rules will be highlighted in the
worksheet.

= Exclusion - Items that meet exclusion candidate rules will be excluded from the
worksheet.

=  Both - Both inclusion and exclusion candidate rules are applied for the review
period.

= None - No rules are applied for the review period.

In the Exception Frequency field, enter the frequency, in review periods, that RPM
should process exceptions from the merchandising system.

* Enter 1 for every review period.

= Enter 2 for every other review period.

= Enter 3 for every third review period.

= Enter 0 if you never want RPM to process exceptions.

Click Calculate Review Periods. The review periods are calculated and the Review
Period Details pane opens.

(B Review Period Details |

Review Period Details I,

Start Date End Date

Exception |

01/01/2005) 01/01/2005)

01/02/2005 01/02/2005)

01/03f2005 01/03/2005

01/04/2005 01/04/2005

01/05f2005 01/05/2005

01/06f2005 O1/0&/2005

01/07/2005 0107 2005

01/08f2005 01/08/2005

01/09/2005, 01/09/2005

01/10/2005, 01/10/2005,

01/11f2005 01/11/2005

01/12f2005 01f12/z005

01/13f2005) 01/13/2005

A= == == == e = e e e | E
slEIEIENENEEN W] &
;I}}Hiii%%iiiiim
i [« | [ e | | e I

1 EEE R R E | E | E

Review period details pane
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4. In the Review Period Details pane, in the Rules and Exceptions fields, edit as
necessary for each review period.

Complete the Calendar

= Click Done at the bottom of the workspace. The new calendar is added and the
Maintain Calendar workspace closes.

Maintain a Calendar

Navigate: From the Task Pad, select Calendar > Maintain Calendar. The Maintain
Calendar workspace opens.

%3 Maintain Calendar

@

Calendar List

Name Description

Start Date

End Date

Review Period Duration | Days Between Review Pd Expired |

corin devac test

11/19fz004

11/20/2004

Daily Calendar

10082004

10/03f2005

Dermo Calendar Weekly Calendar

11f12f2004

02/10/2005]

Srarts 11/24

11/z24f2004

11/29/2004

Update Item Attribute

10/13/2004

10/17/2005

Test weekly schedule Test zcheduls

10f25/2004

12/26/2004

1
1]
2
Q
1
2
1

Future calendar

09f23f2005

09/25/2005

1
1
&
£
3
5
z

Ooooog

cancel |[_save +Repeat ][ Done

Maintain calendar workspace

1. Select the calendar you want to maintain from the Calendar List pane.

2. Click Edit. The Calendar Detail and Review Period Details panes are displayed and
the fields that can be changed are enabled.
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|@ Review Period Details

Review Period Details | &,
Start Date End Date Rules Exception |
01/01/2005] 01/01/2005) m =
01/02f2005, 01/02/2005
01/03f2005] 01/03/2005)
01/04/2005, 01/04/2005
01/05/2005 o1/os/zo0s| oth  [¥]
01/06f2005 01/0&/2005
01/07/2005 01/07/2005| [oth  [¥]
01/08/2005 01082005
01/03/2005 01/0%/2005| Both  [¥]
01/10/2005 01/10/2005 Both -
01/11/2005 01/11/2005 Both -
01/12/2005 01/12/2005
01/13/2005 01/13/2005) Both  [¥]
T = —
Review period details
(@ talendar Details
* Name |2|JD5 Calendsr |
Description | |@
Calendar Setup [ Review Period Setup
a8
¥ End Date
Mew Calendar to Assign to Strategies When Calandar Expires
e [ 8 &

Calendar detail

3.

5.

= Calendar Detail

Edit the enabled fields as necessary.

— End Date: Select the end date for the calendar.

— New Calendar to Assign to Strategies when Calendar expires: Select the
calendar that replaces the current calendar after the end date.

= Review Period Details

—  Rules: Select Inclusion, Exclusion, Both, or None.

— Exceptions: Select if exceptions, from the merchandising system, should be
processed during the review period.

press the Calculate Review Periods button.

Click Done.

Delete a Calendar

1.

2
3.
4

Select the calendar you want to delete from the list.
Click Delete. You are prompted to confirm your decision.
Click Yes. The calendar is deleted.
Click Done to close the window.

Click Calculate Review Periods. If edits are made to the calendar detail, you must
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Maintain Location Move

Location Moves allows you to smoothly move a location from one zone to another within
a zone group. The process allows a location to keep all location level pricing events while
it transfers from the old zones pricing strategies to those of the new zone, while at the
same time inheriting the pricing events of the new zone. Keep the following in mind
when scheduling location moves:

*  Alocation does not automatically inherit the price of the new zone. Pricing events
scheduled after the move date in the new zone, will be applied to the new location.

*  Only location level promotions will follow a location into a new zone. Promotions
from the old or new zone that span the move date must be stopped before
scheduling a location move.

Request a Location Move

Navigate: From the Task Pad, select Zone Structure > Maintain Location Move. The
Maintain Location Move workspace opens.

B9 Maintain Location Move

I{_ﬂ Location Move List ‘

Location Move List Il ¢

() Location [3) | Location Nan Lecation Typ| Zone Group (3 Old Zone (f) | Old Zone Nan New Zone ()| New Zone Nal Scheduled DY Status Conflict Move Resul

171 12345678 |TestStroel..|Store 521 For testing . | 08/01/2002|5cheduled =
176 12345678 [TestStroel..|Store 521 For testing ... | 08/01/2002(Failed

i 124 testing 124 |Store 2 Far testing ... [ 08/01/2002|Scheduled

177 124 testing 124 |Store 521 For testing ... | 08/01/2002(Failad e
180 138 138 Store 521 For testing ... | 08/01/2002(Scheduled 5=
181 138 138 Store 521 For testing ... [ 08/01/2002|Failed

& 161 lstgr i Fortesting,., | 08/01/2002/schedylad ad

(2 Maintain Location Move ‘

= Group

M m m

m

Maintain location move workspace
1. Click New. The Zone Group Field is enabled on the Maintain Location Move pane.

© Maintain Location Move ‘

8 8
8 =]

Maintain location move pane
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In the Zone Group field, enter the zone group of the location you need to move, or
click the LOV & button and select a zone group.

In the Zone field, enter zone of the location you need to move, or click the LOV
button and select a zone.

In the Location field, enter the location you need to move, or click the LOV & button
and select a Location.

In the New Zone field, enter the zone to move the location to, or click the LOV
button and select the new zone.

In the Effective Date field, enter the date the location should move zones, or click the
calendar [ button and select a date.

Note: The Effective Date you can set depends on the number
of days set in the system option Location Move Lead Time.
The earliest date a location move can be created is today’s
date plus the location move lead time.

Click Apply. The location move request appears with a status of Worksheet on the
Location Move list.

Schedule a Location Move

1.
2.
3.

Select a location move with a status of Worksheet.
Select Schedule from the Action drop-down.

Click Update. If no conflicts are found, the location move request is changed to a
status of Scheduled and it becomes locked and uneditable. The location will be
moved on the effective date.

Note: An alert is given when conflict checking is complete.

Reset a Failed Location Move

1.
2.
3.

4.

Select a location move with a status of Failed.
Select Worksheet from the Action drop-down.

Click Update. The failed location move is changed back to a worksheet location
move request.

Fix the conflict that caused the location move to fail and reschedule it.

View Conflicts

In the Conflict column, click the failed link. The conflict window opens with the
conflict information displayed.

There are three types of conflicts:

Promotion - A promotion from the old or new zone spans the effective date of the
move.

Schedule - There is a location move already scheduled for the location.

Price Strategy - The location or old zone is attached to a price strategy.
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View Move Results

If RPM created any exceptions or exclusions in order for the location to be moved
successfully, those items are viewable in the move results column.

= In the Move Results column, click the completed link. The conflict review window
opens with move results information displayed.

Delete a Location Move

Note: Only location moves in Worksheet status can be
deleted.

Select a location move with a status of Worksheet.

2. (Click Delete. A dialog appears asking "The selected Location Move Request will be
deleted. Canceling this task will not return these records. Do you wish to continue?"

3. (Click Yes to delete the location move.
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Maintain Price Strategies

Pricing strategies allow you to define how prices are proposed when pricing worksheets
are generated. You can define pricing strategies at the department, class, or subclass level
to identify the items that are affected by the strategy. The lowest merchandise level you
can define for a price strategy is determined by the aggregation levels defined for the
department. An item/location can only be on one regular pricing strategy (clearance,
competitive, or margin) and one maintain margin pricing strategy.

After you have created a price strategy, you can maintain different aspects of the price
strategy.

Note: Updates to pricing strategies affect only future
worksheets. Current worksheets will not be updated.

Area Differential

Area Differential Pricing

Area differential pricing allows you to set prices for items at a particular zone or zone
group differently than another zone or zone group. The price differential is based on the
rules you define. Area differentials can be used when you create a price change to ensure
consistent pricing. Differential pricing cannot be applied to other pricing events, such as
clearances or promotions.

When creating an area differential:

* You first establish a primary area, by defining the merchandise hierarchy and zone
hierarchy for the primary area.

* Next, select the zones that fall within the secondary area.

=  Then define how prices for the items in the hierarchy will differ in the secondary

areas from the prices in the primary area. You can choose to price the item higher or
lower by percent, or set the price to the same as the primary area.

*  You can choose to exclude certain items in the merchandise hierarchy from the
secondary area differential prices.

* You can choose to create and associate a competitive pricing strategy with the
secondary area differential.

Area differentials are applied when price changes are created manually or directly from
the Price Strategy workspace. They are also created in the worksheet if there are
item/zone combinations brought into the worksheet that are part of the primary area on
an area differential strategy. When competitive information is associated with an area
differential the worksheet chooses the lower of the retails proposed by the strategies.
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If you set up the secondary area to be auto-approved, secondary area price changes are
conflict checked, and if no conflict exists, created in approved status. If conflicts exist, the
secondary area price change is created in worksheet status. If you set up the secondary
are to not be auto-approved, secondary area price changes are created in worksheet
status. The Change the status of a price change topic provides additional information
about status changes and conflict checking.

Create an Area Differentials

Navigate: From Task Pad, select Price Strategy > Create Price Strategy. The Create
Pricing Strategy workspace opens.

%9 create Pricing Strategy

I(: Strategy Maintenance

Tepe | select- [l

cancel || save + Repeat || Done

Create Pricing Strategy workspace
1. Inthe Type field, select Area Differential.
2. (Click Next. Additional fields appear.

I(:' Strategy Maintenance

| Cefine Secondary Areas ||

Strategy Maintenance pane
3. Enter the ID of the merchandise level you want to apply the area differential to, or
click the LOV El button and select the appropriate merchandise level.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above, if
the definition of the department in the aggregation level
dialog allows it.

4. Select the zones that define the primary area:
=  Zone Group: Enter the ID of the zone group that contains the locations to add to
the area differential price strategy, or click the LOV &l button and select a zone
group.
= Zone: Enter the ID of the zone to add to the area differential price strategy, or
click the LOV =l button and select a zone.
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5.

Click Define Secondary Areas. The Area Differential Strategy Details pane opens.

|(: Area Differential Strateqy Details |

I

Zone ID Zone Mame Differential Percent Auto Approve Price Guide Create Price Changes|

H Auto Approve  [[]

Create Price Changes  []

b Item Exclusion

Area Differential Strategy Details pane

Define Secondary Areas

1. Click New to enable the fields.

2. In the Price Zone field, enter the ID of the zone that you want to add to the secondary
area of the area differential price strategy, or click the LOV &l button and select a
zone.

3. In the Price Guides field, enter the ID of the price guide you want to apply to the
differential pricing, or click the LOV & button and select a price guide.

Note: Only price guides associated with the selected
departments can be selected.

4. Select the Create Price Changes check box to create price changes on the effective
date.

Note: Selecting this check box will create price changes for
all of the items on the strategy at the zone on the secondary
area
5. Inthe Differential field, select how the price differs from the primary area:

=  Price Higher: The items at the specified secondary area are priced higher by the
percentage entered in the Percent field.

=  Price Lower: The items at the specified secondary area are priced lower by the
percentage entered in the Percent field.

=  Price Equal: The items at the specified secondary area are priced the same as the
items in the primary area.
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6. In the Percent field, enter the percent by which the secondary area price is different
from the primary area price.

7. Select the Auto Approve check box to indicate price changes for the area differential
should be created in Approved status.

8. In the Effective Dave field, enter the date on which the price change for the area
differentials should occur.

Note: This field is only enabled if you selected the Create
Price Changes check box.

Exclude Items From the Area Differential

Note: Expand the Item Exclusion section of the Area
Differentials pane to complete the procedure.

1. Enter or select criteria ID of the items you want to exclude.
Click Add. The information is added to the item exclusion table.
To remove an item from the item exclusion table:
a. Select an item.

b. Click Remove. The item is removed from the item exclusion table.

Complete the Area Differential
1. Click Apply. Any changes are added to the table
2. Click Done to save your changes and close the window.

Edit an Area Differential Price Strategy

Navigate: From Task Pad, select Price Strategy > Maintain Price Strategy. The Maintain
Pricing Strategy workspace opens.

%5 Maintain Pricing Strategy

(@ strategy Maintenance |
Pricing Strategies List I
Department | Class Subclass ‘ e o | mre ‘ Lacation | T ‘ Price Guide | Calendar | Calendar Status
Fitter by: =] Fer 21 =] [ ster by x| [iter 21 ||| Fieer 4 x| [ Fiteer 21 ][ Feer 21 x| [ siteer 2y =] Foeer 21 LT
122 . z1 Area al =
5000t ALL Fest..| 1011 ALL Class | 1013 ALL Subel.., | Ranjit 001 Ranjit Test Group | Baltimore Clearance Mane
1234: Glassuare 2G-TCO004b 21 Clearance MNane
1704: *Candida... zG-forDey Z1-USD Clearance SH-1 Assignad
17041 *Candida... 26-000% At Clearance Daily Calendar | Assigned
1704: *Candida... 26-2WH 2-WH Clearance Daily Calendar | Assigned
1221: Kitchenw... | 1000; Utensils | 1000; Gadgets | Rick's Teams Polars Buffals Compatitive Daily Calendar | Assigned
12211 Kitchenwi., 1221 Warehouses| Warehouses Competitive Corin 10/21 Suspended
12211 Kitchenw... | 10001 Utensils | 1000: Gadgets | 1221 Warzhouses| Warehouses Campetitive Starts 10/23, En..| Assigned
1221: Kitchenw... | 1000: Utensils | 1000; Gadgets | Mpls and Farge | Mpls and Fargo Compatitive Daily Calendar | Assignad
99; 316 Meat Ranjit 001 Fanjit Test Group | Baltimore Margin Daily Calendar | Assigned
111: *Test Dep ... HL-CAD HL_CAD Margin Mone
T778: Cost Dept name HL_CAD Margin MNane
2345: Small Ap.. DW USD D USD: Margin MNane 1
2345 Small Apu Ranjit 001 Ranjit Test Group | Edina Margin Hane
77771 Retail Dept MERGH EXTRA.. | My Zonef Z Locs Margin Mane
TTTT: Retail Dept Ranjit 001 Ranjit Test Group Margin MNane
TETT: Retail Dept Ranjit 001 ranjit tast 2 Margin MNane
TT77: Retail Dept Ranjit 001 Mew Zone Margin Mone =

| e ]

cancel || Savs + pepeat |[ pore |

Maintain Pricing Strategy workspace
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1. From the Pricing Strategies List, select the area differential strategy you want to
maintain.

2. Click Edit, or double-click the strategy selected. A second Strategy Maintenance pane
opens and the fields that can be changed are enabled.

I(—“ Strategy Maintenance |

Il

Zone ID | Zone Name | Location ID ‘ Location Name | Differential | Percent | Auto Approve | Price Guide | Create Price Ch:

223 |Dw AU | | ‘ Price Higher | 10% | | | (]

|

cancel |[ save + Repest |[ Dore

Strategy Maintenance pane
3. If you selected an area differential strategy, select the location you want to update.

Remove a Zone From an Area Differential Strategy
1. Select the zone you want to delete.

2. Click Delete. The zone is removed from the table

Exclude Items From the Area Differential

Note: Expand the Item Exclusion section of the Area
Differentials pane to complete the procedure.

Enter or select criteria ID of the items you want to exclude.

2. Click Add. The information is added to the item exclusion table.
To remove an item from the item exclusion table:
a. Select an item.

b. Click Remove. The item is removed from the item exclusion table.

Complete the Area Differential
1. Click Apply. Any changes are added to the table
2. Click Done to save your changes and close the window.
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Clearance Pricing

Clearance Pricing
A clearance pricing strategy allows you to define the method used to markdown items.

= Create a Clearance Pricing Strategy

= Edit a Clearance Price Strategy

Create a Clearance Pricing Strategy
Navigate: From Task Pad, select Price Strategy > Create Price Strategy. The Create

Pricing Strategy workspace opens.

%5 Create Pricing Strategy

I(: Strategy Maintenance

e T

Tepe |- se

cancel |[_save + Repeat ][ _Dons

Create pricing strategy workspace
1. Inthe Type field, select Clearance.
2. Click Next. Additional strategy fields appear.

I(: Strategy Maintenance

* *

Define Strategy Details

Clearance strategy fields
3. Enter the ID of the merchandise level you want to apply the strategy to, or click the

LOV E button and select the appropriate merchandise level.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above, if
the definition of the department in the aggregation level

dialog allows it.

4. Select the zones for the strategy:
Zone Group: Enter the ID of the zone group that contains the locations to add to

the price strategy, or click the LOV El button and select a zone group.
Zone: Enter the ID of the zone to add to the price strategy, or click the LOV

button and select a zone.
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5. In the Price Guides field, enter the ID of the Price Guide field, or click the LOV
button and select a price guide.

Note: Only price guides associated with the selected
departments can be selected.

6. In the Calendar field, enter the ID of the calendar you want to associate with the
strategy, or click the LOV &l button and select a calendar.

7. Inthe Suspend field, select the check box to indicate that reviews of the existing
strategy are stopped.

Note: Clear the check box to indicate the review periods
should begin with the next review period.

8. Inthe New Calendar field, enter the ID of the calendar you want to associate with the
strategy, or click the LOV &l button and select a calendar.

Note: You must select the Suspend check box before you can
add a new calendar.

9. Click Define Strategy Details. The Clearance Strategy Details pane opens.

I(: Clearance Strategy Details

Markdaown Parcent  [Regular Price |}

ctlearance Strategies ” &;

Markdown Number Discount Percent |

Clearance strategy details

Define Clearance Strategy Details

1. Inthe Markdown Percent field, select the price from which the clearance price is
calculated.

Click Add Row.
In the Discount Percent field, enter the percent of the markdown.
Click Apply.

Note: If the price from which the clearance price is calculated
is Regular Retail, the Discount Percent fields must increase
with each markdown added.
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Edit a Clearance Price Strategy

Navigate: From Task Pad, select Price Strategy > Maintain Price Strategy. The Maintain
Pricing Strategy workspace opens.

%5 Maintain Pricing Strategy

(@ strategy Maintenance |
Pricing Strategies List I
Department | class | subelass | zone Group | zone | Location | ype | Price Guide | calendar | calendar status |
Filter b || Fitter by =] [ uter ] [Fitter by ||| Fitter by x| [Fitter by [=]|[ Fiter s > [Fiter by [*]|[ Fitter by >|[Fer by [=]
5000t ALL Fest..| 1011 ALL Class | 1013 ALL Subel.., | Ranjit 001 Ranjit Test Group | Baltimore Clearance Mane
1234: Glassuare 2G-TCO004b 21 Clearance Mane
1704: *Candida.,.. zG-forDey Z1-USD Clearance SH-1 Assignad
1704 *Candida.. 2G-0009 AL Clearance Daily Calendar Assigned
17041 *Candida... 2G-2WH Z-WH Clearance Daily Calendar | Assigned
1221: Kitchenw... | 1000: Utensils | 1000: Gadgets | Rick's Teams Polars Buffals Competitive Daily Calendar | Assigned
1221 Kitchenw... 1221 Warehouses| Warehouses Competitive Corin 10/21 Suspended
12211 Kitchenw... | 1000: Utensils | 1000: Gadgets | 1221 Warzhouses| Warehouses Competitive Starts 10/23, En..| Assigned
1221: Kitchenw... | 1000: Utensils | 1000; Gadgets | Mpls and Fargo | Mpls and Fargo Campetitive Daily Calendar | Assigned
99; S1G Maat Ranjit 001 Ranjit Test Group | Baltimore Margin Daily Calendar | Assigned
111: *TestDep HL-GAD HL_CAD Margin Hane
7778 Cost Dept name HL_CAD Margin Hane
2345: Small Ap.. DW USD D USD: Margin MNene 1
2345: Small Ap.. Ranjit 001 Ranjit Test Group | Edina Margin MNane
T7774 Retail Dept MERGH EXTRAW | My Zonef Z Locs Margin Hane
TT7Tt Retail Dept Ranjit 001 Ranjit Test Group Margin Mane
TT7T: Retail Dept Ranjit 001 ranjit tast 2 Margin MNane
TT7: Retail Dept Ranjit 001 Mew Zone Margin Hane =

| |

cancel || save + Repeat |[ pore |

Maintain Pricing Strategy workspace
1. From the Pricing Strategies List, select the clearance strategy you want to maintain.

2. (Click Edit, or double-click the strategy selected. A second Strategy Maintenance pane
opens and the fields that can be changed are enabled.

—
(E—} Strategy Maintenance |
Type CIearancalE‘
* *
Departmant (3q W+ erch Extract R Zane Group  |sgg W rs
Class B+ Zane a08 B+ v
Subclass B+ Location B+
Calendar Daily Calendar . Mew Calendar .
Markdown Percent  [Regular Price |E|
Markdown Hurmber Discount Percent
Remove Markdown | _Edit [ add Rew |
Clearance Strategies Il
Markdovsn Number Discount Percent
1 266
z 36
-

cancel |[_save +Repeat || _pore |

3. Make necessary changes.
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Edit a Price Guide

= Change or enter a price guide name or click the LOV &l button and select the
appropriate price guide if necessary.

Change Calendars

Note: In order to specify a new calendar, the existing
calendar must be suspended.

1. Select the Suspend checkbox.

2. Enter a calendar name, or click the LOV E1 button and select a calendar

Edit a Markdown

1. Select the Markdown number from the Clearance Strategies table.
2. Click Edit. The Discount Percent field is enabled.

3. Edit the discount percent.

4. Click Apply.

Delete a Markdown

1. Select the highest Markdown number from the Clearance Strategies table.
2. Click Remove Markdown.

3. Click Apply.

Clearance Defaults

Clearance Defaults Pricing

A clearance defaults pricing strategy allows you to set up a strategy for generating
subsequent markdowns after an initial clearance event.

= Create a Clearance Defaults Pricing Strategy
= Edit a Clearance Defaults Price Strategy
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Create a Clearance Defaults Pricing Strategy

Navigate: From Task Pad, select Price Strategy > Create Price Strategy. The Create
Pricing Strategy workspace opens.

%5 Create Pricing Strategy

I-f(—" Strategy Maintenance

Type [ select - =

cancel || ssve + Repeat |[ pone

Create pricing strategy workspace
1. Inthe Type field, select Clearance Defaults.
2. Click Next. Additional strategy fields appear.

I'@ Strategy Maintenance

* Departrment l:l %_'_
8
8

| Cefine Strategy Details ||

Clearance Defaults strategy fields
3. Enter the ID of the merchandise level you want to apply the strategy to, or click the
LOV B button and select the appropriate merchandise level.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above, if
the definition of the department in the aggregation level
dialog allows it.

4. C(lick Define Strategy Details. The Clearance Defaults Strategy Details pane opens.

|'@ Clearance Strategy Details |

Discount Percent I:I
Drays after First l:l
Reset Price this many days after out of stock date l:l add Row Apply
I &,
Markdown Number | Discount Percent Days after First |

Clearance Defaults strategy details
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Define Clearance Strategy Details

1. Enter the percent of the first markdown after the initial markdown in the Discount
Percent field.

2. Enter how many days after the first markdown that this markdown should be taken
in the Days after First field.

3. Enter when to reset the price to regular price in the Reset Price this many days after
out of stock date field.

4. Click Apply. A row is added to the table.

Add Subsequent Markdowns
1. Click Add Row.

2. Enter a percent in the Discount Percent field.

Note: Subsequent markdown percents must be greater than
the previous.

3. Enter a number of days in the Days after First field.
4. Click Apply. The markdown is added to the table.

I(:' clearance Strategy Details

Add Row
||
Markdown Number Discount Percent Days after First
1 10%|5
2 15910

Clearance Defaults Strategy Details pane with markdowns
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Edit a Clearance Defaults Price Strategy

Navigate: From Task Pad, select Price Strategy > Maintain Price Strategy. The Maintain
Pricing Strategy workspace opens.

ﬁ Maintain Pricing Strategy

(@ strategy Maintenance |
Pricing Strategies List Ile?
Department | Class | Subclass | Zone Group | Zone | Location | Type | Price Guide | Calendar | Calendar Status |
Fitber by: || [ tker by x| [eer by > [Fer by []|[ Fiber oy ] [Fter by [>]|[ Futer by > [Fuer by ][ Fuer by > ||[ Futer by >
S000: ALL Fest...| 101: ALL Class | 101: ALL Subcl... | Ranjit 001 Ranjit Test Group | Baltimers Claarance Nens
1234: Glassware Z2G-TCO004h Z1 Clearance Mone
1704 *Candida... z6-forDev 71-UsD Clearance SH-1 Assigned
1704 *Candida... z5-0009 a1 Claarance Daily Calendsr | Assianad
1704: *Candida... 23-ZWH Z-uH Clearancs Daily Calendar | Assignad
1221: Kitchenw... | 1000; Utensils | 1000; Gadgets | Rick's Teams Palars Buffalo Competitive Daily Calendar Assigned
1221: Kitchenu... 1221 Warehouses| Warshouses Competitive Corin 10721 Suspended
1221: Kitchenw... | 1000: Utensils | 1000: Gadgets | 1221 Warshouses | Warshouses Competitive Starts 10/23, En..| Assigned
1221: Kitchenw., | 1000; Utensils | 1000; Gadgets | Mpls and Farge | Mpls and Fargs Competitive Daily Galendar | Assignad
33, 816 Meat Ranjit 001 Ranjit Test Group | Baltimore Margin Daily Calendsr | Assigned
111t *Test Dep .., HL-CAD HL_CAD Marain Nene
TT78: Cost Dept name HL_CAD Fargin Nens
2345: 3mall Ap.., W USD oW USD Fargin Mane -
23451 Small Ap... Ranjit 001 Ranjit Test Group | Edins Marain Nene
77T Retail Dapt MERCH EXTRA... | My Zone/ 2 Locs Fargin Nens
TETT: Retail Dapt Ranjit 001 Ranjit Test Group Fargin Nens
T7FT Retail Dept Ranjit 001 ranjit test 2 Margin Mane
7777 Retail Depe Ranjit 001 New Zene Marain Nene =

| Cean ||

cancel |[_save +Repeat |[_Done |

Maintain Pricing Strategy workspace

1. From the Pricing Strategies List, select the clearance defaults strategy you want to
maintain.

2. Click Edit, or double-click the strategy selected. A second Strategy Maintenance pane
opens and the fields that can be changed are enabled.

I@ Strategy Maintenance |

Type |Clearance Defaultsli‘

*
Departrnent  |2345 .+ srnall Appliances
Class 1001 .+ Bathroom Applial
Subclazs 1000 .+ Menz Shavers

Discount Percent l:l

Days after First

Rezet Price this many days after out of stack date  [g5q Add Raow Apply
I &,

Markdown Number Discount Percent Days after First
1 159 (7

2 0% |14

2 S0%5 (21

| Edit I Femove Markdown

Strategy Maintenance pane
3. Make necessary changes.
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Add Subsequent Markdowns

1. Select which row you want to add the markdown before.
2. Click Add Row.

3. Enter a percent in the Discount Percent field.

Note: Subsequent markdown percents must be greater than
the previous.

&

Enter a number of days in the Days after First field.
Click Apply. The markdown is added to the table.

7= Clearance Strategy Details
(&

o

Markdown Number Discount Parcent Days after First

1 10% |5

2 15% (10

Clearance Defaults Strategy Details pane with markdowns

Edit a Markdown

1. Select the Markdown number from the Clearance Strategies table.

2. Click Edit. The Discount Percent and Days after First fields are enabled.
3. Edit the discount percent and days after first values.

4. Click Apply.

Delete a Markdown

1. Select the highest Markdown number from the Clearance Strategies table.
2. Click Remove Markdown.

3. Click Apply.

Pricing Strategies 85



Competitive Pricing

Competitive Pricing

Competitive Pricing
A competitive pricing strategy allows you to define your pricing strategy for items based
on your primary competitor's prices

Note: All locations in a competitive pricing strategy must
use the same currency.

You can also assign reference competitors to a competitive pricing strategy. This
information allows you to compare the proposed prices to the prices available from other
retailers. If the proposed prices vary from the target percentages defined for the reference
competitors, you are informed so you can adjust the price in the pricing worksheet.

Create a Competitive Pricing Strategy
Navigate: From Task Pad, select Price Strategy > Create Price Strategy. The Create
Pricing Strategy workspace opens.

%5 Create Pricing Strategy

I(—" Strategy Maintenance

Type [ select - =

cancel_|[_save + Repeat |[_Don=

Create pricing strategy workspace
1. Inthe Type field, select Competitive.
2. Click Next. Additional strategy fields appear.

‘(—“ Strategy Maintenance

=
-
=
S|
e — g

Define Strategy Details

Competitive strategy fields
3. Enter the ID of the merchandise level you want to apply the strategy to, or click the

LOV El button and select the appropriate merchandise level.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above, if
the definition of the department in the aggregation level
dialog allows it.
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4. Select the zones for the strategy:
=  Zone Group: Enter the ID of the zone group that contains the locations to add to
the price strategy, or click the LOV &l button and select a zone group.
= Zone: Enter the ID of the zone to add to the price strategy, or click the LOV
button and select a zone.

5. In the Price Guides field, enter the ID of the Price Guide field, or click the LOV
button and select a price guide.

Note: Only price guides associated with the selected
departments can be selected.

6. Inthe Calendar field, enter the ID of the calendar you want to associate with the
strategy, or click the LOV &l button and select a calendar.

7. Inthe Suspend field, select the check box to indicate that reviews of the existing
strategy are stopped.

Note: Clear the check box to indicate the review periods
should begin with the next review period.

8. In the New Calendar field, enter the ID of the new calendar you want to associate
with the strategy, or click the LOV & button and select a calendar.

Note: you must select the Suspend check box before you can
add a new calendar.

9. Click Define Strategy Details. The Competitive Strategy Details pane opens.

@ Competitive Strategy Details
[~

Compste Type fracr [7]

+ Reference Competitors

Carnpetitar Carnpetitar Store Campete Type Percent

LU B S T I
[

il [ O @

Z I NEIEIENRE

Py o | e |||y

& ESESNETES

[« [ B [ [

Competitive strategy details
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Define Competitive Strategy Details

1. Inthe Competitor field, enter the ID of the primary competitor or click the LOV
button and select a competitor.

2. Inthe Competitor Store field, enter the ID of the store that proposed retails are being
compared against.

Note: The currency at the competitor store must be the same
as the zones previously selected.

3. Inthe Compete Type, select how the price strategy determines the prices:
= Match: Prices are proposed to be the same as the primary competitor's prices.

= Price Above: Prices are proposed to be a percentage above the primary
competitor's prices.

=  Price Below: Prices are proposed to be a percentage below the primary
competitor's prices.

= Price by Code: Prices are proposed by the market basket code for the
merchandise hierarchy/zone.

Define Match Strategy Details
1. Define reference competitors as necessary.

2. Click Done to save any changes and close the workspace.

Define Price Above or Price Below Strategy Details

1. Inthe Compete Percent field, enter the percent above or below the primary
competitor's price that the new price is set at.

2. Setup the acceptable range:

Note: Acceptable range is the amount by percentage that a
retail price can vary from a primary competitor before a
price change is proposed.

a. Inthe Acceptable Range From field, enter the bottom of the range.
b. Inthe Acceptable Range To field, enter the top of the range.
Define reference competitors as necessary.

Click Done to save any changes and close the workspace.

Define Price by Code Strategy Details

1. Inthe Code field, select the competitive market basket code you want to use to set
the price.

2. Inthe Compete Type, select how the price strategy determines the prices:
=  Match: Prices are proposed to be the same as the primary competitor's prices.

= Price Above: Prices are proposed to be a percentage above the primary
competitor's prices.

= Price Below: Prices are proposed to be a percentage below the primary
competitor's prices.

3. Inthe Compete Percent field, enter the percent above or below the primary
competitor's price that the new price is set at.
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4. Setup the acceptable range:

Note: Acceptable range is the amount by percentage that a
retail price can vary from a primary competitor before a
price change is proposed.

a. Inthe Acceptable Range From field, enter the bottom of the range.
b. Inthe Acceptable Range To field, enter the top of the range.
Define reference competitors as necessary.

Click Done to save any changes and close the workspace.

Define Reference Competitors

1. In the Reference Competitors section, enter the ID of the competitor in the
Competitor field, or click the LOV El button and select a competitor.

2. In the Competitor Store field, enter the ID of the store, or click the LOV &l button and
select a store.

3. Inthe Compete Type, select how to compare prices to the reference competitors:

= Match: A pass or fail indicator appears on the worksheet depending on if the
proposed price matches the referenced competitors price.

= Price Above: A pass or fail indicator appears on the worksheet depending on if
the proposed price is at least the specified percent above the referenced
competitor's price.

= Price Below: A pass or fail indicator appears on the worksheet depending on if
the proposed price is at least the specified percent below the referenced
competitor's price.

4. If you selected Price Above or Price Below, enter the percent above or below the
competitor's price that the new price is compared.

5. Click Done to save any changes and close the workspace.

Create a Competitive Price Strategy Associated with an Area Differential

Note: Expand the Competitor section of the Area
Differentials pane to complete the procedure.

1. Inthe Competitor field, enter the ID of the competitor or click the LOV & button and
select a competitor.

2. In the Competitor Store field, enter the ID of the store that proposed retails are being
compared against or click the LOV =l button and select a store.

Note: The currency at the competitor store must be the same
as the zones previously selected.
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3. Inthe Compete Type, select how the price strategy determines the prices:
=  Match: Prices are proposed to be the same as the competitor's prices.

= Price Above: Prices are proposed to be a percentage above the competitor's
prices.

=  Price Below: Prices are proposed to be a percentage below the competitor's
prices.

= Price by Code: Prices are proposed by the market basket code for the
merchandise hierarchy/zone.

Define Match Strategy Details
1. Define reference competitors as necessary.

2. Click Done to save any changes and close the workspace.

Define Price Above or Price Below Strategy Details

1. Inthe Compete Percent field, enter the percent above or below the competitor's price
that the new price is set at.

2. Setup the acceptable range:

Note: Acceptable range is the amount by percentage that a
retail price can vary from a competitor before a price change
is proposed.

a. Inthe Acceptable Range From field, enter the bottom of the range.
b. Inthe Acceptable Range To field, enter the top of the range.
Define reference competitors as necessary.

Click Done to save any changes and close the workspace.

Define Price by Code Strategy Details

1. Inthe Code field, select the competitive market basket code you want to use to set
the price.

2. Inthe Compete Type, select how the price strategy determines the prices:
= Match: Prices are proposed to be the same as the competitor's prices.

= Price Above: Prices are proposed to be a percentage above the competitor's
prices.

=  Price Below: Prices are proposed to be a percentage below the competitor's
prices.

3. Inthe Compete Percent field, enter the percent above or below the competitor's price
that the new price is set at.

4. Setup the acceptable range:

Note: Acceptable range is the amount by percentage that a
retail price can vary from a competitor before a price change
is proposed.

a. Inthe Acceptable Range From field, enter the bottom of the range.
b. Inthe Acceptable Range To field, enter the top of the range.
Define reference competitors as necessary.

Click Done to save any changes and close the workspace.
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Define Reference Competitors

Note: Expand the Reference Competitor section of the Area
Differentials pane to complete the procedure.

1. In the Reference Competitors section, enter the ID of the competitor in the
Competitor field, or click the LOV E button and select a competitor.

2. In the Competitor Store field, enter the ID of the store, or click the LOV % button and
select a store.

3. In the Compete Type, select how to compare prices to the reference competitors:

=  Match: A pass or fail indicator appears on the worksheet depending on if the
proposed price matches the referenced competitors price.

= Price Above: A pass or fail indicator appears on the worksheet depending on if
the proposed price is at least the specified percent above the referenced
competitor's price.

=  Price Below: A pass or fail indicator appears on the worksheet depending on if
the proposed price is at least the specified percent below the referenced
competitor's price.

4. If you selected Price Above or Price Below, enter the percent above or below the
competitor's price that the new price is compared.

5. Click Done to save any changes and close the workspace.

Edit a Competitive Pricing Strategy

Navigate: From Task Pad, select Price Strategy > Maintain Price Strategy. The Maintain
Pricing Strategy workspace opens.

B9 Maintain Pricing Strategy

(& strategy Maintenance |
Pricing Strategies List Il
Department | Class | Subclass ‘ Zone Group | Zone ‘ Location | Type ‘ Price Guide | Calendar | Calendar Status |
Fiter by ||| e 8y x| [ rtter by ||| Fiteer by M x| [ e 8y = ||[ e 8y || [ e 8y ||| e by ||| e by -

z are al one
S000: ALL Fest..| 101; ALL Class | 101: ALL Subel.., | Ranjit 001 Ranjit Test Group | Baktimore Clearance MNane
1234: Glassware 2G-TCO004D z1 Clearance Hane
17041 *Candida... 2G-farDey 21-UsD Clearance SH-1 Assigned
1704: *Candida... 26-0003 AL Clearance Daily Calendsr | Assigned
1704: *Candida... 26-2WH 2-WH Clearance Daily Calendar | Assigned
1221 Kitchenw., | 1000; Utensils | 1000; Gadgets | Rick's Teams Polars guffalo Competitive Caily Galendar | Assigned
12211 Kitchenw... 1221 Warehouses| Warehouses Campetitive Corin 1021 Suspended
1221: Kitchenw... | 1000: Utensils | 1000: Gadgets | 1221 Warshouses | Warshouses Competitive Starts 10/23, En..| Assigned
1221: Kitchenw... | 1000; Utensils | 1000; Gadgets | Mpls and Farge | Mpls and Fargo Competitive Daily Calendar | Assigned
29; 516G Meat Ranjit 001 Ranjit Test Group | Baltimore Margin Daily Calendar Assigned
1111 *TestDep o HL-CAD HL_CAD Margin Mane
T778: Cost Dept name HL_CAD Margin MNane
2345: Small Ap.. DW USD DW USD: Margin Hane 1
2345 Small Ap.. Ranjit 001 Ranjit Test Group | Edina Margin Hane
TTTT: Retail Dept MERGH EXTRA.. | My Zonef 2 Locs Margin MNane
TTTT: Retail Dept Ranjit 001 Ranjit Test Group Margin MNane
T777: Retail Dept Ranjit 001 ranjit test 2 Margin Hane
TT7Tt Retail Dept Ranjit 001 Mew Zone Margin Mane =
| |

cancel |[_save +Repeat |[_Done |

Maintain Pricing Strategy workspace
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1. From the Pricing Strategies List, select the competitive strategy you want to maintain.

2. Click Edit, or double-click the strategy selected. A second Strategy Maintenance pane
opens and the fields that can be changed are enabled.

(@ strategy Maintenance |\:I
| L]
| |
8 8
Price Guide l:l% Suspend O
8 a8
Competitor E Corin's Compet... Competitor Store | go1 B
~ Reference Competitors
Competitor Competitor Store Compete Type Percent
N — a
N — ¥
N I = [
N — 8 _
S —" 5 -
A4
Cancel ” Save + Repeat H Done
3. Make necessary changes.
Edit a Price Guide
= Enter the price guide name or click the LOV El button and select the appropriate
price guide.

Change calendars

Note: In order to specify a new calendar, the existing
calendar must be suspended.

1. Select the Suspend checkbox.

2. Enter a calendar name, or click the LOV El button and select a calendar
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Edit a Competitor

1. Inthe Competitor field, enter or change the competitor ID, or click the LOV
button and select the appropriate competitor.

2. In the Competitor Store field, enter a competitor store ID, or click the LOV [l button
and select the appropriate store.

In the Compete Type drop-down, select the compete type.

For Price Above and Price Below compete types, setup the acceptable range:

Note: Acceptable range is the amount by percentage that a
retail price can vary from a competitor before a price change
is proposed.

a. Inthe Acceptable Range From field, enter the bottom of the range.
b. Inthe Acceptable Range To field, enter the top of the range.

Edit Reference Competitors

Define reference competitors as necessary.

Complete the Competitive Price Strategy
1. Click Save + Repeat to commit your changes.

2. Click Done to save any changes and close the workspace.
Margin Pricing

Margin Pricing
A margin pricing strategy allows you to define the pricing strategy for items based on
margin targets.
* Create a margin pricing strategy

= Edit a Margin Pricing Strategy
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Create a Margin Pricing Strategy
Navigate: From Task Pad, select Price Strategy > Create Price Strategy. The Create

Pricing Strategy workspace opens.

%5 Create Pricing Strategy

I(—" Strategy Maintenance

Type [ select - =

cancel || ssve + Repeat |[ pone

Create pricing strategy workspace
1. Inthe Type field, select Margin.
2. Click Next. Additional strategy fields appear.

I(—"' Strategy Maintenance

| Dafine Strategy Details |

Margin strategy fields
3. Enter the ID of the merchandise level you want to apply the strategy to, or click the

LOV EI* button and select the appropriate merchandise level.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above, if

the definition of the department in the aggregation level
dialog allows it.

4. Select the zones for the strategy:
Zone Group: Enter the ID of the zone group that contains the locations to add to

the price strategy, or click the LOV &l button and select a zone group.

Zone: Enter the ID of the zone to add to the price strategy, or click the LOV El*

button and select a zone.
In the Price Guides field, enter the ID of the Price Guide field, or click the LOV

button and select a price guide.

Note: Only price guides associated with the selected
departments can be selected.
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6. In the Calendar field, enter the ID of the calendar you want to associate with the
strategy, or click the LOV &l button and select a calendar.
7. Inthe Suspend field, select the check box to indicate that reviews of the existing
strategy are stopped.
Note: Clear the check box to indicate the review periods
should begin in the next period.
8. In the New Calendar field, enter the ID of the calendar you want to associate with the
strategy, or click the LOV &l button and select a calendar.
Note: you must select the Suspend check box before you can
add a new calendar.
9. Click Define Strategy Details. The Margin Strategy Details pane opens.
I(: Margin Strategy Details
Code Fselect - [7] Acceptable Range From l:l
Margin Target I:I Acceptable Range To l:l
Margin Strategy Details " y;
Code | Margin Target Acceptable Range From | Acceptable Range To |
+ Reference Competitors
Competitor Competitor Store Compete Type Percent
N e
N I = &
N I =
o = s
e[ 8 &

Margin strategy details

Define Margin Strategy Details

1.

In the Code field, select the margin market basket code you want to use to set the
price.

In the Margin Target field, enter the percent of margin you want to earn on the
item/zone.

Setup the acceptable range:

Note: Acceptable range is the amount by percentage that a
margin can vary from the target before a price change is
proposed.

a. Inthe Acceptable Range From field, enter the bottom of the range.
b. Inthe Acceptable Range To field, enter the top of the range.
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4. Click Apply. An entry is added to the Margin Strategy Details table.
5. Define reference competitors as necessary.

6. Click Done to save any changes and close the workspace.

Edit a Margin Pricing Strategy

Navigate: From Task Pad, select Price Strategy > Maintain Price Strategy. The Maintain
Pricing Strategy workspace opens.

B9 Maintain Pricing Strategy

(& strategy Maintenance |
Pricing Strategies List Il
Department | Class | Subclass | Zone Group | Zone | Location | Type | Price Guide I Calendar | Calendar Status I
Fiter by ||| e 8y x| [ rtter by ||| Fiteer by M x| [ e 8y = ||[ e 8y || [ e 8y ||| e by ||| e by -

z Ave ial h

S000: ALL Fest..| 101; ALL Class | 101: ALL Subel.., | Ranjit 001 Ranjit Test Group | Baktimore Clearance MNane

1234: Glassware 2G-TCO004D z1 Clearance Hane

17041 *Candida... 2G-farDey 21-UsD Clearance SH-1 Assigned

1704: *Candida... 26-0003 AL Clearance Daily Calendsr | Assigned

1704: *Candida... 26-2WH 2-WH Clearance Daily Calendar | Assigned

1221 Kitchenw., | 1000; Utensils | 1000; Gadgets | Rick's Teams Polars guffalo Competitive Caily Galendar | Assigned

12211 Kitchenw... 1221 Warehouses| Warehouses Campetitive Corin 1021 Suspended

1221: Kitchenw... | 1000: Utensils | 1000: Gadgets | 1221 Warshouses | Warshouses Competitive Starts 10/23, En..| Assigned

1221: Kitchenw... | 1000; Utensils | 1000; Gadgets | Mpls and Farge | Mpls and Fargo Competitive Daily Calendar | Assigned

29; 516G Meat Ranjit 001 Ranjit Test Group | Baltimore Margin Daily Calendar Assigned

1111 *TestDep o HL-CAD HL_CAD Margin Mane

T778: Cost Dept name HL_CAD Margin MNane

2345: Small Ap.. DW USD DW USD: Margin Hane 1

2345 Small Ap.. Ranjit 001 Ranjit Test Group | Edina Margin Hane

TTTT: Retail Dept MERGH EXTRA.. | My Zonef 2 Locs Margin MNane

TTTT: Retail Dept Ranjit 001 Ranjit Test Group Margin MNane

T777: Retail Dept Ranjit 001 ranjit test 2 Margin Hane

TT7Tt Retail Dept Ranjit 001 Mew Zone Margin Mane =
| |

cancel |[_save +Repeat |[_Done |

Maintain Pricing Strategy workspace
1. From the Pricing Strategies List, select the margin strategy you want to maintain.

2. Click Edit, or double-click the strategy selected. A second Strategy Maintenance pane
opens and the fields that can be changed are enabled.
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I/CJ Strategy Maintenance ||:I
8 a8
8 B
8 B
Price Guide l:l% Suspend
| 8
Cade Acceptable Range Fram l:l
Margin Target l:l Acceptable Range To l:l I
mMargin Strategy Details " &
Code | Margin Target | Acceptable Range From ‘ Acceptable Range To
Mo Code |5% |4% |6%
+ Reference Competitors
Competitor Competitor Store Compete Type Percent
A 18 B
N — &
S — 8 -
) — & B
S — 8 - _
[ carcel J[ save + Repeat || pone |

3. Make necessary changes.

Edit a Price Guide
=  Enter the price guide name or click the LOV H button and select the appropriate
price guide.

Change Calendars

Note: In order to specify a new calendar, the existing
calendar must be suspended.

1. Select the Suspend checkbox.

2. Enter a calendar name, or click the LOV % button and select a calendar

Edit Margin Details

1. Select a row in the Margin Strategy Details table.

2. Inthe Margin Target field, enter the percent of margin you want to earn on the
item/zone.

Note: Acceptable range is the amount by percentage that a
margin can vary from the target before a price change is
proposed.
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3. Inthe Acceptable Range From field, enter the bottom of the range.
4. In the Acceptable Range To field, enter the bottom of the range.
5. Click Apply.

Delete Margin Details
1. Select the margin detail from the Margin Strategy Details table.

2. Click Delete. The row is removed from the table.

Edit Reference Competitors

= Define reference competitors as necessary.

Complete the Margin Price Strategy
1. Click Save + Repeat to commit your changes.

2. Click Done to save any changes and close the workspace.
Maintain Margin Pricing

Maintain Margin Pricing

A maintain margin pricing strategy allows you to define the pricing strategy for items
based on future cost changes. The proposed retails can be based on current or market
basket margin percentages. Reference competitors may be assigned for comparison
purposes.

* Create a maintain margin pricing strategy

= Edit a Maintain Margin Pricing Strategy

Create a Maintain Margin Pricing Strategy

Navigate: From Task Pad, select Price Strategy > Create Price Strategy. The Create
Pricing Strategy workspace opens.

%9 create Pricing Strategy

I'(_: Strategy Maintenance

Type [ select- [~

cancel || save + Repeat || Done

Create pricing strategy workspace

98 Oracle Retail Price Management



Pricing Strategies

1.
2.

In the Type field, select Maintain Margin.
Click Next. Additional strategy fields appear.

( (:' Strategy Maintenance

* *

Cefine Strategy Details |

Maintain margin strategy fields

3.

Enter the ID of the merchandise level you want to apply the strategy to, or click the
LOV E button and select the appropriate merchandise level.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above, if
the definition of the department in the aggregation level
dialog allows it.

Select the zones for the strategy:

=  Zone Group: Enter the ID of the zone group that contains the locations to add to
the price strategy, or click the LOV &l button and select a zone group.

=  Zone: Enter the ID of the zone to add to the price strategy, or click the LOV
button and select a zone.

In the Price Guides field, enter the ID of the Price Guide field, or click the LOV

button and select a price guide.

Note: Only price guides associated with the selected
departments can be selected.

In the Calendar field, enter the ID of the calendar you want to associate with the
strategy, or click the LOV &l button and select a calendar.

In the Suspend field, select the check box to indicate that reviews of the existing
strategy are stopped.

Note: Clear the check box to indicate the review periods
should begin in the next period.

In the New Calendar field, enter the ID of the calendar you want to associate with the
strategy, or click the LOV &l button and select a calendar.

Note: you must select the Suspend check box before you can
add a new calendar.
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9. Click Define Strategy Details. The Margin Strategy Details pane opens.

(@ Maintain Margin strategy Details

Auto Approve I:‘ * Cost Change Forward Days “ |
* Method () Market Basket Margin B

[ : ) Current Margin

* Reference Competitors

Competitor Competitor Store Compete Type Parcent
S = | ot ]
e[ |B |
N I = " pen 3]
o[ B |
8 ] e T3]

Maintain margin strategy details

Define Maintain Margin Strategy Details

1. Select the Auto Approve check box to indicate price changes should be created in
Approved status.

2. Inthe Cost Change Forward Days, enter the number of days into the next review
period that the strategy will consider cost changes when proposing price changes.

Note: Cost Change Forward Days should not exceed the
length of a review period.

3. Select the method for the strategy:

= Market Basket Margin: Select to have the margin for the item's market basket
applied to the item's new cost. The Margin Strategy Details area appears.

I@ Maintain Margin Strategy Details |

Auto Approve D * Cast Change Forward Days |

* method (®)|Mark et Basket Margin

() Current Margin

N P S
Margin Strategy Details |
Code Margin Target Acceptable Range From Acceptable Range To |

= Reference Competitors

Cornpetitor Competitor Stare Cormpete Type Parcent
N ]
e[ B e [5]
o[ 18 |
o] ]
e[ |8 B protcn [

Margin strategy details
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= Current Margin: Select to have the current margin applied to the item's new cost.
The current margin fields enable.

I-'(f—"! Maintain Margin Strategy Details ‘

Aute Approve [ ¥ Cast Change Farward Days |

¥ Method ) Market Basket Margin Increase (C) Margin %

® [Current Margin (") Change by Cost Change Amount
Decrease () Margin %

) Change by Cost Change Amount

* Reference Competitors

Competitor Competitor Store Compete Type Percent

= g
=
= = mash 7]
= =
= =

Current margin increase and decrease fields

Define Market Basket Margin

1.

6.

In the Code drop-down, select the margin market basket code you want to use to set
the price.

In the Margin Target field, enter the percent of margin you want to earn on the
item/ zone.

Setup the acceptable range:

Note: Acceptable range is the amount by percentage that a
margin can vary from the target before a price change is
proposed.

a. Inthe Acceptable Range From field, enter the bottom of the range.
b. Inthe Acceptable Range To field, enter the top of the range.

Click Apply. An entry is added to the Maintain Strategy Details table.
Define reference competitors as necessary.

Click Done to save any changes and close the workspace.

Define Current Margin

1.

2.

3.

Select how the strategy will apply an increase in margin to a proposed retail:

=  Margin %: Select to have the percent of the cost change added to the basis retail
to determine the proposed retail.

= Change by Cost Change Amount: Select to have the amount of the cost change
added to the basis retail.

Select how the strategy will apply a decrease in margin to a proposed retail:

= Margin %: Select to have the percent of the cost change subtracted from the basis
retail to determine the proposed retail.

= Change by Cost Change Amount: Select to have the amount of the cost change
subtracted from the basis retail.

Click Done to save any changes and close the workspace.
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Define Reference Competitors

1. Inthe Reference Competitors section, enter the ID of the competitor in the
Competitor field, or click the LOV B button and select a competitor.

2. In the Competitor Store field, enter the ID of the store, or click the LOV % button and
select a store.

3. In the Compete Type, select how to compare prices to the reference competitors:

=  Match: A pass or fail indicator appears on the worksheet depending on if the
proposed price matches the referenced competitors price.

= Price Above: A pass or fail indicator appears on the worksheet depending on if
the proposed price is at least the specified percent above the referenced
competitor's price.

=  Price Below: A pass or fail indicator appears on the worksheet depending on if
the proposed price is at least the specified percent below the referenced
competitor's price.

4. If you selected Price Above or Price Below, enter the percent above or below the
competitor's price that the new price is compared.

5. Click Done to save any changes and close the workspace.

Edit a Maintain Margin Pricing Strategy

Navigate: From Task Pad, select Price Strategy > Maintain Price Strategy. The Maintain
Pricing Strategy workspace opens.

ﬁ Maintain Pricing Strategy

I/(-W Strategy Maintenance |
Pricing Strategies List Ile?
Department | Class | Subclass ‘ Zone Group | Zone ‘ Location | Type ‘ Price Guide | Calendar | Calendar Status |
Fiiter by ||| e 8y ||| Fter by x| [ e by x||[ e 8y MIEEDS ||| e 8y x||[ e 2y ||| e = ||[ e by >

) E Ares al

SO00: ALL Fest..| 101 ALL Class | 101: ALL Subel.., | Ranjit D01 Ranjit Test Group | Baltimore Clearance MNane
12341 Glassware 2G-TCODDAL z1 Clearance MNane
17041 *Candida... 2G-farDey Z1-UsD Clearance SH-1 Assignad
1704: *Candida... 26-000% AL Clearance Daily Calendar | Assigned
1704: *Candida... 26-2WH Z-WH Clearance Daily Calendar | Assigned
12211 Kitchenw... | 1000; Utensils | 1000; Gadgets | Rick's Teams Polars Buffalo Competitive Daily Calendar | Assigned
1221: Kitchenw... 1221 Warshouses| Warzhauses Campetitive Corin 10/21 Suspended
1221: Kitchenw... | 1000: Utensils | 1000: Gadgets | 1221 Warshouses | Warshouses Competitive Starts 10/23, En..| Assigned
1221 Kitchenw.,, | 10001 Utensils | 1000; Gadgets | Mpls and Farge | Mpls and Fargo Competitive Caily Galendar | Assigned
391 516 Meat Ranjit 001 Ranjit Test Group | Baltimore Margin Daily Calendar | Assigned
111: *TestDep o HL-CAD HL_CAD Margin Mane
TT78: Cost Dept name HL_CAD Margin Mane
2345 Small Apu oH USD oW USD: Margin Hane 1
2245t Small Ap.. Ranjit 001 Ranjit Test Group | Edina Margin Mane
TT7T: Retail Dept MERCH EXTRA.. | My Zonef 2 Locs Margin Mane
TTTT: Retail Dept Ranjit 001 Ranjit Test Group Margin MNane
77771 Retail Dept Ranjit 001 ranjit test 2 Margin MNane
TT7Tt Retail Dept Ranjit 001 Mew Zone Margin Mane =

| Cean ||

cancel |[_save +Repeat |[_Done |

Maintain Pricing Strategy workspace

1. From the Pricing Strategies List, select the maintain margin strategy you want to
maintain.

2. Click Edit, or double-click the strategy selected. A second Strategy Maintenance pane
opens and the fields that can be changed are enabled.
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I(—_" Strategy Maintenance |

=
= =
= =
= =
=
Price Guide l:l = Suszpend D
= =
= =
Auto Approve D * cost Change Forward Days |2
* Method (7} Market Basket Margin Increase (") Margin %
@' Current Margin .é. Zhange by Cost Change Armount
Decease -é- Margin %

'?' Change by Cost Change Armount

¥ Reference Competitors

Cornpetitor Cornpetitor Store Cormpete Type Percent
N —
s [ B
S
o[ B
S —=

Maintain Margin Strategy Maintenance pane.

3. Make necessary changes.

il [ (D D D
= =2 = =2
gl eyl

[« [« Ld L4 L

Match

Edit a Price Guide

=  Enter the price guide name or click the LOV & button and select the appropriate
price guide.

Change Calendars

Note: In order to specify a new calendar, the existing
calendar must be suspended.

1. Select the Suspend checkbox.

2. Enter a calendar name, or click the LOV El button and select a calendar

Edit Maintain Margin Details
1. Select the Auto Approve check box to indicate price changes should be created in
Approved status.

2. Inthe Cost Change Forward Days, enter the number of days into the next review
period that the strategy will consider cost changes when proposing price changes.

Note: Cost Change Forward Days should not exceed the
length of a review period.
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3. Select the method for the strategy:

= Market Basket Margin: Select to have the margin for the item's market basket
applied to the item's new cost. The Margin Strategy Details area appears.

Auto Approve |:| * Cost Change Forward Days |2 |

* Method (@) |Market Basket Margin

| ! Current Margin

N " T
Margin Strategy Details " @;
Code Margin Target Acceptable Range From Acceptable Range To |

Margin strategy details
= Current Margin: Select to have the current margin applied to the item's new cost.

Edit Market Basket Margin

1. Inthe Code drop-down, select the margin market basket code you want to use to set
the price.

2. Inthe Margin Target field, enter the percent of margin you want to earn on the
item/zone.

3. Setup the acceptable range:

Note: Acceptable range is the amount by percentage that a
margin can vary from the target before a price change is
proposed.

a. Inthe Acceptable Range From field, enter the bottom of the range.
b. Inthe Acceptable Range To field, enter the top of the range.

Click Apply. An entry is added to the Maintain Strategy Details table.
Define reference competitors as necessary.

Click Done to save any changes and close the workspace.
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Edit Current Margin
1. Select how the strategy will apply an increase in margin to a proposed retail:

= Margin %: Select to have the percent of the cost change added to the basis retail
to determine the proposed retail.

= Change by Cost Change Amount: Select to have the amount of the cost change
added to the basis retail.

2. Select how the strategy will apply a decrease in margin to a proposed retail:

* Margin %: Select to have the percent of the cost change subtracted from the basis
retail to determine the proposed retail.

= Change by Cost Change Amount: Select to have the amount of the cost change
subtracted from the basis retail.

3. Click Done to save any changes and close the workspace.

Edit Reference Competitors

*  Define reference competitors as necessary.

Complete the Margin Price Strategy
1. Click Save + Repeat to commit your changes.

2. Click Done to save any changes and close the workspace.

Delete a Pricing Strategy

Navigate: From Task Pad, select Price Strategy > Maintain Price Strategy. The Maintain
Pricing Strategy workspace opens.

B9 Maintain Pricing Strategy

I/(J Strategy Maintenance |
Pricing Strategies List Il
Department Class | Subclass ‘ AT oD | Erm ‘ Location | T ‘ Price Guide | Calendar | Calendar Status |
Fitter by: [ || Fiker by > [rer sy =] [Fier by 7]l Fitter oy x| [Fter sy [ Fier y. > [Fer sy [*]|[ Fitrer by ||| Fiter by >

z1 a
5000: ALL Fc: .| 101: ALL Class 101: ALL Subcl... | Ranjit 001 Ranjit Test Group | Baltimare Clearance Mone
1234: Glassuare 26-TCODD4 21 Clearance Mane
1704: *Candida... 2G-farDay 21-UsD Clearance SH-1 Assignad
1704 *Candida,. 26-0009 a1 Clearance Caily Galendar | Assigned
17041 *Candida... 2G-2WH Z-WH Clearance Daily Calendar | Assigned
1221: Kitchenw... | 1000: Utensils | 1000: Gadgets | Rick's Teams Polars Buffals Campetitive Daily Calendsr | Assigned
1221 Kitchenw... 1221 Warshouses| Warzhouses Campatitive Corin 10/21 Suspended
12211 Kitchenw., | 1000; Utensils | 1000; Gadgets | 1221 Warehouses| Warehouses Competitive Starts 10/23, Enw| Assigned
12211 Kitchenw... | 10001 Utensils | 1000: Gadgets | Mpls and Fargo | Mpls and Fargo Campetitive Daily Calendar | Assigned
39; 516 Maat Ranjit 001 Ranjit Test Group | Baktimore Margin Daily Calendar | Assigned
111: *TestDep HL-CAD HL_CAD Margin Hane
7778 Cost Dept name HL_CAD Margin Mane
2345: Small Ap. DW USD D USD: Margin MNane 1
2345: Small Ap.. Ranjit 001 Ranjit Test Group | Edina Margin MNene
T777: Retail Dept MERGH EXTRAw, | My Zonef Z Locs Margin Hane
77771 Retail Dept Ranjit 001 Ranjit Test Group Margin Hane
TT7T: Retail Dept Ranjit 001 ranjit tast 2 Margin MNane
TTTT: Retail Dept Ranjit 001 New Zane Margin Mane =
| |

cancel _|[_save +Repeat |[_oone |

Maintain Pricing Strategy Workspace

1. From the Price List, select the price strategy you want to delete.
2. Click Delete. You are prompted to confirm your decision.

3. Click Yes.
4

Click Done to close the window.
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Worksheet

Worksheets

RPM uses strategies, calendars, and item/location information to automatically generate
worksheets. The Worksheet functionality allows you to maintain the proposed price
changes automatically generated by RPM.

The worksheet may contain many different columns.

Worksheet Column Definitions and Calculations

Use these procedures to manipulate the worksheet:

Change the Value in a Cell
Maintain Columns
Maintain Views

Apply Filters

Worksheet Status

From the Worksheet Status workspace you can:

Worksheet Detail

Maintain a Pricing Worksheet

Submit a Pricing Worksheet for Approval
Approve a Pricing Worksheet

Reject a Pricing Worksheet

Reset the Status of a Pricing Worksheet
Delete a Pricing Worksheet

The Worksheet Detail workspace allows you to:

Review the auto generated price change proposals.

Review items that met rules or were exceptions.

Make clearance decisions.

Delete the Pricing Worksheet if no price changes need to be made.

Examine the information about price change proposals and make decisions about
which items to change and what retail prices to set.

Modify column values.

Perform what-if analysis on the Worksheet to help you make the best pricing
decisions.

Export the worksheet to a Comma Separated Value (csv) file that can be opened in
other applications such as spreadsheets and work processors.

Maintain Worksheet Details

Edit the Proposed Retail

Take or Don't Take Proposed Price Changes
View Totals
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= Perform a What-if Analysis
=  Export a Worksheet

Worksheet Columns

The worksheet may contain many different columns. See the descriptions and
calculations for each column below.

Column

Description

Editable Calculation

% off Regular
Retail

% off Basis
Retail

Base Cost

Basis Cost

Class ID

Class
Description

The percent difference
between the basis regular
retail and the new retail of
the item.

The percent difference
between the basis retail
(regular or clearance) and
the new retail of the item.

This value is the same as %
off Regular Retail if there
is no clearance retail.

The base cost of the item
on the effective date
(including price change
processing days).

The pricing cost of the
item on the effective date
(including price change
processing days).

The class hierarchy ID of
the item's class.

The name of the class.
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No

No

No

No

No

No

Price Change Amount divided by Basis
Regular Retail (Before VAT)

Depending on your aggregation level
settings:

Price Change Amount = Current Retail -
New Retail

Price Change Amount = New Retail -
Current Retail

The zone level regular retail is used if it
exists.

Price Change Amount divided by Basis
Retail (Before VAT)

Price Change Amount equals the
difference between the New Retail and
the Clearance or Regular Retail

Depending on your aggregation level
settings:

Price Change Amount = Current Retail -
New Retail

Price Change Amount = New Retail -
Current Retail

The zone level clearance retail is used if
it exists.

When the record is at a zone level, the
zone level base cost is used in the
calculation if one exists.

When the record is at a zone level, the
zone level basis cost is used in the
calculation if one exists.



Worksheets

Column Description Editable Calculation

Clearance Checked and disabled if Yes

Indicator the item is on active
clearance. Unchecked if
the item is not on
clearance.

Clearance Hyperlink that opens a No
window with details on
approved clearances.

"Pending" appears if the
item is on a pending
clearance.

Competitor A "Pass" appears if thereisa No

Alert competitor A and the
strategy rules is met. "Fail"
appears if the strategy rule
is not met.

Competitor A Competitor A's retail price. No

Retail

Competitor B "Pass" appears if thereisa No

Alert competitor B and the
strategy rules is met. "Fail"
appears if the strategy rule
is not met.

Competitor B Competitor B's retail price. No

Retail

Competitor C  "Pass" appears if thereisa No

Alert competitor C and the
strategy rules is met. "Fail"
appears if the strategy rule
is not met.

Competitor C  Competitor C's retail price. No

Retail

Competitor D "Pass" appears if thereisa No

Alert competitor D and the
strategy rules is met. "Fail"
appears if the strategy rule
is not met.

Competitor D Competitor D's retail price. No

Retail

Competitor E  "Pass" appears if thereisa No

Alert competitor E and the
strategy rules is met. "Fail"
appears if the strategy rule
is not met.

Competitor E =~ Competitor E's retail price. No

Retail
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Column Description Editable Calculation
Conflict An exclamation point No When conflict checking is run again or
appears if conflicts were the price change is taken or not taken,
found during conflict the column is reset.
checking.
Cost Changes "Yes" appears if there are ~ No
During approved cost changes
Review Period that have an effective date
during the review period
of the worksheet.
Current The clearance retail for No The zone level clearance retail appears if
Clearance today if the item is on it exits.
Retail clearance.
Current The unit of measure for the No
Clearance item clearance price.
Retail UOM
Basis Retail The active retail (regular No The zone level basis retail appears if it
or clearance) on the exists.
effective date before the
current price change.
Basis Retail The unit of measure for the No
UOM item basis retail.
Basis Retail The active multi-unit retail No The zone level multi-unit retail appears
Multi-units on the effective date before if it exists.
the current price change.
Basis Multi- The active multi-unit retail No
unit Retail on the effective date before
the current price change.
Basis Multi- The unit of measure for the No
unit Retail active multi-unit retail on
UOM the effective date before
the current price change.
Current Cost The pricing cost today. No
Current Cost ~ The cost markup of the No Current Retail (regular or clearance,
Markup %. item based on current cost before VAT) minus Current Cost
and current retail. divided by Current Cost.
The zone level current cost is used if it
exists.
Current Retail ~ The retail markup of the No Current Retail (regular or clearance,
Markup % item based on current cost before VAT) minus Current cost divided
and current retail. by Current Retail.
The zone level current cost is used if it
exists.
Current Multi- The unit value of the No The primary zone current multi-units
Units multi-unit retail price. will appear if it exists.

For example: "2 ea." if
there is a 2 for $5 multi-
unit retail.
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Column Description Editable Calculation
Current Multi- The retail value of the No
units Retail multi-unit retail price.
For example: "$5.00" if
there is a 2 for $5 multi-
unit retail.
Current Multi- The unit of measure for the No
units UOM item multi-unit.
Current The item's regular retail No The zone level current retail appears if it
Regular Retail value today. exists.
Current Retail The selling unit of measure No
UOM for the current retail.
Current The regular retail value No Current Retail divided by Package UOM
Retail/UOM  per unit of measure in the
package today.
For example: ".05/0z" if
there is a 16 oz. can of
soup that retails for .89.
Diff One The differentiator 1 value = No
for a transaction level item.
Diff Two The differentiator 2 value  No
for a transaction level item.
Diff Three The differentiator 3 value = No
for a transaction level item.
Diff Four The differentiator 4 value = No
for a transaction level item.
Effective Date  The date that price change Yes End of Review Period plus Price Change
goes into effect. Processing Days
New Item An indicator appears if the No
Location Ind  item/location is a new
combination in RPM.
First Received The date this item was first No
Date received into the location.
Historical The monetary historical No The weekly, monthly, half-yearly, or
Sales sales of the item based on yearly historical sales depending on
the locations in the row. aggregation level setting.
Historical The retail sales of the item No The weekly, monthly, half-yearly, or
Sales Units for the current period. yearly historical sales depending on
aggregation level setting.
Item The name of the item. No
Description
Item ID The transaction or parent  No

item ID.
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Column Description Editable Calculation
Last Cost The date of the last cost No
Change change.
Note: Place the cursor over
this field to show the
average or highest cost of
the item over the locations
in the zone
Last Price The date of last price No
Change change.
Note: Place the cursor over
this field to show the items
zone price.
Last Received The date the item was No
Date last received into the
location.
Link Code The link code assigned to  No
the transaction level item.
A hyperlink opens a link
code information window.
Proposed The markdown number if No
Retail there is a proposed
Markdown #.  clearance price change.
Margin The market basket code for No
Market Basket transaction level items if
Code one exists.
Cost Markup  The cost markup of the No New Retail minus Basis Cost divided by
%. On New item based on new cost Basis Cost
Retail and new retail. The zone level basis cost is used if it
exists.
New Multi- The unit value of the new Yes
Units multi-unit retail price.
For example: "2 ea." if
there is a 2 for $5 multi-
unit retail.
New Multi- The retail value of the Yes
units Retail new multi-unit retail price.
For example: "$5.00" if
there is a 2 for $5 multi-
unit retail.
New Multi- The unit of measure of the Yes
units UOM new item multi-unit.
For example: ea. if there is
a 2 for $5 multi-unit retail.
New Retail The new proposed retail Yes

value for the effective date.

Edit this field to override
the proposed price.
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Column Description Editable Calculation
New The new retail value per No New Retail divided by the Unit Of
Retail/UOM  unit of measure. Measure.
For example: ".05/0z" if
there is a 16 oz. can of
soup that retails for .89
New Retail The percent retail sales No New Retail minus New Cost divided by
Markup %. margin of the item based New Retail (Before VAT)
on the new retail. The zone level basis cost if used if it
exists.
New Retail The unit of measure for the Yes
UOM item's new retail.
If you enter a new retail,
New Retail UOM is
required.
Original Retail The original retail of the No
item.
Out of Stock  The out of stock day for Yes Default Out of Stock Days after the
Date clearance price changes. effective date
You can change this field.
Package Size ~ The package size of the No
item.
Package UOM  The package unit of No
measure of the item.
Parent ID The parent item ID if the ~ No
worksheet is at transaction
item level and the item has
a parent.
Parent Item The name of the parent No
Description item.
Pending Cost ~ The date of the earliest No
Changes pending cost change for
the item for the primary
supplier.
A hyperlink opens a link
to a window with more
information.
Price Change  The monetary value of the No New Retail minus Basis Retail at the
Amount price change for one unit location

of that item.

Depending on your aggregation level
settings:

Price Change Amount = Basis Retalil -
New Retail

Price Change Amount = New Retail -
Current Basis

The zone level basis retail is used if it
exists.
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Column Description Editable Calculation

Price Change  Select "Take" to accept the  Yes

Indicator proposed price change for
the transaction level item
and lock the row for
editing.

Select "Don't Take" to
reject the proposed price
change and lock the row
for editing.

Price Changes A hyperlink "NONE"if no No
price changes exist during
review period.

A hyperlink "Pending" if
price changes exist during
review period. Click the
hyperlink to view pending
price change records.
Note: During the review
period means between
todays date and the end of
the review period.

Primary "Pass" appears if thereisa No

Competitor primary competitor and

Alert the strategy rules is met.

"Fail" appears if the
strategy rule is not met.

Primary "Yes" when a new or No

Competitor updated competitor retail

Retail is brought into RPM.

Changed Ind  Npote: If more than one
strategy uses the same
competitor, "Yes" will only
appear in the worksheet
for the first strategy to find
it.

Primary The primary competitors ~ No

Competitor retail.

Retail

Primary The items selling unit of No

Competitor measure for the primary

Retail UOM. competitor.

Primary The unit value of the No

Competitor multi-unit retail price on

Multi-Units

the most recent shop date.

For example: "2" if there is
a 2 for $5 multi-unit retail

114 Oracle Retail Price Management



Worksheets

Column Description Editable Calculation
Primary The primary competitors ~ No

Competitor multi-unit retail with the

Multi-Unit number of units on the

Retail most recent shop date.

For example: 2 for $5

Primary The items unit of measure No
Competitor for the multi-unit price on
Multi-units the most recent shop date.
UOM.

Primary The primary supplier ID No
Supplier for the item.

Note: Place the cursor over
this field to view the
supplier name.

Promotions Hyperlink that opens a No
window with details on
approved current or
pending (after the effective
date of the current price
change) promotions.

Proposed Cost The cost markup of the No Proposed Retail minus Basis Cost
Markup %. item based on proposed divided by Basis Cost.
retail and basis cost. The zone level basis cost is used if it
exists.
Proposed The retail on the proposed No Proposed Effective Date plus Price Prior
Retail effective date. Create Days
Proposed The proposed retail per No Proposed Retail divided by Package
Retail/ UOM unit of measure in the UOM
package.
For example: ".05/0z" if
there is a 16 oz. can of
soup that retails for .89
Proposed The unit of measure for the No
Retail UOM item's proposed retail.
Proposed The retail sales margin of  No Proposed Retail minus Basis Cost
Retail Markup the item based on the new divided by Proposed Retail (Before
% retail. VAT)
The zone level basis cost if used if it
exists.
For zone level records, if a zone level
basis cost exists, use that value in the
calculation
Replenishment "Yes" if the item is on an No
Indicator active replenishment
record.
Reset Date The reset date for the item. Yes Defaults to Out of Stock Date plus one
Enter a date to change the day
default.
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Column

Description Editable

Calculation

Retail Label
Type

Retail Label
Value

Price Zone
Group ID

Price Zone ID

Rule

Projected Sales
Units

Sales Change
Amount

Seasonal Sell
Thru %

Season/Phase

The retail label type of the No
item.

The retail label value of the No
item.

The price zone group ID No
for a zone level item.

Note: Place the cursor over
this field to view the price
zone group description.

The price zone ID for a No
zone level item.

Note: The price zone
description is available as
a mouse over.

Binocular icon appears if ~ No
the item meets rules.

Click the icon to open a
window and view details
of the rules met by the
record.

The smoothed average No
regular price sales based

on the number of weeks of
sales that have occurred.

The difference between the No
items new retail and the

basis retail on the effective

date multiplied by the
projected sales for a week.

The sell through percent No
for the current season.

Total sales for the stores in

the zone or location

divided by stock on hand

for the zone/location.

Hyperlink opens No
Season/Phase detail
window.
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Total Sales divided by Total Weeks of
Sales

Depending on your aggregation level
settings:

Sales Change Amount = Basis Retail -
New Retail

Sales Change Amount = New Retail -
Current Basis

On Worksheet Status the sum of all
individual records. On Worksheet Detail
per item.

Total Sales For the Season divided by
Stock On Hand

Depending on your aggregation level
settings Warehouse Stock On Hand will
be included or excluded.
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Column

Description Editable

Calculation

Sell Thru %

State

Store On Hand

Store On
Order

Store total
inventory

Subclass ID

UDA

VPN

Weeks of Sales
Exposure

Weeks Since
First Sale

Total
Inventory

WH Stock On
Hand

Warehouse On
Order

WH total
Inventory

The sell through percent No
for store locations in the
zone.

The status of the details of No
the record.

The current stock on hand No
at store locations.

The total on order qty for  No
all stores in the price zone.

Note: On order is in the
single unit size of the item,
not case size.

Total inventory for all No
stores in the zone.

The subclass hierarchy ID  No
of the item's subclass.

Note: Place the cursor over
the field to view the
subclass description.

Hyperlink opens UDA No
information for the item if
it exists.

The VPN for the primary ~ No
supplier of the item.

The number of weeks the  No
item has had sales

exposure (on had at

location).

The number of weeks No
since the items first sale.

Total inventory for the No
item/location.

The current stock on hand No
at warehouse locations in.

Total on order qty forall ~ No
stores in the price zone.

Note: On order is in the
single unit size of the item,
not case size.

The total inventory for all  No
stores in the zone.

Sales divided by (Stock On Hand plus
Sales)

Depending on your aggregation level
settings Warehouse Stock On Hand will
be included or excluded.

The type of sales and the amount of time
to be considered is determined by the
Sales Calculation Method.

Store On Hand plus Store On Order plus
Store In_Transit + Store OBNP_INV

Total Warehouse Inventory plus Total
Store Inventory

Warehouse On Hand plus Warehouse
On Order plus Warehouse In Transit
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Change the Value in a Cell

Change the Value in a Cell
1. Double click the cell.

2. Enter a value, change a value, or select from a drop-down list.

Change the Values of Multiple cells

1. Press and hold the Ctrl key while selecting cells or column headings to select
multiple cells or columns.

2. Right click on the selected cells or columns. A window appears that allows you to
edit the value for all selected cells.

Price Change Indicator f'5_<|

cdited Value [ saiez - [

| Apply || Cancel |

Example Edit Value window
3. Enter a value, change a value, or select from a drop-down list.
4. Click OK. The values for all selected cells change.

Maintain Columns

You can edit the worksheet to display only the columns you are concerned with, change
the order the columns display, and change the number of rows that appear.

Hide and Position Columns

1. Inthe Worksheet Details pane, click the E button.

2. Select Column Display and Ordering... from the drop-down menu. The Column
Display and Ordering window opens.

Column Display and Ordering

Hide these columns: Show these columns:

Mew Retail lE
Iterm I

%% off Regular Retail

%% off Basiz Retail
Baze Cost

/D]

Baszis Cost
Class Id

1 I

| Cancel || 0K |

Column display and ordering window
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3. To hide columns:

a.

b.

C.

Select a column to hide in the Show these columns pane.

Click the || button. The column name appears in the Hide these columns pane.
Repeat the steps above to hide additional columns.

— To hide individual columns, right-click on the column heading in the
Worksheet Details pane and select Hide Column from the drop-down menu.

4. To position columns:

a.

b.

Select a column to re-position in the Show these columns pane.

Click the [ | and [ ™| buttons as necessary to move the columns. This
determines the position of the columns from left to right.

Repeat the steps above to re-position additional columns.

— Toreposition individual columns, click on the column heading in the
Worksheet Details pane and drag it to the desired position.

5. Click OK. The worksheet columns are repositioned to reflect your changes.

Sort the Worksheet

In the Worksheet Details pane, click the E button.

2. Select Sort Table... from the drop-down menu. The Column Display and Ordering
window opens.

3. Set the sort order of the worksheet:

a.

b
c.
d

g.

Select a column from the Columns pane.

Click the [_* | button. The column name appears in the Priority Column pane.
Repeat the steps above to move additional columns.

Select a column in the Priority Column pane.

Click the [ | and [ ™| buttons as necessary to move the columns. This
determines the order by which the worksheet information is sorted.

Clear the Ascending column to have the column sort date in a descending
manner.

Repeat the steps above as necessary.

4. Click OK. The worksheet columns are sorted to reflect your changes.

To sort based on individual columns, right-click on the column heading in the
Worksheet Details pane and select either Make Primary Sort, Ascending or Make
Primary Sort, Descending from the drop-down menu.
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Adjust the Size of the Worksheet Content

In the Worksheet Details pane, click the E button.
2. Move the cursor over Size Content.

Select from the drop-down menu:

= Smallest

= Smaller

= Standard
= Larger

= Largest

= FitAll

4. The size of the content on the worksheet is adjusted.

Adjust Column Sizes

In the Worksheet Details pane, click the E button.
Move the cursor over Column Resizing in the drop-down menu.
Select from the drop-down menu:
*  Adjust Next Column Only
= Adjust Subsequent Columns
= Adjust Last Column Only
=  Adjust All Columns
4. The worksheet columns are adjusted.

= Toresize individual columns, position the cursor on the right-hand border of the
column heading. The cursor will change to a double arrow. Click and drag right
or left to resize the column.

Set Non-Scrolling Columns

You can set up to seven columns to be locked or non-scrolling. This allows comparison of
values in the locked columns to all other columns in the worksheet.

1. Inthe Worksheet Details pane, click the E button.

2. Select Column Locking from the drop-down menu. The Column Locking dialog
opens.

Column Locking P§|

Mumber of colurnns to be locked (0 to 7) IZI

| Cancel || OK |

Column locking dialog
3. Enter the number of columns to lock.

4. Click OK. The columns are locked (non-scrolling).
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Maintain Views

Add a View
1. Click Maintain View. The Maintain View dialog opens.
I,
Default Description Corporate |
Corp | —
Fabarl |
Faberz O
Faberd | L
fabers O
ITEM-ZOME | —]
pci firzt 1 d
Maintain View dialog
2. Click Add. A new line appears in the list.
3. Enter a name for the view in the Description field.
4. Select the Default View checkbox if you would like the view you created to be the
default view.
5. Click Save. The view is saved and is accessible from the drop-down at the top of the
Worksheet Details pane.
Delete a View
Select the view you want to delete from the list.
2. Click Delete. The view is removed from the list.
Select a View

Select a saved view from the drop-down menu.
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Apply Filters

Since worksheets may contain many detail records, RPM gives you the ability to filter
those records so you see only the details that need attention. You can perform an ad hoc
filter on any column in the Worksheet Detail or you can create and save an advanced
filter that you can continue to use in the future.

Apply an ad hoc Filter

= In the Worksheet Details pane, select a value from the Filter by: drop-down above
the column you wish to filter the worksheet by. The worksheet refreshes, with the
filter applied.

Clear an ad hoc Filter

= In the Worksheet Details pane, select Clear Filter from the Filter by: drop-down
above the column that the filter was applied to. The filter is cleared and the
worksheet returns to its previous state.

Note: Any other filters applied will still be applied to the
worksheet.

Clear all Filters

= In the Worksheet Details pane, select Revert to Default from the Filter by: drop-down
above any column. The filters are cleared and the worksheet returns to its original
state.

Apply an Advanced Filter

Note: Advanced filters override any ad hoc filters previously
applied to the worksheet.

1. Inthe Worksheet Details pane, select Advanced Filter from the Filter by: drop-down
above the column you wish to filter the worksheet by. The Advanced Filter dialog
opens.

Advanced Filter F§|

Show rows where

Mew Retail |i5 equal to

5l
I =l
' M

|(m:|ne)

| Cancel H OK J

Advanced filter dialog
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2 T

Select a condition to apply to the column from the top drop-down in the dialog.
Enter or select a value for the filter to look for in the next drop-down.

You may enter an additional condition and value in the remaining drop-downs.
Select a logical operator (And or Or) in the area between the drop-downs.

Click OK to apply the filter to the worksheet. The worksheet refreshes, with the filter
applied.

Maintain Worksheet Detall Filters

* In the Worksheet Details pane, click the Filter L2 button. The Worksheet Detail Filter

window opens.

Worksheet Detail Filter 3

Filter [ select- [¥] [ SaueFiteras .. |[ Delate Filter |[ apply Filker |
Column | condition [ vatue ‘
Remove All
Filter an a Columan or 3 Yalue (O Golumn
@ value
Column [~ select - E‘ Condition |- salect - E Value “ Add Criteria

Worksheet detail filter window

Note: Click the clear filter button to remove the filter
criteria.

Create a Worksheet Detail Filter
1.

Select Column to have the filter compare the values in two columns.
Or
Select Value to have the filter match a value in a column.

Select a column to filter by from the Column drop-down.
Select a condition to apply to the filter from the Condition drop-down.

Select a column to compare to the previous column in the Column drop-down if you
chose to filter by column above.

Or

Select of Enter a value for the filter to look for in the next field if you chose to filter by
value above.

Click Add Criteria. The criteria is added to the Worksheet Detail Filter table.
Repeat the steps above to continue adding criteria. Continue to the next step.
Click Save As to save the filter.

= Enter a name for the filter in the Save Filter dialog.
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Apply a Worksheet Detail Filter
1. Select a filter from the Filter drop-down.
2. Select criteria from the Worksheet Detail Filter table. You can select multiple criteria.

3. Click Apply Filter. The Worksheet Detail Filter window is closed and the filter is
applied.

Delete Worksheet Detail Filter Criteria
1. Select a filter from the Filter drop-down .
2. Select criteria from the Worksheet Detail Filter table.

3. Click Remove Criteria. The criteria is removed from the filter. Click Remove All, to
remove all criteria from the filter.

Delete a Worksheet Detail Filter
1. Select a filter from the Filter drop-down.
2. Click Delete Filter. The filter is removed from the Filter drop-down.

View Conflict Check Results

The Conflict Check Results workspace allows you to review the results of background
conflict checking for worksheets, price changes, promotions, and clearances. If the
background conflict checking system option is selected, conflict reviews occur in the
background, or when the system is not busy performing other tasks. An alert appears in
the Conflict column of the worksheet, price change, promotion, or clearance maintenance
pane when conflict checking is complete. At that time, follow the procedures below to
view the results of background conflict checking.

When background conflict checking is off the system performs conflict checks
immediately when Conflict Check is clicked from the Price Change, Promotions, or
Clearances workspaces.
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View Conflict Check Results

Navigation: From Task Pad, select Conflict Check Results > View Conflict Check Results.
The Conflict Check Results workspace opens.

%9 cConflict Check Results
@ |
I,
Event Type | ID Promotion Co Promotion Col Department | Class Subclass Zone Result Result Date
| Filker bylzl | Filter bylzl |F.".*ter bylzl | Filker bylzl | Filter bylzl |F."!ter bylzl | Filker bylzl | Fitker bylzl |F.".*ter bylzl |F."!ter bylzl
Worksheet 1 00 Mo Conflict,,, | 03/01/2005
4 4

Conflict Check Results workspace.
= Select the conflict results you want to view.

Delete Conflict Check Results
1. Select the conflict results to delete.
2. Click Delete.
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Worksheet Status

Maintain a Pricing Worksheet

Navigate: From the Task Pad, select Worksheet > Worksheet Status. The Worksheet
Status workspace opens.

%5 worksheet Status

I@ Worksheet Status

s | ®
Adion |- selact - 4|
&,
Merchandise Leval | Marchandise ID Location Level| Location ID Location Status | Conflict| Last Review Date | Reas
Filker by : :I Fitker by: :l Filter by: :l Filker by : :I Fitker by: :l Fitke :l Filker by: :l
Cepartment 2064 Zone

02-01-200%5
Crepartrnent 0z-02-2005

4]

»
Select All || Unseladt All || Wwarkzhesat Datail |
Total Price Change Arnount 0,00
Total Price Change $0H o
Total Price Change Items =
Total Sales Amount $0.00

Worksheet Status workspace

1. Select the worksheet you want to maintain.

Note: You can select multiple worksheets as long as they are
for the same department and currency.

2. Click Worksheet Detail to maintain the details of the worksheet.
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Submit a Pricing Worksheet for Approval

The Pricing Worksheet status must be In Progress to enable the Submit action. To change
the status of the Pricing Worksheet from New or Updated to In Progress, you need to
have at least one row or item selected for price change.

1.

2
3.
4

Select the worksheet that you want to submit.
Review the information in the Worksheet Status window to ensure that it is correct.
From the Action drop-down list, select Submit.

Click Apply. The status is changed to Submitted and the Pricing Worksheet is ready
for approval.

Note: Before the status changes to Submitted, RPM checks
the Pricing Worksheet to ensure that there are no conflicts.
The status options that are available from the Action drop-
down list change based on current status of the worksheet's
details.

Approve a Pricing Worksheet

Note: The Pricing Worksheet status must be in either
Submitted or Delete Pending status before you can select the
approve action.

Select the worksheet that you want to approve.

When you are ready to approve the submitted or delete pending Pricing Worksheet,
select Approve.

Click Apply. The Pricing Worksheet information is saved and applied.

Note: For worksheets in Submitted status, before the status
changes to Approved, RPM checks the Pricing Worksheet to
ensure that there are no conflicts. Delete pending status
worksheets are not conflict checked before being moved to
Deleted status.

When the system option, Dynamic Area Differentials is off,
secondary area worksheets are enabled when the primary
area is approved. When the system option is on, changes to
secondary areas happen dynamically after changes to the
primary area.
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Reject a Pricing Worksheet

You can reject a Pricing Worksheet that has a status of Submitted or Delete Pending.
When you reject a submitted or delete pending Pricing Worksheet, its status changes to
Rejected or Delete Rejected.

Note: If you want to work with the Pricing Worksheet when
its status is Rejected, Reset the status of the Pricing
Worksheet (see the procedure below).

1. Select the worksheet that you want to reject.

2. You can enter a Reason for the rejection in the Reason field. Click the £ button to
open an editing window where you can enter a reason up to 250 characters long.

From the Action drop-down list, select Reject.

Click Apply. The status of the Pricing Worksheet changes to Rejected or Delete
Rejected.

Reset the Status of a Pricing Worksheet
Use the Reset action to return the worksheet to its previous status.
1. Select the worksheet that you need to reset the status of.
2. From the Action drop-down list, select Reset.

3. Click Apply. The Worksheet Status window refreshes and the worksheet is returned
to its previous status.

Delete a Pricing Worksheet
1. Select the worksheet that you want to delete.
2. From the Action drop-down list, select Delete.

3. Click Apply. The Pricing Worksheet is moved to Delete Pending status and is ready
to have your deletion approved or rejected.

Note: The options that are available from the Action drop-
down list change based on worksheet's current status.

128 Oracle Retail Price Management



Worksheets

Worksheet Detail

Maintain Worksheet Details

Navigate: From the Task Pad, select Worksheet > Worksheet Status. The Worksheet

Status workspace opens.

%9 worksheet Status

I@ Worksheet Status |
Reason | |@ Apply
Adion [ selact - =l
I,
Merchandise Level | Merchandise ID Location Level| Location ID Location Status | Conflict| Last Review Date | Reas
Fifter by W Firter by Fitter by ||| Fitter by ||| Fitter bpo ||| Ay T | At ||| Fitter by || ity
Cepartment 03-01-2003
Cepartment 2 Zone g Zil Hew 03-02-2003
4] »
Selact All || Unzelect All || Wworksheet Detail
Total Price Change Amount | £n0n
Total Price Change SOH o
Total Price Change Itermns 5
Total Sales Armount £0.00

Worksheet status workspace

1. Select the worksheet you want to view the details of. You can select multiple
worksheets or click Select All to select of all the worksheets.

2. Click Worksheet Detail. The Worksheet Detail workspace opens.
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%5 worksheet Details
@ Worksheet Details |
Itern Level 'Tran Level lEI
cotin Save View . . . D E
| o | i - =]
I
Item ID Item Description | Historical Salg Historical Sald Seasonal Sell | Sell Thru % | Rule Season/Phasd Store On H
Filker by W\ Filker by || Fitker by :l Filker by :l Fitker by | T\ Filker by | ||| Fitber by | ||| Fitker by | ||| Fitber by
1901 RDP CMLTE 0,00 o i 5]
1910 RDP Item for RPM 0.00 0 i 5]
1911 RDP item for RPM 0.00 0 i 5]
1360 RPD RPM itzm 0.00 o i 5]
1961 RDP RPM itzm 2 0.00 o i 5]
1952 RDP RPM Item 3 0.00 o 5
1370 RDF RPM Item 0.00 o i 5]
[« l »
| Unzelad All || Selack All || Reset Data || What If || Suggest Date ||
| Cancel Il Save Il Cone I

Worksheet detail workspace
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Merchandise Extract Iltem Deletions

Navigate: From the Task Pad, select Worksheet > Merchandise Extract Item Deletions.
The Worksheet Extract Item Deletions workspace opens.

%3 merchandise Extract Item Deletions

@ |
I
Pricing Strategy terchandise Id terchandise Level Zone Zone Group Date Item Count
Fifter by: EI | Fifrer by : Izl | Fiftey by : lz‘ |F.I'J‘ter by.‘lzl |kaer by IEI ‘ Fiftar by : lz‘ |F.l'i‘ter by IEI
2893 63 Department 746 T4E 1zf18/z2002 422
2853 36 Clazz 746 748 1zf18/z2002 1
2835 63 Department 745 T43 1zf1afz002 44
2861 B3 Department =1} T33 1zf18fz002 2
2831 40 Clazz T46 T43 1zf1afz002 B2
2B3Z &0 Cepartment T46 T4 1zf1afzo002 134
2883 T2 Cepartment ==} Ta3 1zf1afzo002 2
3082 319 Subclass 745 T4 1zf1afzo002 1
2083 69 Cepartment T4a 743 1zf1a/z2002 4
3288 T Cepartment T45 742 1zf1a/z002 T
23344 7o Cepartment == T53 1zf1a/z2002 2
23365 T Cepartment 459 455 1zf1a/z002 =]
2562 62 Cepartment == T52 1zf1g/2002 24
2702 40 Class T4 T4z 1zf1g/2002 124
2827 &0 Cepartment = T52 1zf1g/2002 S|
aeol =m0 Cianavtroant A 4 12018000 o
|
@ |
I
Item Location Reason Candidate Rule Name
Filker by: E | Filtey by lzl |F.l'i‘ter by lzl | Filtey by lzl

Merchandise Extract Item Deletions

1. Double-click on the row on the summary table that you would like to see more detail.
The detail table is populated with the items and information that were excluded from

the resulting worksheet for the particular run of the merchandise extract.

2. Filter the detail results by selecting the appropriate drop-down menus.

Column Definition

Area Differential Exclusion Item/location combinations that have been

excluded from a Secondary Area Differential.

Invalid Maintain Margin Cost The strategy is maintain margin and the
item/location does not have a cost change in

the cost review period.
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Column

Definition

Invalid Secondary Item

Missing Link Item

New Item Location

No Cost
No Retail

Candidate Rule Exclusion

Variable Link Code

Variable Link MBC

Variable Link Selling UOM

Variable Link Vat Indicator

132 Oracle Retail Price Management

Item/locations that meet one of the below:

Does not belong to any link code whereas
the same item belongs to a link code in the
primary area.

Does not exist in the primary area AND
does not belong to any link code in the
secondary area.

Belongs to a link code that does not exist in
the primary area.

When one or more item from a item-link
code/zone group is missing the entire group is
excluded.

Item/locations that meet one of the below:

If any one item from a Link code is present
in the worksheet, all items in the same
Link code must also be present in the
worksheet.

Items sharing the same Link code should
have the same Basis UOM.

Items sharing the same Link code should
all have the same Class Vat Indicator
settings.

For Margin and Maintain Margin
Strategies, items sharing the same Link
code should have the same Margin Market
Basket code.

For Competitive Margin Strategies, items
sharing the same Link code should have
the same Competitive Market Basket code.

Item/locations that are not present in at the
start of a review period cannot be added in the
middle of a review period.

No cost could be found for the item/location.
No retail could be found for the item/location.

The item/location meets a exclusion candidate
rule.

The item does not have the same Link Code at
all locations in the zone.

The items sharing a market basket code do not
have the same Link Code at all locations in the
zone.

The items sharing a link code do not have the
same Basis UOM at all locations in the zone.

The items sharing a link code do not have the
same vat indicator at all locations in the zone.
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Column

Definition

Variable Zone Selling UOM

The item does not have the same Basis UOM at
all locations in the zone. The strategy is
maintain margin and the item/location does
not have a cost change in the cost review

period.

Edit Proposed Retail Prices

Enter a new retail price in the New Retail field as required for each item.

Take or Don't Take Proposed Price Changes

1.
2.

Select the level to view the worksheet at from the Item Level drop-down.

Change the Price Change Indicator field in the appropriate row:

Maintain Wiew |

Itern Level I‘rran Level

=]

8

Mew Retail WOM | Price Change Indicator | Conflict State Promotion €
ﬂ Filkar by w || Filkar by E Fikkar by: Filbar by: Filkar by:
; EACH - Mew
S50] EACH Mew
24| EACH -Dr‘z:i s Mew
22| EACH Mew
02 EACH M aw
29 EACH Meaw
&2 EACH e
01| EACH Meaw
nilcaru GO

Price Change Indicator column

3.

= Select "Take" to accept the proposed price change for the item.

= Select "Don't Take" to reject the proposed price change for the item.

Click Save. Your changes to the worksheet are saved and the Worksheet Status
workspace opens.

See the Worksheet columns section for a complete list of the editable columns on the
worksheet.
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View Totals

Navigate: From the Task Pad, select Worksheet > Worksheet Status. The Worksheet

Status workspace opens.

%5 worksheet Status

I@ Worksheet Status

Reason | |@
Adion [ gelact - =l
I,
Merchandise Level | Merchandise ID Location Level | Location ID Location Status | Conflict| Last Review Date | Reas
Filker by: w || Fitrer by Filter by | ||| Fitter by | ™) Fitber by | ||| A | Fite| || Fiter by ht (1ERES
Cepartment
Cepartment 2 Zoneg 2 21 Mew 0z-02-200%
4] »
Selact All || Unzelect All || Wworksheet Detail

Total Price Change Amount | £n0n
Total Price Change SCOH o
Total Price Change Itermns 5
Total Sales Armount £0.00

Worksheet status workspace

1. Select the worksheet you want to view the details of. You can select multiple
worksheets or click Select All to select of all the worksheets.

2. Click Worksheet Detail. The Worksheet Detail workspace opens.
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%5 worksheet Details

I@ Worksheet Details |
Itern Level 'Tran Level lEI
cotin Save View . . . D E
| = | i - =]
I,
Item ID Item Description | Historical Salg Historical Sald Seasonal Sell | Sell Thru % | Rule Season/Phasd Store On H
Filker by W\ Filker by || Fitker by Filker by Fitker by | T\ Filker by | ||| Fitber by | ||| Fitker by | ||| Fitber by
. B
1901 RDP CMLTE 0,00 o i 5]
1910 RDP Ttem for REM 0.00 0 i 5]
1911 RDP item far RPM 0.00 0 i 5]
1360 RPD RPM itzm 0.00 o i 5]
1961 RDP RPM itzm 2 0.00 o i 5]
1952 RDP RPM Item 3 0.00 o 5
1370 RDF RPM Item 0.00 o i 5]
[«] l »
| Unzelad All || Selack All || Reset Data || What If || Suggest Date ||

| Cancel Il Save Il Done I

Worksheet detail workspace

3. Select the row you want to view totals for by clicking the box :‘ to the left of the

Tow.

= Press and hold the Ctrl key while selecting to select multiple rows. Click Select
All to select all the rows.

Note: If no items are selected, the totals appear for all items
where a price change would occur.
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4. Click the Totals =1 button. The Totals window opens.

Price Change Totals|| Sales Totals | Competitive Analysis totals

Zone ID Zone Name Price Change Amount| Price Change SOH Price Change Items

Fecalculate Total || Cone

Totals window

View Price Change Totals

1. Select the Price Change Totals tab. The totals for all of the item rows that you selected
appear on the Totals window.

2. Click Done. The Totals window is closed.

View sales totals

1. Select the Sales Totals tab. The totals for the sales for the item rows that you selected
appear on the Totals window.

2. Click Done. The Totals window is closed.

View Competitive Analysis Totals

1. Select the Competitive Analysis Totals tab. The totals for how you are competing in
all retail zones that you have selected appear on the Totals window.

2. Click Done. The Totals window is closed.
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What-If Analysis

Navigate: From the Task Pad, select Worksheet > Worksheet Status. The Worksheet
Status workspace opens.

%5 worksheet Status

I@ Worksheet Status |

Reason | |@ Apply
Adion [ gelact - =l
I
Merchandise Level | Merchandise ID Location Level | Location ID Location Status| Conflict| Last Review Date | Reas
Filker by: w || Fitrer by w || Fiter by ||| Filber by | T|| Fitrer by ||| AT | A | | A by ht (1ERES
Cepartrent
Cepartment 2 Zoneg 2 21 Mew 0z-02-200%
4] »
Selact All || Unzelect All || Wworksheet Detail

Total Price Change Amount | £n0n

Total Price Change SCOH o
Total Price Change Itermns 5
Total Sales Armount £0.00

Close

Worksheet status workspace

1. Select the worksheet you want to view the details of. You can select multiple
worksheets or click Select All to select all of the worksheets.

2. Click Worksheet Detail. The Worksheet Detail workspace opens.
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%5 worksheet Details

@ Worksheet Details |

Ttern Level 'Tran Level lEI
|c0rin lzl | Save View Diff Type . D

I

Item ID Item Description | Historical Salg Historical Sald Seasonal Sell | Sell Thru % | Rule Season/Phasd Store On H

Filker by W\ Filker by || Fitker by :l Filker by :l Fitker by | T\ Filker by | ||| Fitber by | ||| Fitker by | ||| Fitber by
T 5

1901 ROP CMLTE 0.00 o] ﬂ

1910 RDP Item for RPM 0.00 a H

1911 RDP item for RPM 0.00 a ﬂ

1960 RPD RPM itern 0.00 a H

1961 RDP RPM itern 2 0.00 a H

1962 RDP RPM Itemn 2 0.00 a H

1370 RDP RPM Item 0.00 a H

Kl I 3

| Unzelad All || Selack All || Reset Data || What If || Suggest Date ||

Cancel Il Save Il Done I

Worksheet detail workspace

3. Select the row you want to perform a what-if analysis on by clicking the box :‘ to
the left of the row.

* Press and hold the Ctrl key while selecting to select multiple rows. Click Select
All to select all the rows.
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Perform a What-if Analysis on a Clearance Pricing Strategy

1.

Price Strategy - Clearance @

rPrcing Guides

Click What If. The What If window opens.

Current

Mew |- Selact - IEI

—Markdown Percents

Il

Markdowven Mumber Current Mew

1 105 105
2 20% 20%
2 0% 209
4 409 405
=] 0% S0%
& & 05 & 015
T TO%E 7O
g S0%% S0%%

| Cancel || Resat || Apply |

What If window
2.

Make changes to the following fields to test what happens to the worksheet:

=  Price guide: Select a new price guide from the New drop-down.

= Markdown percent: Enter a markdown percent in the New Markdown Percent

field.

Click Apply. The What If window is closed and the data in the Worksheet change to

reflect the changes made in the What If window.
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Perform a What-if Analysis on a Competitive Pricing Strategy
1. Click What If. The What If window opens.

Price Strategy - Competitive E]

 Pricing Guides

Current

Hew |- Select - lzl

~Competit

Current Compete Type * Naw Cormpete Type Price By Code =

Current Compete Percent
Current Acceptable Range Fram

Current Acceptable Range To

rCompete Yalues by Code

I
Code Current Compete Ty| Current Compete Percd Current Acceptable Range F{ Current Acceptable Rangd New Compete Ty New Compete Dem=|
Mo Code | Price Below 15% 15% 20%: Price Below | "l15% Z
Alphat Price Above 10% Price Above | ™ H0%
Christm..| Price Above 7% 5% =5 Price sbove | |79 =]
nal lmaech rstch - i
Cancel || Reset || Apply

What If window
2. Make changes to the following fields to test what happens to the worksheet:
=  Price guide: Select a new price guide from the New drop-down.

= Compete type: Select a different compete type for the whole worksheet or by
code by selecting from the New Compete Type drop-downs.

= Compete percent: Enter a new compete percent in the New Compete Percent
field.

3. Click Apply. The What If window is closed and the data in the Worksheet change to
reflect the changes made in the What If window.
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Perform a What-if Analysis on a Margin Pricing Strategy
1. Click What If. The What If window opens.

Price Strategy - Margin

()

rPricing Guides

Current

Mew |- Selact - IEI
rMargin Percents

I &%

Code Current Margin Target| Current Acceptable Range From| Current Acceptable Range To| Mew Margin Target
Ma Code 43 % 4 396 S0% 4%

Alphal < G o G & G o} G

Christmas [15% 1596 2055 15%:

Seasonal  [S5% 55 T 556

Springtirme |10% 10% 159 1008

| Cancel || Reset || Apply |

What If window

2. Make changes to the following fields to test what happens to the worksheet:
=  Price guide: Select a new price guide from the New drop-down.
* Margin target: Enter a margin target in the New Margin Target field.

3. Click Apply. The What If window is closed and the data in the Worksheet change to
reflect the changes made in the What If window.

Reset the What-if Data
1. Click What If. The What If window opens.
2. Click Reset. The values are returned to their original value.

3. Click Apply. The What if window is closed and the data in the Worksheet change
back to their original value.
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Export a Worksheet

Export allows you to export the current view of the worksheet to a Comma Separated
Value (csv) file.

Navigate: From the Task Pad, select Worksheet > Worksheet Status. The Worksheet
Status workspace opens.

%9 worksheet Status

@ Worksheet Status |

Reaszon | |@

Adion [ selact - =l
I,
Merchandise Level | Merchandise ID Location Level| Location ID Location Status | Conflict| Last Review Date | Reas
Filter by W Fidter by F|| Fitvar by || Fitter by | TN | Fitber by || AT | Fitke| || Fidter by || ity
Cepartment Zone Hew 03-01-2003
Crepartment 2 Zone =) 21 Mew 03-02-2005
4] »
Select All || Unselec All || Wworksheet Detail

Tatal Price Change Amount |40 0p

Total Price Change SOH o
Total Price Change Items 5
Tatal Sales Armount 0,00

Cloze

Worksheet status workspace
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1. Select the worksheet you want to view the details of. You can select multiple
worksheets or click Select All to select of all the worksheets.

2. Click Worksheet Detail. The Worksheet Detail workspace opens.

%3 wWorksheet Details
I@ Worksheet Details |
Itermn Lewel ITran Level lzl
|c0rin lzl | Save View Diff Type . D
I ]
Item ID Item Description | Historical Salg Historical Sald Seasonal Sell | Sell Thru % | Rule Season/Phasd Store On I*
Filtar by ||| Fiiter by || Fitter by :l Filkar by :l Filbar by || Fitter by | ||| Filter by | F||| Fitter by || Fitter by: |
T : 5
1301 RDP CMLTS 0.00 0 i 5]
1310 RDP Item for RPM 0.00 o i 5]
1311 RDP itzm far RPM 0.00 o i 5]
1980 RPD RPM itzm 0.00 o i 5]
1981 RDF RPM itzm 2 0.00 o i 5]
1952 RDP RPM Item 3 0,00 o i 5]
1970 RDP RPM Item 0,00 o i 5]
[« l >
Unzeladc All || Selact All || Reset Data || Wwhat If || Suggest Date ||
Cancel Il Save Il Done I

Worksheet detail workspace

3. Select the row you want to export by clicking the box :I to the left of the row.

= Press and hold the Ctrl key while selecting to select multiple rows. Click Select
All to select all the rows.

4. Click the Export (Bl button. The Save window opens.
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Save

Save In: |[:| Ternp

03 wERC.tmp. dirdn [1 {aShal4e0-7384-11d4-bae7-00409631a2c8}
3 wWERD.trap. dirdD [1 {a8533100-1481-11d4-9731-00c04f22ab 35}
3 WERE.trnp, dir0i [ {abds9912-5d00-11d4-bae7-9367cala7955}
3 WERF.trnp, dir0d [ {CAS32E73-1BB7-11DE-9DEA-00010240CE35)
3 WERF.tmp. dir01 [ {CE303AFF-1BER-1108-906A-00010240CE95])

3 wards.0 sheet44544

175 {00761b0&-803d-11d4-9790-00c04fEeeb39}
[ {46E891FF9-F43A-4AE6-B3IF2Z-SCEFD4CCRBELY

1 [»
File Marme: F'r'i-:i b 454 4 |

Files of Type: |*.cs-.l lEI

| Save || Cancel |

Save window

5. Select a location to save the file to from the Save In drop-down.

6. Enter a name for the file in the File Name field.

7. Click Save. The file is saved.

8. Open the file in the program of your choice such as a spreadsheet or word processor.
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Price Changes

Price Changes

A price change is the permanent change in the price of an item. You can use the price
guides to move the new price to established price points, round the price, or define price
internals.

The Create Price Change workspace allows you to establish the price changes for an item
or group of items at a location or group of locations. When you open the window, the
Price Change List and Price Change Maintenance containers open. After you create your
price change in the Price Change Maintenance container, it is added to the Price Change
List container.

If you select locations with multiple currencies, you can only choose to create a price
change by percent or to reset the POS price. Additionally, you cannot create multi-unit
pricing across multiple currencies.

Create price change allows you to create the following types of price changes.
= Regular: The price change is occurring at the retailer's initiative.
= Vendor Funded: The supplier is subsidizing a portion of the price change.

= Link codes: Associate items to each other at a location and price them exactly the
same.

When a price change is added to RPM, it must go through a series of checks before it can
be applied to an item/location. Depending on your user role, you may not be able to
move the retail price change to the next status. A change to submitted or approved
status, or from worksheet back to approved, results in a conflict check. A change to
approved status results in the application of area differential strategies for the price
change. A price change may be in any of the following statuses:

Status Definition

Worksheet The price change has been started,
but not reviewed or sent out.

Submitted The price change has been
completed and is pending review.
Conlflict checking has occurred for
the price change.

Approved The price change has been reviewed
and accepted. The price change is
communicated to the locations for
which the price change is effective.

Executed The new prices established are
effective for the item/location.

Rejected The price change has been reviewed
and declined.
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Search for a Price Change

After you create a price change, you can maintain different aspects of the price change.
You can create exceptions to the items and locations that exist on the price change, you
can change the specifics of the price change, and you can copy an existing price change.

The procedures below allow you to navigate and search for price changes through the
Maintain Price Change task on the Task Pad; however, you can accomplish these same
tasks after you create a price change and the price change is displayed in the Price
Change List pane in the Create Price Change workspace.

Search for a Price Change

Navigate: From the Task Pad, select Price Changes > Maintain Price Change. The

Maintain Price Changes workspace opens.

%3 Maintain Price Changes

I-'f(::' Price Change Search

Type [regulsr 54|
Status [ select - =l
Appraved By | |
Crested By | |
Fesson Code l:l 8+

5
Departrment l:l +

=

Itern Type |Item E
Itern Level  [Transaction Level Item =l

[ search On This Leval Gnly

—

Itern

Effactive Date | |E -|—0| |E
Approved Date | |E -|—0| |E
Create Date | |E -|—0| |E

Price Guide

[ 18

E—

D Search On This Lavel Only

Market Bazket Code l:l +

Location

=T

cancel

Maintain Price Changes workspace Price Change Search pane

1. Enter criteria as necessary to restrict the search to the price changes you want to

maintain.

Field Criteria

Type Select Regular, Vendor Funded, Link Code, or All price change types.

Status Select Approved, Executed, Rejected, Submitted, or Worksheet status
price changes.

Approved By Enter a username to search for price changes approved by a specific
user.

Created By Enter a username to search for price changes created by a specific user.

Reason Code Select reason codes
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Field Criteria

Deal ID Select deal IDs to search for price changes related to specific deals. First
select Vendor Funded from the Type field.

Deal Detail ID Select deal detail IDs to search for price changes related to specific deal
details. First select Vendor Funded from the Type field, then select a
deal from the Deal ID field.

Price Change ID Select price change IDs to search for specific price changes.

Effective Date Select an effective date to search for price changes with a specific
effective date.

Approved Date Select an approved date to search for price changes with a specific

Create Date

Price Guide

Merchandise Level

Zone/Location

Market Basket
Code

Link Code

approved date.

Select a create date to search for price changes with a specific create
date.

Select price guides to search for price changes with specific price
guides.

Select criteria in the following fields to search for price changes in a
specific merchandise level:

*  Department
=  (lass
= Subclass

* Item Type
» [tem Level
= Diff Type
= Jtem

= Diff

Select Zone Groups, Zones, and Locations to search for price changes
from specific zones or locations.

Select a Market Basket Code to search for price changes with a specific
Market Basket Code.

Select a Link Code to search for price changes with a specific Link Code.

Note: Select the Search on this Level Only checkbox to
restrict the search to the selected level.
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2.

Click Search. Your results appear in the Price Change List pane.

@ Price Change List

Price Change View |Standard Colurnn view| ¥ || g#
Id Link Code [tem [tem Descripy Item Level | Diff Id Diff Id Descri| Location Location Desqd Location Typd Primary Zon
Fitkar by FA|| Fitter by | ||| Fitver by:| V| Fitter by ||| Fitver by:| ™ )| | Fidber by || Fitter by:| ||| Fitver by:| V|| Fitter by ||| Fitter by | || | Fiitter by | ™

241 100151009 [RPM GA **., [Transaction ., 2 AUD location, |Zone b4

921 100151009 |RPM Q& **., [Transaction .. 2 AUD locatio.., [Zone :

20z 100118006 |Misty Test L. |Transaction ., 1000000027 [Sydney Stare

201 100118006 |Misty Test L. |[Tranzaction ., 1000000025 [Las Yegas  |Stors
4 [ »
D [W[dr22450]pr] sotopazs [t [ef1r [—|

Selact All
status  [apnroved action  [salect- [w] [ Update | [ cenflict chack || suggestDat=_|
| [ Delete Hew I Copy |[_Lec Exception ][ Tran Exception ||

Price Change List pane

Create a Regular Price Change

Navigate: From the Task Pad, select Price Changes > Create Price Change. The Create

Price Change workspace opens.

%5 create Price Change

If—) Price Change List

(J) wendor Funded
() Link Code

—

* Effective Date

Change Type [change By Amount

Change Amount |

selling UOM

Ignore Constraints

* Location Selection

Zone Group 8

Price Change Wiaw |Standard Colurmnn view| ||| &

1d Link Code | Item Item Descrip Item Level | Diff Id Diff Id Descri| Location Location Desq Location Typd Primary Zon.

Fitcer by [ ¥ ||[ Fitver by [ ¥ ||[ Fitver by [ ¥ || [ Fiter b [ 7| [ Fiter b [ ||| iter v [ 7] [miter x> ||| Fitcer sy [ ||[ Fiteer 8[| [ mitemr [ ]|[ iter b {1

4 »

Select Al _

Status Action [ gelac - = T [_cenflict chack ][ suggest Date |
| Delate H Meaw Il ZCopy H Loc Exception H Tran Exception ||
@ Price Change Maintenance |

Type (®) Regular Price Guide

[ 18
L 18

* Reason Code

Multi Unit Pricing

|

Multi Units
Multi Unit Retail

MUt Unit UG

|

cancel |[_save + Repeat |[ rcone |

Create Price Change workspace
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1. In the Price Change Maintenance pane, in the Type field, select Regular.

I(: Price thange Maintenance

Type ®) Regular Price Guide l:l
() wendar Funded * Reason Code |:| =
(i Link Code
* Effective Date I:l@
Change Type |<3|..a,..gE By Amount E‘ Multi Unit Pricing
iChange Armount | |
=
=
F
Ignore Constraints =l
~ Location Selection
=
Location Selection |
Level | d Description | Location Type

- Item Selection

Itern Type  [ttem

&[]

Itern Level  [Transaction Level Item

Itern B+

Price Change Maintenance pane

2. In the Effective Date field, enter the date the price change should go into effect, or

click the calendar B button and select a date.

Note: The Effective Date you can set depends on the number
of days set in the system option Price Change Processing
Days. The earliest date price changes can be created is
today’s date plus the price change processing days. If you
have emergency price change permission, Price Change

Processing Days will be ignored.

3. In the Price Guide field, enter the ID of the price guide you want to apply to the price
change, or click the LOV El button and select a price guide.

Note: The price guide only applies to the items in the same
department as the price guide and locations that share the

same currency as the currency on the price guide.

4. In the Reason Code field, enter the ID of the reason you are creating the price change,

or click the LOV =l button and select a reason code.
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Setup Price Change Type

1.

Select Locations
1.

In the Price Change Type field, select the type of price change that is occurring.

Note: If you selected locations with multiple currencies, you
can only choose to create a price change by percent or to
reset the POS price.

Change By Percent: A price for an item is changed by a percentage added to or
removed from the basis regular retail. The percent of change is determined by
the percent entered in the Change Amount field.

Change By Amount: A price for an item is changed by an amount added or
removed from the basis regular retail. The amount of change is determined by
the amount entered in the Change Amount field.

Fixed Price: The price for the item will be at a specified retail that will be defined
in the change amount field.

Reset POS Price: The item will be recognized on a price change but no change to
the retail will occur. When you select Reset POS Price, the Change Amount field
and Selling UOM field will be disabled.

In the Change Amount field, enter an amount.

If appropriate, define the multi-unit pricing for a price change:

a.
b.

Select the Multi Unit Pricing check box.

In the Multi Units field, enter the number of units that are part of the price
change.

In the Multi Unit Retail field, enter the new price for the items.
In the Multi Unit UOM field, enter the ID of the unit of measure that applies to
the price change, or click the LOV El button and select a unit of measure.

In the Location Selection area, select how you want to add locations to the price
change.

Zone Group: Enter the ID of the zone group that contains the locations to add to
the price change, or click the LOV El button and select a zone group.

Zone: Enter the ID of the zone to add to the price change, or click the LOVE*
button and select a zone.

Location: Enter the ID of the location that you want to add to the price change, or
click the LOV El T button and select a location.

Note: You can create price changes at the zone or location
level.

Click Select. The zones and/ or locations that meet your criteria are added to the
table in the Location Selection table.
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Select Items

1. In the Price Change Maintenance pane, in the Item Selection area, select items on the
price change using the available fields.

¥ Item Selection

=]
=]
Item Type  [itemn =
Item Lavel | =]
-]
=]
Item Selection |l
Level | D Diff ID | Description

Item Selection area of Price Maintenance pane

Note: All fields with LOV E1* buttons allow multiple
selections.

= To select items from all available items, enter an ID in the Item field, or click the
LOV El* button and select item.

a. Enter information in the enabled fields to limit the items available in the Item
field.

In the Department field, enter a department number, or click the LOV +
button and select a department.

In the Class field, enter a class number, or click the LOV E1* button and
select a class.

In the Subclass field, enter a subclass number, or click the LOV Elt button
and select a subclass.

In the Item Type drop-down, select Item or Item List.

Note: If you select Item List from the Item Type drop-down,
only item lists will be selectable from the Item field. If you
select Item, only single items that conform to the other
criteria specified will be selectable.

In the Item Level drop-down, select Parent Item, Parent Item/Diff, or
Transaction Level Item.

Note: The Diff Type and Diff fields are only enabled if
Parent Item/ Diff is selected.

In the Diff Type drop-down, select a diff type.
In the Diff drop-down, select a diff.

b. In the Item field, click the LOV &t button and select items.
2. Click Select. Items that meet your criteria are added to the Item Selection table.
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Complete the Price Change

1. In the Price Change Maintenance pane, click Apply to create price changes. One price
change will be created for each item/location intersection.

Change the status of your price change as appropriate.

Click Done to save your changes and close the workspace.

Create a Vendor Funded Price Change

Navigate: From the Task Pad, select Price Changes > Create Price Change. The Create
Price Change workspace opens.

%5 Create Price Change

al

I@ Price Change List | —I
Price Change ¥iew [Standard Column vies[ ] || g%
d Link Code Item Item Descripfl Item Level Diff Id Diff Id Descri] Location Location Desd Location Type Primary Zom

[Fitcer sy | ¥ ||| Fieer sy [ ¥ || miteer sy ¥ | [ Fitter sy ] || iteer by || Fitter [ || Fitear o] | Fitear oy { || Fitar £ { | | tter 2y { ||| Fier £y 7]

2 E=

I@ Price Change Maintenance |

Type ®) Regular Price Guide l:l g
(") wendor Funded * Reason Code l:l E
(O Link Code
* Effective Date l:l
Change Type |Changg By Armaunt lz' Multi Unit Pricing O

change Amount | |

Ignore Constraints . %

~ Location Selection

Zone Group 8 -

Cancel ” Save + Repeat ” Lone I

Create Price Change workspace
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1. In the Price Change Maintenance pane, in the Type field, select Vendor Funded.

I('J Price Change Maintenance |

Type () Regular Price Guide l:l
(O] *
S Gesapicalll|
() Link Code
* Effective Date l:l
Change Typa |<;ha,.,gE By Amount E mMulti Unit Pricing [

Change Amount | ‘

8
8

Partrer Type [ select- B
I 2
* Funding Type |
} Location Selection
Location Selection Il
Level n Description | Location Type ‘
¥ Item Selection
Item Selection (=3
Level i Diff ID | Description ‘

| |

Price Change Maintenance pane
2. In the Effective Date field, enter the date the price change should go into effect, or
click the calendar 24 button and select a date.

Note: The Effective Date you can set depends on the number
of days set in the system option Price Change Processing
Days. The earliest date price changes can be created is
today’s date plus the price change processing days. If you
have emergency price change permission, Price Change
Processing Days will be ignored.

3. In the Price Guide field, enter the ID of the price guide you want to apply to the price
change, or click the LOV &l button and select a price guide.

Note: The price guide only applies to the items in the same
department as the price guide.

4. In the Reason Code field, enter the ID of the reason you are creating the price change,
or click the LOV El button and select a reason code.
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Select the Vendor and Deal

1. In the Price Change Maintenance pane, in the Partner Type drop-down, select the
partner type.
=  Manufacturer
=  Distributor
=  Wholesaler
= Supplier
2. Inthe Partner field, enter the ID of the partner with the deal, or click the LOV
button and select a partner.
3. Inthe Deal ID field, enter the ID of the deal, or click the LOV El button and select a
deal.
4. In the Deal Detail ID field, enter the ID of the deal details, or click the LOV &1 button
and select the deal details.
Setup Price Change Type
1. In the Price Change Type field, select the type of price change that is occurring.
Note: If you selected locations with multiple currencies, you
can only choose to create a price change by percent or to
reset the POS price.
= Change By Percent: A price for an item changed by is a percentage added to or
removed from the basis regular retail. The percent of change is determined by
the percent entered in the Change Amount field.
= Change By Amount: A price for an item is changed by an amount added or
removed from the basis regular retail. The amount of change is determined by
the amount entered in the Change Amount field.
=  Fixed Price: The price for the item will be at a specified retail that will be defined
in the change amount field.
* Reset POS Price: The item will be recognized on a price change but no change to
the retail will occur. When you select, the Change Amount field and Selling
UOM field will be disabled.
In the Change Amount field, enter an amount.
3. If appropriate, define the multi unit pricing for a price change:

a. Select the Multi Unit Pricing check box.

b. In the Multi Units field, enter the number of units that are part of the price
change.

c. Inthe Multi Unit Retail field, enter the new price for the items.
In the Multi Unit UOM field, enter the ID of the unit of measure that applies to
the price change, or click the LOV &l button and select a unit of measure.
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Select Locations

1. In the location area of the Price Change Maintenance pane, in the Location field,
]
enter a location ID, or click the LOV &1+ button and select locations.

Note: Only locations on the deal are selectable.

2. Click Select. Locations are added to the table in the Location Selection table.

Enter Funding Information

1. In the Price Change Maintenance pane, in the Funding Type drop-down, select
Percent or Amount.

Note: If the selected locations have different currencies, only
Percent is available.

2. In the Funding Amount field, enter an amount.

Select Items

1. In the Item Selection area of the Price Change Maintenance pane, in the Item field,
[ ]
enter an item ID, or click the LOV Elt button and select items.

Note: Only items on the deal are selectable.

2. Click Select. The items appear in the Item Selection table.

Complete the Price Change
1. In the Price Change Maintenance pane, click Apply to add all your changes.
2. Change the status of your price change as appropriate.

3. Click Done to save your changes and close the workspace.
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Create a Link Code Price Change

Navigate: From the Task Pad, select Price Changes > Create Price Change. The Create

Price Change workspace opens.

%3 Create Price Change

I@ Price Change List

Price Change

Wiew |Standard Columnn view|[ ] || g%
d Link Code Item Item Descripy Item Level Diff Id Diff Id Descri| Location Location Desg Location Type Primary Zom
Fitker by ||| Fitter by || Fitter by:| | | Friker by ||| Fitker by FN|| Fiiter by T | Fitter by ||| Filker by T |ﬁ!ter by ™ |F.l!t'er by ™ |F.ll‘ter LT

4 4
2 E2
Select Al
Status action [ selec - [= T [L_conflict check [ suggast Date |
Delete Naw ]| Copy [[_Loc Excaption |[ Tran Excsption ||
I@ Price Change Maintenance |
Type @) Regular Price Guide l:l =]
wendor Funded * Reason Code l:l E
() Link Code
* Effective Date l:l
Change Type |change By Amount |Z| Multi Unit Pricing O
Change Amount | | Multi Units
Selling UOM . Multi Unit Retail
Ignore Constraints LA Wivits () .
~ Location Selection
Zone Group % -

Cancel ” Save + Repeat ” Lone I

Create Price Change workspace
1.
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I(:' Price Change Maintenance |

Tope () Regular =
() wendor Funded ¥ Reason Code l:l =
(@ {Link Codd
¥ Effective Date l:l@
Change Type | lzl Multi Unit Pricing |:|
H
=
]
=
* Link Code
* =
* Currency usD H
=
=
-
=

|

Price Change Maintenance pane

2.

In the Effective Date field, enter the date the price change is should go into effect, or
click the calendar & button and select a date.

Note: The Effective Date you can set depends on the number
of days set in the system option Price Change Processing
Days. The earliest date price changes can be created is
today’s date plus the price change processing days. If you
have emergency price change permission, Price Change
Processing Days will be ignored.

In the Price Guide field, enter the ID of the price guide you want to apply to the price
change, or click the LOV El button and select a price guide.

Note: The price guide only applies to the items in the same
department as the price guide and locations that share the
same currency as the currency on the price guide.

In the Reason Code field, enter the ID of the reason you are creating the price change,
or click the LOV El button and select a reason code.

Select Link Codes

1.

In the Link Code area of the Price Change Maintenance pane, in the Link Code field,
enter the ID of the link code, or click the LOV El button and select a link code.

In the Currency field, enter the currency code, or click the LOV &l button and select
the currency.

In the Zone Group field, enter the ID of the zone group that contains the locations
you want to add to the price change, or click the LOV =1+ button and select a zone
group.

In the Zone field, enter the ID of the zone that contains the locations you want to add
to the price change, or click the LOV T button and select a zone.

Note: The Zone field is limited by the currency entered in
step 2.
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5. Inthe Location field, enter the ID of the location that you want to add to the price
change, or click the LOV + button and select a location.

Note: You can create price changes at the zone level.
Locations are not required.

Setup Price Change Type
1. Inthe Change Type field, select Fixed Price.

= Fixed Price: The price for the item will be at a specified retail that will be defined
in the change amount field. Link code price changes can only be setup as fixed
price.
2. Inthe Change Amount field, enter an amount.
3. If appropriate, define the multi unit pricing for a price change:
a. Select the Multi Unit Pricing check box.

b. In the Multi Units field, enter the number of units that are part of the price
change.

c. Inthe Multi Unit Retail field, enter the new price for the items.

d. Inthe Multi Unit UOM field, enter the ID of the unit of measure that applies to
the price change, or click the LOV El button and select a unit of measure.

Complete the Price Change
1. In the Price Change Maintenance pane, click Apply to add all your changes.
2. Change the status of your price change as appropriate.

3. Click Done to save your changes and close the workspace.
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Change the Status of a Price Change

Navigate: From the Task Pad, select Price Changes > Maintain Price Change. The
Maintain Price Changes workspace opens.

%5 Maintain Price Changes

(f—_) Price Change Search

Type [regular =] Price Change ID I:I 8+
Status | celed - |E| Effective Date | | T°| |
Approved By | | Approved Date | | -|—0| |
Created By | | Create Date | | -|—0| |
Resson Code |:| B+ Price Guide I:I B+
Deal ID B- Deal Detail ID B

Clazz .+ Zone .+

Subclass .+ Location I:I %4.

Itern Type |Item I:‘ Search On This Lavel Only

]

Itern Level I'I'ransaction Level Itern
Markeat Basket Code l:l %4_
[] search ©n This Level Cnly
Diff Type  celoct - |z| Limk Cade .+

e E—] T
Diff B

[oioar ] oo |

Maintain Price Changes workspace
1. Search for and retrieve the price change you want to maintain. Your results are
displayed in the Price Change List pane.

f(—) Price Change List |

12

Id Link Code Item Item Descripy Item Level Diff 1d Diff Id Descri| Location Location Desd Location Typg Primary Zon

riteer by | ¥ | Fiteer by | | [ Fiteer by | w || Fiteer sy [ | | Fiter b || Fiteer sy [ | Fitear g [ w ||| Fteer by | 2| Fiteer spe o] | Fiter e [ )| Fiteer 2y 3

241 100151009 [RPM Q& **. [Transaction .. 3 AUD locatio... [Zone b4
921 100151009 |RPM Q& **., [Transaction .. 2 AUD locatio.., [Zone :
20z 100118006 |Misty Test L..|Transaction ... 1000000027 |Sydney Store
201 100118006 |Misty Test L..|Transaction .. 1000000025 Las Vegas Store

4 .3

|
ﬁ Emlzﬁiimg Go to page ofl? E

Status  [approved acion [ select- [w] [ Opdate | [_conflict check _|[_suggest Dat=_|

| [ Delste I Hew I Copy |[_Lec Exception ][_Tran Exceptian ||

Price Change List pane
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Note: If you are in the Create Price Change workspace your
price changes are displayed in the Price Change List
container when you click Apply. You do not need to open
the Maintain Price Change workspace.

2. Select the price change for which you want to change the status.
= In the table, select a row.
=  Click Select All. All records in the Price Change List pane are selected.
In the Action field, select the status to which you want to move the price change.
Click Update. You are prompted to confirm your decision.

Click Yes. If the system option, background conflict check, is off and conflicts exist,
the Conflict Review List window is displayed.

Conflict Review List 3

Conflict Review List " &

Change Type Change Amount Effective Date

Change By Percent  15% 12-20-2004

Price Change Tyj ID Promotion Comp Date Unit Retail on E4 Selling UOM Multi Units Multi-Unit Retai| Mult-Unit Selling
Price Change 3221 12-04-2004 $26.84 EACH
Price Change 3242 12-01-2005 $35.22 EACH

Conflict review list window

Note: See View conflict check results for more information
on background conflict checking. When background conflict

check is on, a binocular i icon appears in the conflict
column when conflict checking is complete. Click the icon to
open the Conflict Review List workspace.

a. The current price change is displayed in the upper half of the window. Price
changes promotions, and/ or clearances for the same item/location are displayed
in the lower half of the window.

b. Click Close to close the Conflict Review List. The Maintain a price change
procedure contains additional information on how to adjust a price change.

6. Click Done to save any changes and close the window.

160 Oracle Retail Price Management



Price Changes

Maintain a Price Change

Navigate: From the Task Pad, select Price Changes > Maintain Price Change. The
Maintain Price Changes workspace opens.

%5 Maintain Price Changes

(f—_) Price Change Search

Type [regular =] Price Change ID I:I 8+
Status | celed - |E| Effective Date | | T°| |
Approved By | | Approved Date | | -|—0| |
Created By | | Create Date | | -|—0| |
Resson Code |:| B+ Price Guide I:I B+
Deal ID B- Deal Detail ID B

Clazz .+ Zone .+

Subclass .+ Location I:I %4.

Itern Type |Item I:‘ Search On This Lavel Only

]

Itern Level I'I'ransaction Level Itern
Markeat Basket Code l:l %4_
[] search ©n This Level Cnly
Diff Type  celoct - |z| Limk Cade .+

e E—] T
Diff B

[oioar ] oo |

Maintain Price Changes workspace
1. Search for and retrieve the price change you want to maintain. Your results appear in
the Price Change List pane.

f(—) Price Change List |

12

Id Link Code Item Item Descripy Item Level Diff 1d Diff Id Descri| Location Location Desd Location Typg Primary Zon

riteer by | ¥ | Fiteer by | | [ Fiteer by | w || Fiteer sy [ | | Fiter b || Fiteer sy [ | Fitear g [ w ||| Fteer by | 2| Fiteer spe o] | Fiter e [ )| Fiteer 2y 3

241 100151009 [RPM Q& **. [Transaction .. 3 AUD locatio... [Zone b4
921 100151009 |RPM Q& **., [Transaction .. 2 AUD locatio.., [Zone :
20z 100118006 |Misty Test L..|Transaction ... 1000000027 |Sydney Store
201 100118006 |Misty Test L..|Transaction .. 1000000025 Las Vegas Store

4 .3

|
ﬁ Emlzﬁiimg Go to page ofl? E

Status  [approved acion [ select- [w] [ Opdate | [_conflict check _|[_suggest Dat=_|

| [ Delste I Hew I Copy |[_Lec Exception ][_Tran Exceptian ||

Price Change List pane
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Maintain a Price Change

2. From the list of results, select the price change you want to maintain. The price
change details appear in the Price Change Maintenance pane.

I/(J Price Change Maintenance

=

* Effective Date 03f022005

Change Type |Change By Amount lz' Multi Unit Pricing D

Change Amount |200.00 |
Location Selection (=3
Level | 1D ‘ Description | Location Type
Store | 1000000000 | Farga | Store
Item Selection |
Level | jui) ‘ Diff 1D | Description
Parent Item | 100163000 | |CN-1

| Apply |

Price Change Maintenance pane

3. If necessary, change the status of the price change to Worksheet.

4. Edit the enabled fields as necessary.

Note: You cannot change the items and locations on a price

change.

o

Click Apply to add all any changes.

6. Click Done to save any changes and close the window.
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Copy a Price Change
1. From the list of results, select the price change you want to copy.
2. Click Copy. The price change details appear in the Price Change Maintenance pane.

I@ Price Change Maintenance |

* Effective Date

Change Type |Changg By Armount lz' Multi Unit Pricing  []

Change Armount |200,gg |

8
8

Location Selection (3
Level | n Description | Location Type
Store | 1000000000 | Fargo | Store
Item Selection Il
Level | jui) ‘ Diff 1D | Description
Parent Item | 100163000 | |CN-1

| )
Price Change Maintenance pane

3. Edit the enabled fields as necessary.

4. Click Apply to add all any changes.

5. Click Done to save any changes and close the window.

Note: Effective dates, exceptions, and status are not copied
when copying a price change.

Delete a Price Change

From the list of results, select the price change you want to delete.
Click Delete. You are prompted to confirm your decision.
Click Yes. The price change is deleted.

Eal A

Click Done to close the window.

Note: Only price changes with a status of Worksheet can be
deleted.
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Check for Conflicts

1. From the list of results, select the price change you want to check.

2. Click Conflict Check. If the system option, background conflict check, is on and
conflicts exist, the Conflict Review List window is displayed.

Conflict Review List X

Conflict Review List " &

Effective Date

Change Type Change Amount

Change By Percent  15% 12-20-2004

Price Change Tyy ID Promotion Comp Date Unit Retail on E{ Selling UOM tulti Units Multi-Unit Retai| Multi-Unit Sellin
Price Change 3221 12-04-2004 $26.84 EACH
Price Change 3243 12-01-2005 $35.22 EACH

Conflict review list window
= If no conflicts exist, click OK.

= If conflicts exist, you must adjust the details of your price change before you can
move the price change to the next status.

Note: See View conflict check results for more information
on background conflict checking.

3. Click Done to save any changes and close the window.

Suggest a Date
1. From the list of results, select the price change you want to suggest a date for.

2. Click Suggest Date. The system runs a check of promotion constraints, then
calculates an appropriate date and places it in the effective date field.

3. Click Done to save any changes and close the window.
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Create a Location Exception

Note: Location exceptions can only be created for Zone Level
price changes

1. From the list of results, select the price change.

2. Click Location Exceptions. The locations selection area of the Price Change
Maintenance pane is enabled.

I@ Price Change Maintenance

* Effective Date

Change Type |Changg By Armount lz' Multi Unit Pricing  []

Change Armount |200,gg |

8
8

Location Selection (3
Level | n Description | Location Type
Store | loooo0oooo | Farga | Store
Item Selection Il
Level | jui) ‘ Diff 1D | Description
Parent Item | 100163000 | |CN-1

| [aest ]|

Price Change Maintenance pane

3. In the Location field, enter the ID of the location where items are different than the
zone on the price change, or click the LOV &l button and select a location in the zone.

4. In the enable price change fields, enter information about the price change for the
item/location.

Click Apply to add any changes.

Click Done to save any changes and close the window.
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Create Item Exceptions at the Transaction Level

Note: Item exceptions at the transaction level can occur only
when the price change was created at the item parent or item
parent/ diff level.

1. From the list of results, select the price change.

2. Click Tran Exceptions. The item selection area of the Price Change Maintenance pane
is enabled.

I@ Price Change Maintenance |

* Effective Date

Change Type |Change By Armount lz' Multi Unit Pricing  []

Change Armount |200,gg |

8
8

Location Selection |
Level | n ‘ Description | Location Type
Store | 1000000000 | Fargo | Store
Item Selection (4
Level | jui) ‘ Diff 1D | Description
Parent Itam | 1001&3000 | |CN-1

| L zeas |

Price Change Maintenance pane

3. In the Item field, enter the ID of the item for which items are different than the parent
item on the price change, or click the LOV El button and select an item.

4. In the enable price change fields, enter information about the price change for the
item.

Click Apply to add any changes.

6. Click Done to save any changes and close the window.
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Clearances

A clearance is designed to move out of date and slow selling merchandise out of a store.
A clearance is considered a permanent price change, and inventory is consequently
revalued. Once the reset date for a clearance has passed, the item’s price and inventory
value is returned to the regular price. The following clearances can be created.

= Regular: The clearance is occurring at the retailer's initiative.
* Vendor Funded: The supplier is subsidizing a portion of the clearance.

When a clearance is added to RPM, it must go through a series of checks before it can be
applied to an item/location. Depending on your user role, you may not be able to move
the clearance to the next status. A clearance may be in any of the following statuses:

Status Definition

Worksheet The clearance has been started, but not
reviewed or sent out.

Submitted The clearance has been completed and is
pending review. Conflict checking has
occurred for the price change.

Approved The clearance has been reviewed and
accepted. The clearance is communicated
to the locations for which the clearance is
effective.

Executed The clearance prices established are
effective for the item/location.

Rejected The clearance has been reviewed and
declined.

After you create a clearance, you can maintain different aspects of the clearance. You can
create exceptions to the items and locations that exist on the clearance, you can change
the specifics of the clearance and you can copy an existing clearance.

The procedures below allow you to navigate and search for clearances through the
Maintain Clearances task on the Task Pad; however, you can accomplish these same
tasks after you create a clearance and the clearance opens in the Clearance List pane in
the Create Clearance workspace.
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Search for a Clearance

Search for a Clearance

Navigate: From the Task Pad, select Clearances > Maintain Clearances. The Maintain
Clearances workspace opens.

%5 Maintain Clearances

(@ tlearance Search

Frovw  [o]

Effective Date [ & T |
Approved By | |
Approved Date | ‘ Te |

Deal ID

Dezl Detail ID

| B
B+

Department

Class

Subclaszs

B+

| B
B+

Cosea [1]

Crested By

Price Guide

Out OF Stock Date l:l

Zone

Item Type  [ttem

Diff Typ= | selact -

Ttern |

Diff

Item Level ransaction Level Item[¥] [J5earch On This Level Only
e E— -

B+

B

[] search on This Level Only

e —

|

Maintain Clearances workspace
1. Enter criteria as necessary to restrict the search to the clearances you want to

maintain.

2. Click Search. Your results appear in the Clearance List pane.

Wiew [Markup Colurmn view [ || &%

[ team [ Ttam Descripd toem Lovel | DiFzd

[ Dif¢ 14 Desen] Location | Location Desd Location Tvpd Primary Zone| Enception 1nd Pard

scif1o0022004 [arisl slespa...

nE Tam

11

[Teszt 2lrzon...

Zone

Fitrer Sy : sitrer by | || Ftrer 2 [ || mirer 2 [ || mtter 2 [ || mtter 2 [ )| [ mtver 2 [ || st 20 [ || mer 20 [ || mteer 20 [ ]| | e 20 [ ]| [

saz|100000016 [Tese

T

1000000014

Bl

Srare

Sa1[100000016 [TestItem 1...

1000000014

Bl

stare

Sz4[100025213  |MmM Fashion ...

1000000001

Minnespolis

stare

Fl [ >

= [@4l[ddrz235[]kr] sctcpas= 1 of 7 ="
S=lact All

e sctien Feee=- Ind

Sopw

Loc Excaption

| renexcepuon ]|

Clearance List pane
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Create a Regular Clearance

Navigate: From the Task Pad, select Clearances > Create Clearance. The Create Clearance

workspace opens.

B3 cCreate Clearance

I@ Clearance List

endor Funded

—

* Effective Date

Clearance ¥iew |Standard Column Vlew " d
1d Ttem Item Descripl] Ttem Level | Diff Id Diff Id Descri] Location Location Desq Location Typd Primary Zone| Exception In
Fitter by { || Fiteer by { ||| Fiter by { ||| Fiteer by { || Fiteer oy { ||| Fiter by { ||| Fitear oy { || Fitear by { ][ Fitear oy { || Fiteer by { ][ Fiter 4 { =
4 ]
hsi] =
Selact All
Status Action [ select - =] Update Conflict Check
Delete | New ] Copy | Lo Exception ][ Tran Exception ||
I@ clearance Maintenance |
Type ®) Regular Price Guide

* Resson Code

Changs Typs [armaunt off

Out Of Stock Date

change Arnaunt |

Reset Date

~ Location Selection

Zone Group %
Create Clearance workspace

1.

Earliest Reset Date
Latest Reset Date

Apply Subclass Defaults

[ 8
[ I8

-
C m

O

In the Clearance Maintenance pane, in the Type field, select Regular.
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Create a Regular Clearance

((=1 Clearance Maintenance
[E

Type (@) Regular Prica Guide l:l
() vendar Funded * Reason Code |:| =
¥ Effective Date l:IE
Change Type s cunt off Out O Stock Date l:IEI
Change Amaount | ‘ Reset Date l:l@

Apply Subclass Defaults  [7]

* Location Selection

Location Selection " &;
Level | d Description ‘ Location Type |

* Item Selaction

Itemn Type  [Item

]

Itern Level |Transaction Level Itern

Clearance Maintenance pane
2. In the Effective Date field, enter the date the clearance is enabled, or click the
calendar [ button and select a date.

Note: The Effective Date you can set depends on the number
of days set in the system option Price Change Processing
Days. The earliest date clearances can be created is today’s
date plus the price change processing days, unless you have
emergency privileges.

3. In the Price Guide field, enter the ID of the price guide you want to apply to the
clearance, or click the LOV &l button and select a price guide.

Note: The price guide only applies to the items in the same
department as the price guide and locations that share the
same currency as the currency on the price guide.

4. In the Reason Code field, enter the ID of the reason you are creating the clearance, or
click the LOV & button and select a reason code.

5. In the Out of Stock Date field, enter the date you expect the inventory to be
consumed, or click the calendar E button and select a date.

Note: Depending on your system settings the date may
default.
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6. In the Reset Date field, enter the date the price of the item returns to regular price, or
click the calendar B button and select a date.

Note: Depending on your system settings the date may
default.

7. Select Apply Subclass Defaults to attach a Clearance Defaults Pricing Strategy to the
clearance.

Note: Set up a Clearance Pricing Strategy before creating a
clearance. See the Clearance Defaults section of the Maintain
Price Strategies chapter for complete information on setting
up a Clearance Defaults pricing strategy.

Setup Clearance Type
1. In the Price Change Type field, select the type of clearance that is occurring.

Note: If you selected locations with multiple currencies, you
can only choose to create a clearance by percent.

Change By Percent: A price for an item changed by is a percentage added to or
removed from the basis retail price. The percent of change is determined by the
percent entered in the Change Amount field.

Change By Amount: A price for an item is changed by an amount added or
removed from the basis retail price. The amount of change is determined by the
amount entered in the Change Amount field.

Fixed Price: The price for the item will be at a specified retail that will be defined
in the change amount field.

2. In the Change Amount field, enter the amount, percent, or fixed amount for the
clearance.

Select Locations

Note: There is no need to enter a negative sign before the
number entered in the Change Amount field. A clearance
can only exist as a decrease in price.

1. Inthe Location Selection area, select how you want to add locations to the clearance.

Zone Group: Enter the ID of the zone group that contains the locations to add to
the clearance, or click the LOV & button and select a zone group.

Zone: Enter the ID of the zone to add to the clearance, or click the LOV El button
and select a zone.

Location: Enter the ID of the location to add to the clearance, or click the LOV
button and select a location.

2. Click Select. Locations that meet your criteria are added to the table in the Location
Selection area.
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Select Items

1. In the Clearance Maintenance pane, in the Item Selection area, select items on the
clearance using the available fields.

~ Item Selection

B
B
Itemn Type  [ltern =
Itemn Level |
8
8
Item Selection |

Level | Uil Diff ID | Description

Item selection area of Clearance Maintenance pane

Note: All fields with LOV El buttons allow multiple items to
be selected.

= To select items from all available items, enter an ID in the Item field, or click the
LOV E button and select item.

a. Enter information in the enabled fields to limit the items available in the Item
field.

— In the Department field, enter a department number, or click the LOV
button and select a department.

— In the Class field, enter a class number, or click the LOV &l button and select
a class.

— In the Subclass field, enter a subclass number, or click the LOV &1 button and
select a subclass.

— Inthe Item Type drop-down, select Item or Item List.

Note: If you select Item List from the Item Type drop-down,
only item lists will be selectable from the Item field. If you
select Item, only single items that conform to the other
criteria specified will be selectable.

— In the Item Level drop-down, select Parent Item, Parent Item/Diff, or
Transaction Level Item.

Note: The Diff Type and Diff fields are only enabled if
Parent Item/Diff is selected.

— In the Diff Type drop-down, select a diff type.
— In the Diff drop-down, select a diff.

b. In the Item field, click the LOV &l button and select items.
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2. Click Select. Items that meet your criteria are added to the table in the Item Selection

area.

Complete the Clearance

1. Click Apply to add any changes.
2. Change the status of your clearance as appropriate.
3. Click Done to save any changes and close the workspace.

Create a Vendor Funded Clearance

Navigate: From the Task Pad, select Clearances > Create Clearance. The Create Clearance

workspace opens.

%5 create Clearance
al
I@ Clearance List | —I
tlearance Wiew |Standard Column view|[¥] || g%
d Ttem Item Descrip§ Item Level | Diff Id Diff Id Descrif Location Location Desqd Location Typd Primary Zone | Exception In
[ Fitier by | ¥ ||| Fitver by [ ¥ ||| Fiteer b [ ¥ ||| Fiter o [ ¥ || Fiter o [ ¥ || Fiter e [ ¥ || Fiter e [ ¥ | Fiter e [ 7| [ Fiter e [ 7] [ iter o | ]| Fiter 2]
4 »
|
= P
(@ tlearance Maintenance |
Type -éw Regular Price Guide l:l %
(0) vendar Funded *Rezzan Code |:| 8
¥ Effective Date l:l
Change Type [arnaurt off =] out Of Stack Date l:l
Change Amaunt | | - =
Apply Subclass Defaults ]
* Location Selection
[

Zone @roup =]

Create Clearance workspace

1. Inthe Clearance Maintenance pane, in the Type field, select Vendor Funded.
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Create a Vendor Funded Clearance

((=1 Clearance Maintenance
[E

Type (@) Regular Prica Guide l:l
() vendar Funded * Reason Code |:| =
¥ Effective Date l:IE
Change Type s cunt off Out O Stock Date l:IEI
Change Amaount | ‘ Reset Date l:l@

Apply Subclass Defaults  [7]

* Location Selection

Location Selection " &;
Level | d Description ‘ Location Type |

* Item Selaction

Itemn Type  [Item

]

Itern Level |Transaction Level Itern

Clearance Maintenance pane
2. In the Effective Date field, enter the date the clearance is enabled, or click the
calendar [ button and select a date.

Note: The Effective Date you can set depends on the number
of days set in the system option Price Change Processing
Days. The earliest date clearances can be created is today’s
date plus the price change processing days, unless you have
emergency privileges.

3. In the Price Guide field, enter the ID of the price guide you want to apply to the
clearance, or click the LOV &l button and select a price guide.

Note: The price guide only applies to the items in the same
department as the price guide and locations that share the
same currency as the currency on the price guide.

4. In the Reason Code field, enter the ID of the reason you are creating the clearance, or
click the LOV & button and select a reason code.

5. In the Out of Stock Date field, enter the date you expect the inventory to be
consumed, or click the calendar E button and select a date.

Note: Depending on your system settings the date may
default.
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6. In the Reset Date field, enter the date the price of the item returns to regular price, or
click the calendar B button and select a date.

Note: Depending on your system settings the date may
default.

7. Select Apply Subclass Defaults to attach a Clearance Defaults Pricing Strategy to the
clearance.

Select the Vendor and Deal

1. In the Clearance Maintenance pane, in the Partner Type drop-down, select the
partner type.

=  Manufacturer
=  Distributor
= Wholesaler
= Supplier
2. Inthe Partner field, enter the ID of the partner with the deal, or click the LOV
button and select a partner.

3. Inthe Deal ID field, enter the ID of the deal, or click the LOV El button and select a
deal.

4. In the Deal Detail ID field, enter the ID of the deal details, or click the LOV &1 button
and select the deal details.

Select Locations

1. In the location area of the Clearance Maintenance pane, in the Location field, enter a
location ID, or click the LOV &t button and select locations.

Note: Only locations on the deal are selectable.

2. Click Select. Locations are added to the table in the Location Selection table.

Enter Funding Information

1. In the Clearance Maintenance pane, in the Funding Type drop-down, select Percent
or Amount.

Note: If the selected locations have different currencies, only
Percent is available.

2. Inthe Funding Amount field, enter an amount.

Select Items

1. In the Item Selection area of the Clearance Maintenance pane, in the Item field, enter
an item ID, or click the LOV El* button and select items.

Note: Only items on the deal are selectable.

2. Click Select. The items appear in the Item Selection table.
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Complete the Clearance
1. Click Apply to add any changes.

2. Change the status of your clearance as appropriate.

3. C(lick Done to save any changes and close the workspace.

Change the Status of a Clearance

Navigate: From the Task Pad, select Clearances > Maintain Clearances. The Maintain
Clearances workspace opens.

%5 Maintain Clearances

(@ uearance search

Reguer [
Effective Date | ‘ To | | Status [ select - [x]
Approved By | | Created By ‘ ‘

| ] a8

0 e E—
Itern Type  [tem =] [] search on This Level Only
Itemn Level [ sesrch on This Level Only

Market Basket Code l:l%*

Ttern | ‘%+

]

| [ | [sawen ||

Maintain

Clearances workspace

1. Search for and retrieve the clearance you want to maintain. Your results appear in
the Clearance List pane.

(& Clamvance [
e
v [romm [wimm Descried Toem tovat | orFera [oere va paser
oreer 2y Il|[oveer v [l Foveer 25 Il|[oveer 2 [d|[ Foveer 25 Il [ veer 2r =]

Se1

100022004 |arisl sl=eps.. [Parent Item

Saz

100000016 [TestItam 1. [Tr

1000000014

Sa1

100000016 [TestItam 1. [Tr

1000000014

“ [ »
= 12345 [klEr]l Goto page L Jers =
—
| o= T — |
Clearance List pane

Note: If you are in the Create Clearance workspace, your
clearances appear in the Price Change List container when
you click Apply. You do not need to open the Maintain Price

Change workspace.
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2. Select the price change for which you want to change the status.
= In the table, select a row.
=  Click Select All. All records in the Clearance List pane are selected.
In the Action field, select the status to which you want to move the clearance.
Click Update. You are prompted to confirm your decision.
Click Yes. If the system option, background conflict check, is off and conflicts exist,
the Conflict Review List window is displayed.

Conflict Review List

Conflict Review List

Promotion Componen| Item Location Change Type

Fixed Price

| £
B gs | 3410 12 004§

ran 3 13 4 % EACH

Conflict review list window

Note: See View conflict check results for more information
on background conflict checking. When background conflict

check is on, a binocular G icon appears in the conflict
column when conflict checking is complete. Click the icon to
open the Conflict Review List workspace.

a. The current clearance opens in the upper half of the window. Price changes,
promotions, and clearances affecting the same item/location appear in the lower
half of the window.

b. Click Close to close the conflict review list. The Maintain a clearance procedure
contains additional information on how to adjust a clearance.

6. Click Done to save any changes and close the window.
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Maintain a Clearance

Navigate: From the Task Pad, select Clearances > Maintain Clearances. The Maintain
Clearances workspace opens.

%5 Maintain Clearances

(@ uearance search

Type

Frovw  [o]

Effective Date |

5]

TDl

Approved By |

Approved Date |

||

TD|

Resson Code

L B

Status
Crested By
Create Date

Price Guide

aQut Of Stock Date

Reset Date

=

Deal ID B
Dezl Detail ID B

Departrment ‘%.,.

Class B

Subclass B

Ttern Type |1tgm E‘
Itern Level [J5earch on This Levsl only
Diff Type | selact -

Ttern | ‘%+

Ciff B

Foaes o0
\ |
L m -~ @
L 1

H+
— R —
—

L —
B
L &

[] search on This Level Only

Zone

Location

|

Maintain Clearances workspace
Search for and retrieve the clearance you want to maintain. Your results appear in

1.

the Clearance List pane.

(B dlearance st |
Clearance view [Markup Columnn view [¥]| &
d Item Item Descrip Item Level Diff 1d Diff Id Descri] Location Location Desqd Location Typd PHmary Zone| Exception Ind Parg
Fitver by | ||| Fier y | w ||| Fitter sy {w ||| Fitrer by [ 2| Fitver o [ ||| Fitter 0 [ ||| Fitcer 2y [ > ||| Fitter sy {w || itrer o [w||[ Fitcer o {2 ||| Fitter 2y [ ][ £t
561(100022004 |Ariel sleepe,, [Parent Ttem 11 Test Clizon., [Zane
542(100000016 [Test Item L., [Transaction .. 1000000014 [Baltimors  |Store
541(100000016 [Test Item 1., [Transaction .. 1000000014 [Baltimore  |Store
524100025213 [MM Fashion ..[Tranzaction .. 1000000001 [Minneapalis Store
4 [ 3
S [@[d123450]py] Gotopage [1 |af7 =
Status [approved sction [ selaet- [T Canflict Check
| [ Calate |1 Haw I Capy [[ LocException ][ Tran Excaption ||

Clearance List pane
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2. From the list of results, select the clearance you want to maintain. The clearance
details appear in the Clearance Maintenance pane.

(@ tlearance Maintenance |

]
Qut of Stock Date l:l
Reset Date 10/02/ 2008
Apply Subdass Defsults [
Location Selection Il ¢
Level ‘ 1d ‘ Description | Location Type
Stare |1000000020 |Or|ando |Stare
Item Selection Il ¢
Level ‘ 1d ‘ Diff 1d | Description
Item |9999E| | |F‘L Regular Item 99990

| oo ||
Clearance Maintenance pane

3. If necessary, change the status of the price change to Worksheet.

4. Edit the enabled fields as necessary.

Note: You cannot change the items and locations on a
clearance.

5. Click Apply to add all any changes.

6. Click Done to save any changes and close the window.
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Copy a Clearance
1. From the list of results, select the clearance you want to copy.

2. Click Copy. The clearance details appear in the Clearance Maintenance pane.

(@ tlearance Maintenance |

]
Qut of Stock Date l:l
Reset Date 10/ 022008
Apply Subdass Defsults [
Location Selection Il ¢
Level ‘ 1d ‘ Description | Location Type
Stare |1000000020 |Or|ando |Stare
Item Selection Il ¢
Level ‘ 1d ‘ Diff 1d | Description
Item |9999E| | |F‘L Regular Item 99990

| o |
Clearance Maintenance pane

3. Edit the enabled fields as necessary.
4. Click Apply to add all any changes.

5. Click Done to save any changes and close the window.

Delete a Clearance
1. From the list of results, select the clearance you want to delete.

2. Click Delete. You are prompted to confirm your decision.

Note: Only clearances in Deleted status can be deleted.

3. (Click Yes. The clearance is deleted.

4. Click Done to close the window.
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Check for Conflicting Clearance

1. From the list of results, select the clearance you want to check.

2. Click Conflict Check. If the system option, background conflict check, is on and
conflicts exist, the Conflict Review List window is displayed.

Conflict Review List

Conflict Review List

Promotion Componen| Item Location Change Type

Fixed Price

410 EACH

| #
P ge 3410 1: 4 £

46 12-1 004 FS. 06 EACH

Conflict review list window
= If no conflicts exist, click OK.
= If conflicts exist, you must adjust the details of your clearance before you can
move the clearance to the next status.

Note: See View conflict check results for more information
on background conflict checking.

3. (lick Done to save any changes and close the window.
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Create a Location Exception

Note: Location exceptions can only be created for Zone Level
clearances.

1. From the list of results, select the clearance.

2. Click Location Exceptions. The locations selection area of the Clearance Maintenance
pane is enabled.

I’(: clearance Maintenance

Sut of Stock Date l:“a
Reset Date 1070z zoos |[E

Apply Subdass Defaults  []

Location Selection |

Level ‘ 1d ‘ Description | Location Type |

Stare |1000000020 |Or|ando |Stm’e

Itern Selection | <

Level ‘ 1d ‘ Diff Id | Description |

Item |99990 | |PL Regular Item 93990

| o]

Clearance Maintenance pane

3. Inthe Location field, enter the ID of the location where items are different than the
zone on the clearance, or click the LOV =l button and select a location.

4. In the enabled clearance fields, enter information about the clearance for the
item/location.

Click Apply to add any changes.
Click Done to save any changes and close the window.
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Create Item Exceptions at the Transaction Level

Note: Item exceptions at the transaction level can occur only
when the clearance was created at the item parent or item
parent/ diff level.

1. From the list of results, select the clearance.

2. (Click Tran Exceptions. The item selection area of the Clearance Maintenance pane is
enabled.

I’(J Clearance Maintenance |

[N ]

Out Of Stack Date l:l@

Apply Subdass Defaults [

Location Selection I <2

Level D | Description [ Location Type [

Stare |1nﬂnnnﬂn20 |Or|ando |Stm’e

Item Selection |

Level ‘ 1d ‘ Diff 1d | D |

Irem |99990 | |PL Regular Item 99990

| Caeets |
Clearance Maintenance pane

3. In the Item field, enter the ID of the item for which items are different than the parent
]
item on the clearance, or click the LOV &l button and select an item.

4. In the enabled clearance fields, enter information about the clearance for the
item/location.

Click Apply to add any changes.

6. Click Done to save any changes and close the window.
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Promotions

Promotions

A promotion is a temporary reduction in price. In addition, you can track sales at one or
more locations for a given time period as well as track the sales of merchandise with no
price reductions, at given locations for a set time period.

Updates can be made to the details of an existing promotion and promotion components
can be added to an existing promotion.

Promotion Components

= Simple Component - A simple promotion component consists of an item, item
group, or merchandise level that receives a discount at a specific location or group of
locations when the customer purchases an item.

= Threshold Component - A threshold promotion component consists of an item, item
group, or merchandise level that receives a discount at a location or group of
locations when the customer purchases a quantity or a amount of an item. You must
define the threshold levels before you can create the threshold component.

* Buy/Get Component - A buy/get promotion component consists of an item, item
group, or merchandise level allows you to define which items must purchased by the
customer in order to receive a discount for an additional item.

Changes can be made to the details of a promotion component, and new details can be
added to promotion components.

In the Promotion Component Detail Maintenance pane, records that contain
item/location exceptions or exclusions are indicated by a down arrow. Records that are
item/location exceptions or exclusions are indicated by an up arrow.

Existing promotion components can be copied into a new promotion.

Add Funding Information to a Promotion

Funding is added to a promotion at the component level so that you can indicate the
vendor that is contributing to the promotion. If you choose to create deals, based on the
funded component, you must indicate the billing information for the deal. If the
promotion is associated with an existing deal, the billing information defaults from the
existing deal.

Promotion Event

A promotion event is a method of grouping promotions that occur during a period of
time. Each event can be associated with many promotions, but a promotion can only be
associated with one event.

Updates can be made to the details of existing promotion events.

Threshold Definition

A threshold is a discount that a customer receives for purchasing a pre-determined
amount of an item. You must define the levels that exist in the threshold, then associate
the threshold definition to the threshold component.
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Vendor Funding Defaults

When an item is on promotion at a retailer, part of the discount a customer receives may
be contributed by the vendor. When you set up a promotion, you can define the vendor's
contribution.

You can create billing information defaults at the vendor level, which allows you to
apply the information to any deal that is created through the promotions dialog that is
associated with the vendor

Promotion Constraint

The Maintain Promotion Constraint workspace allows you to maintain promotion
constraints. You set up promotion constraints at the department, class, or subclass level
for a particular zone or location. A warning will appear if a price change or promotion is
created that would fall a certain number of days before or during another approved
promotion or price change. The number of days before the promotion is the promotion
constraint.

Create a Promotion

Navigate: From the Task Pad, select Promotion > Create Promotion. The Create
Promotion workspace opens.

OR

From the Maintain Promotion Events workspace, click New Promotion. The Create
Promotion workspace opens.
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%5 Create Promotion

I@ Promotion Header
Description | | =) End Date l:l
E—
8
Feferenced Deals | Referenced Deals: Mone [ secondary apalication of Discounts
I/(J Promotion Components |
I &
Component Id 3 | Component Name Type Status Secondary Application Conflicts |
Add Component || Create fram Existing
Corlicts Marage Oueraps carcel || save + Repest || Done |

Create Promotion workspace

1.

ok 0N

In the field to the left of the Promotion field, enter the name of the promotion.
In the Description field, enter additional information as necessary.

In the Start Date field, enter the day the promotion begins.

In the End Date field, enter the day the promotion stops.

In the Event field, enter the ID of the event you want to associate with the promotion,
or click the LOV button and select an event.

Update the Currency field as necessary.
Select Secondary Application of Discounts as necessary.

In the Valid Department field, enter the departments for the promotion, or click the
LOV button and select the departments.
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Associate a Deal to a Promotion

1. Click Referenced Deals. The Referenced Deals window opens

Referenced Deals

Available Deals

Deal ID Deal Type Yendor Hame | Status Active Date Close Date Currency |

g0z Promotional *Mamo Dry S...| Approved 08-31-2001 | 08-31-2008 | eurn — |

Q8032 Prornotional WISE POTA.., | Approved 0g-21-2001 0g-21-2002 UG

Q804 Prormotional LIGQUOR MA.., | Approved 0g8-31-2001 0g8-31-2008 Ut

Q805 Promational LIQUOR MA.., | Approved 0%-31-2001 08-31-2008 | euro

Q207 Promational *Marno Dry 5. Approved 0g-23-2001 08-228-2008 | euro

QE09 Promotional *Marmo Dry .. Approved 0g-22-2001 05-27-2008 | euro

2211 Promotional *Mamo Dry .. Approved 08-29-2001 | 08-22-2008 | US Collar

2815 Promotional *Mamo Dry S...| Approved 08-29-2001 | 08-21-2007 | US Dollar

Q216 Promotional FAST FOOD .| Approved 0g-21-2001 0g-31-z002 UKD

981 Proratianal I T ISR S Annroued O8-31-27101 a8-31-2008 115 Diallar vI

il [

Linked Deals

Deal ID Deal Type Yendor Name | Status | Active Date Close Date Currency |
Al
=]

Cancel || Select |

Referenced Deals window

2. Select the deals you want to add to the promotion.
3. Click Select. The window closes.
4. Click Done to save any changes and close the workspace.
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Promotion

Add Components to a Promotion

1.
workspace opens.

In the Promotion Components pane, click Add Component. The Create Component

%9 create Component

(@ Promation tompanent

* Promotion

I =
fimpte [

scription

* Companent Type

Create Component workspace

2. Add the appropriate type of component to the promotion to:

Create a simple component

Create a threshold component

Create a buy/get component

Add a Component from an Existing Component

1. Click Create from Existing. The Copy Promotion Component window opens.

.
= Copy Promotion Component

¥ Brarmation

Start Date

03/ 26fz001 End Date  |gzfzofzool |6

Copy Promotion Component

2. In the Promotion field, enter the ID the component is associated with, or click

LOV E button and select the promotion.

LOV E button and select the promotion.
Update the Start and End Date fields as necessary.
Click Copy. The component is added to the Promotion Component table.

Promoti

the

In the Component field, enter the ID of the component you want to copy, or click the
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Search for a Promotion

Navigate: From the Task Pad, select Promotions > Maintain Promotion. The Promotions
Search workspace opens.

%5 promotions Search

I@ Promotion Search Criteria

Rrarnation | Event |:| 8
Stark Date: After l:l Before l:l

End Date: After l:l Before l:l
Item | |8 |

k Location

» Advanced Search

|
I@ Promotion Search Results |

Promotions Search workspace
1. Expand the Promotion Search Criteria pane.
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(@ Promotion Search Criteria

Start Date: After l:l Befare l:l
End Data: Aftar l:l Before I:I
Ttern | [=]] |

* Location

R E— e —
o —
e R—

Diff 1D B Departmant I:I B+
Division l:l g Class B-
Group I:l g Subelass 8-
vendor Funding [ gelect 7] Deal ID I:I S|

[Refesh |[searen ]|

Promotion Search Criteria pane
2. Enter or select the criteria to limit your search.

3. C(lick Search. Promotions that match these criteria appear in the Promotion Search
Results pane.
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Maintain a Promotion

Navigate: From the Task Pad, select Promotions > Maintain Promotion. The Promotions
Search workspace opens.

%5 promotions Search

I@ Promotion Search Criteria

Rrarnation | Event |:| 8
Stark Date: After l:l Before l:l

End Date: After l:l Before l:l
Item | |8 |

k Location

» Advanced Search

|
I@ Promotion Search Results |

Promotions Search workspace

1. Search for a promotion.

2. In the Promotion Search Results pane, select the promotion you want to edit.
3. (lick Edit. The Maintain Promotion workspace opens.
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(@ Promotion Header

¥ Prometion ‘742 | it ‘summer tows | Comments £ * Start Date |11f15f2c|c|1 |a‘12:uu A |

Description [rey promo | 57 End Date [tirzorza01 | (1200 am |

Event | | B ‘ | Status |Appmugd * |
* Currency |,_|5D | B ‘us Lollar | Total Markup % |N;A |

Feferenced Deal: | Refersnced Deals: None

*valid Departments [10025200,3456 1] B+ [Multiple values

[ 5econdary Application of Discounts

Component Id

@ Promotion Components
| &,
Component Id (}) Component Name Type Status Secondary Application Conflicts
2043 ETS threshold copy Threshold WWarksheet O
541 buy getfunded Buy/Get Warksheet |
a1 buy getfunded Buy/Get Approved O
222 Apprud buy get Buy/Geat approved ]
[ conflict check | [ _Add comporent | [ create from Existing | [ Delete Component | [ Edit

Compenent Hame

Type

Status

Action [ salect - |

Secondary Applicatio

n of Discounts |

Maintain Promotion workspace
4. In the Promotion Header pane, edit the enabled fields as necessary.

Update

5. Click Done to save any changes and close the workspace.
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Check for Conflicts

1. From the Promotion Components pane, select the promotion component you want to
check.

I@ Promotion Components |

I ]

Component ID 3] Component Name Type Status Secondary Application Conflicts
2083 Defect 941 buyfget BuyfGet Warksheet O
3087 Crefect 941 threshald Threshald Warksheet O

Gonflict check | [_Add compenent ][ _Delete component | [_Edit |
Cormponent I 2082
Ceomponent Mamea Defect 941 simple
Type Sirmple
Status Warksheat Action n

Secondary Application of Discaunts

Update

Promotion Components pane

2. Click Conflict Check. If the system option, background conflict check, is off and
conflicts exist, the Conflict Review List window is displayed.

Conflict Review List " &
I Promotion Componen| Ttem Location Change Type Change Amount Effective Date
Price Change Tyj ID Promotion Comp Date Unit Retail on E4 Selling UOM Multi Units Multi-Unit Retai| Mult-Unit Selli
Price Change 3221 12-04-2004 $26.84 EACH

Price Change 3242 12-01-2005 $35.22 EACH

Conflict review list window
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Note: See View conflict check results for more information
on background conflict checking. When background conflict

check is on, a binocular iE icon appears in the conflict
column when conflict checking is complete. Click the icon to
open the Conflict Review List workspace.

= Jf no conflicts exist, click OK.

= If conflicts exist, you must adjust the details of your promotion before you can
move the promotion to the next status.

3. C(lick Done to save any changes and close the window.

Add a Component
1. Click Add Component. The Create Component workspace opens.

%9 create Component

(& Promotion component

*component Tupe  [Simpls 7]

cancel || save || save +Repeat || Done

Create Component workspace

2. Add the appropriate type of component to the promotion to:
= Create a simple component
=  Create a threshold component

= Create a buy/get component

Add a Component from an Existing Component

1. Click Create from Existing. The Copy Promotion Component window opens.

.
= Copy Promotion Component

Start Date 03/z6fz001 |[E] End Date  |p3zfzofzooy |[E

Copy Promotion Component
2. In the Promotion field, enter the ID the component is associated with, or click the
LOV E button and select the promotion.

3. Inthe Component field, enter the ID of the component you want to copy, or click the
LOV E button and select the promotion.

4. Update the Start and End Date fields as necessary.
Click Copy. The component is added to the Promotion Component table.
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Associate a Deal to a Promotion
1. In the Promotion Search Results pane, select the promotion you want to edit.

2. Click Edit. The Maintain Promotion workspace opens.

B3 Maintain Promotion

(@ Promotion Header

* Promotion 742
Description
Event

* currancy

uso

¥ summer toys

toy prome

B Us collar
Fefarencad Deal: | Refersnced Deals: None
*
Valid Departments |1002)200;2456 1| B+ |Multiple values

Comments @

* Start Date 11/15/z001 || 1200 Am
) End Date 11/2972001 | [12:100 AmM
Status #pproved *

Total Markup % [l

Secondary Application of Discounts

I@ Promotion Components

I &
Component Id (}) Component Name Type Status Secondary Application Conflicts
2043 ETS threshold copy Threshold WWarksheet O
541 buy getfunded Buy/Get Warksheet |
a1 buy getfunded Buy/Get Approved O
222 Apprud buy get Buy/Geat approved ]
conflict check | [_add component ] [ create from Existing | [ Delete component |[_Edit

Component Id

Component Name

Type

Status Action [~ gelect - |Z|

Secondary Application of Discounts

| cenflicts || Mansge verlaps |[_cancel |[_Cene

Maintain Promotion workspace
3. Click Referenced Deals. The Referenced Deals window opens
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Referenced Deals

Available Deals

Deal ID Deal Type Yendor Name | Status Active Date Close Date Currency |

as0z Promotional *Mamo Dry 5. Approved 08-31-2001 | 08-31-2008 | eurn — |

803 Promotional WISE POTA.., | Approved 0g-21-2001 0g-21-z002 UKD

Q804 Prornotional LIGQUOR MA.., | Approved og-21-2001 0g-21-2002 EUFD

Q805 Prornotional LIGUOR MA.., | Approved 0g8-31-2001 0g8-31-2008 EUFa

Q807 Promational *Marno Dry S..| &pproved 0%-23-2001 058-28-2008 | euro

Q209 Promational *Marno Dry 5. Approved 0g-23-2001 08-27-2008 | auro

2211 Promotional *Marmo Dry .. Approved 08-29-2001 | 08-22-2008 | US Daollar

2215 Promotional *Mamo Dry .. Approved 08-29-2001 | 08-31-2007 | US Collar

RSN Promotional FAST FOOD .| Approved 0%-21-2001 05-21-2008 | euro

981 Promntional I TSR S Annrouesd O8-31-2001 A8-31=-200 115 Dinllar TI

il [

Linked Deals

Deal ID Deal Type Yendor Name | Status | Active Date Close Date Currency |
B
=]

Cancel || Salact |

Referenced Deals window

4. Select the deals you want to add to the promotion.

5.
6.

Click Select. The window closes.

Click Done to save any changes and close the workspace.

Promotions 197



Add a department to a promotion

Add a department to a promotion

Use this procedure to add departments to a promotion after the promotion has been
created.

Navigate: From the Task Pad, select Promotions > Add Department to a Promotion. The
Add Department to Promotion workspace opens.

%5 add Department to Promotion

I'/C; Promotion Search Criteria

Promatian | Event |:| 8

Currency l:l 8 Status |:| SH
¥ Start Date: After l:l ¥ Before l:l

End Date: After l:l Before l:l

Itamn | I=]

b Location

b Advanced Search

__Clear __Search |
I-/(_ﬂ Promotion Search Results |
I-/(_ﬂ Add Department |

Add Department to Promotion workspace
1. Enter or select the criteria to limit your search.

Note: You must enter a Start Date range.

2. Click Search. Promotions that match these criteria appear in the Promotion Search
Results pane. The Add Department pane opens.

I/CJ Add Department |
8

Add Department pane

3. Select the promotion to add departments to.

4. In the Department field, enter the Department number or click B+ (LOV) and select
from the list of values.

Click Add.

Click Done. The workspace closes, and the departments are added to the promotion.
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Promotion Components

Create a Simple Component

Navigate: From the Task Pad, select Promotions > Create Component. The Create
Component workspace opens.

OR

From the Create Promotion workspace, click Add Component in the Promotion
Components pane. The Create Component workspace opens.

%3 create Component

‘(—“ Promotion Component

* Desari ption
* component Type  Eimplz 7]

cancel || save |[ ssve +Repest |[ Dons

Create Component workspace

1. In the Promotion field, enter the ID the promotion is associated with, or click the
LOV El button and select the promotion.

2. Inthe Description field, enter a description of the component.
In the Component Type field, select Simple.

Click Next. The Promotion Component - Simple pane opens.
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I@ Promotion Component - Simple

8
|
8
¥ Item Selection
Item Selection " d
Level 1] Diff ID | Description |
» Location Selection
Location Selection " &
Level 1 Description | Location Type |
* Change Type e [
8
* Start Date & Time |01.-'01.-'2006 ||12:00 AM |
End Date & Time |12.-'31.-‘2006 ||11:59 P |
* apply To T
Price Guide | | %

| | Apply & Repeat ||

Apply | | Clear | |

Promotion Component - Simple pane

Add Items and Locations to a Promotion Component

1. Inthe Item Selection area, enter the criteria you want to use to select the items on
promotion, or click the LOV B button and select the criteria.
Click Select. The items are added to the Item Selection table.

3. In the Location Selection area, select how you want to add locations to the
promotion, or click the LOV B button and select the criteria.
4. Click Select. The locations are added to the Location Selection table.
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10.

11.

In the Change Type field, select the price change that occurs during the promotion:

= Change By Percent: A price for an item is changed by a percentage removed
from the original price. The percent of change is determined by the percent
entered in the Change Amount field.

= Change By Amount: A price for an item is changed by an amount removed from
the original price. The amount of change is determined by the amount entered in
the Change Amount field.

= Fixed Price: The price for the item will be at a specified retail that will be defined
in the change amount field.

* No Change: The price of the item is not changed. For reporting purposes, the
item is recognized as being on promotion.

*  Exclude: The item will not be affected by price changes that occur as a result of
the promotion.

In the Change Amount field, enter the amount, percent, or fixed amount the price
changes.

Note: There is no need to enter a negative sign before the
number entered in the Change Amount field. A promotion
can only exist as a decrease in price.

In the Selling UOM field, enter the unit of measure for the items, or click the LOV
button and select the selling UOM.

Update the Start and End Date & Time fields as necessary.

In the Apply To fields, select the types of item pricing that you want to apply the
promotion.

Click Apply. The promotion opens in the Promotion Component Detail Maintenance
pane.

Click Done to save any changes and close the workspace.
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Add Funding to a Simple Component
1.
2.

Create a simple component

Expand the Funding pane.

"(—‘ Funding

®

orporate Funding Percent

Craste Deals

vendor Typs [suppiier =l

wvendar Se78 E surpLiER-2

Contribution % |1n

Dl billing clear |[_apply |

[E4

¥endor Type | ¥endor ID Contribution % Deal ID Deal Comp ID Use Deal Locations ‘ Use Deal Items

Funding pane for simple components
3.

10.

11.

In the Corporate Funding Percent field, enter the percent that the retailer contributes
to the promotion.

Select the Create Deals check box to create a deal based on this promotion
component and funding.

In the Vendor Type field, select the type of vendor that is funding the component.

In the Vendor field, enter the ID of the vendor, or click the LOV &l button and select
a vendor.

In the Deal ID field, enter the deal the promotion is associated with, or click the LOV
button and select a deal.

In the Deal Comp ID, enter the ID of the deal component field, or click the LOV
button and select a deal component.

Note: The Deal and Deal ID field are disabled if you selected
the Create Deals check box.

In the Contribution % field, enter the percentage that this vendor contributes to the
promotion component.

Select the Use Deal Locations check box to indicate that the locations on the deal
should be used for the promotion.

Select the Use Deal Items check box to indicate that the items on the deal should be
used for the promotion.

Note: The Use Deal Locations and Use Deal Items check
boxes are disabled if the promotion component already has
items or locations.
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12. If you selected the Create Deals check box, add billing information for a deal to a
funded component.

13. Click Apply to add your changes to the table.

14. Click Done to save any changes and close the workspace.

Create a Threshold Component

Navigate: From the Task Pad, select Promotions > Create Component. The Create
Component workspace opens.

OR

From the Create Promotion workspace, click Add Component in the Promotion
Components pane. The Create Component workspace opens.

%9 create Component

“k—“ Promotion Component

* Dascription
* componart Tues irmpls[]

cancel |[_save ][ _save + Repeat |[ pone |

Create Component workspace
1. Inthe Promotion field, enter the ID the promotion is associated with, or click the
]
LOV El button and select the promotion.

In the Description field, enter a description of the component.
In the Component Type field, select Threshold.
Click Next. The Promotion Component - Threshold pane opens.
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(@ Promotion tomponent - Threshold

8
b Item Selection
Item Selection " &
Level I Diff ID | Description |
¥ Location Selection
Location Selection " &
Level I Description | Location Type |
* Thresheld ]
* Start Date & Time |01.-'01.-‘2006 |@ |12:00 Al |
End Date & Time [12731/z006 |E[11:55 pm |
* apply To [selecc-  [7]

Apply & Repeat H Apply || Clear ||

Promotion Component - Threshold pane

Add Items and Locations to a Promotion Component

1.

In the Item Selection area, enter the criteria you want to use to select the items on
promotion, or click the LOV & button and select the criteria.

Click Select. The items are added to the Item Selection table.

In the Location Selection area, select how you want to add locations to the
promotion, or click the LOV & button and select the criteria.

Click Select. The locations are added to the Location Selection table.

In the Threshold field, select the threshold you want to associate with the promotion,
or click New Threshold to create a threshold definition.

Update the Start and End Date & Time fields as necessary.

In the Apply To fields, select the types of item pricing that you want to apply the
promotion.

Click Apply. The promotion opens in the Promotion Component Detail Maintenance
pane.

Click Done to save any changes and close the window.
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Add Funding to a Threshold Component
1. Create a threshold component.

2. Expand the Funding pane.

I"(—‘ Funding

Carporate Funding Percent |10, goo]

= Threshold Uptake 6

I |

Threshold Discount ‘ Selling UOM | uptake % H

$5.00 0% 109%)

$15.00 0%

Uptake %

Create Deals

Wendar Type [Marufactorer =l
Wendar E WISE POTATO ...
L |
L]
Contribution % |w

| 12 ]

¥endor Type ¥endor 1D Contribution % Deal 1D Deal Comp ID Use Deal Locations Use Deal Ttems

Funding pane for a threshold component

3. Inthe Corporate Funding Percent field, enter the percent that the retailer contributes
to the promotion.
Select a threshold.
In the Uptake % field, enter the percentage of customers that you expect to take
advantage of the promotion at this threshold.
Click Apply to add your changes to the table.

7. Select the Create Deals check box to create a deal based on this promotion
component and funding.

8. In the Vendor Type field, select the type of vendor that is funding the component.

9. Inthe Vendor field, enter the ID of the vendor, or click the LOV & button and select
a vendor.

10. In the Deal ID field, enter the deal the promotion is associated with, or click the LOV
button and select a deal.

11. In the Deal Comp ID, enter the ID of the deal component field, or click the LOV
button and select a deal component.

Note: The Deal and Deal ID field are disabled if you selected
the Create Deals check box.
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12. In the Contribution % field, enter the percentage that this vendor contributes to the
promotion component.

13. Select the Use Deal Locations check box to indicate that the locations on the deal
should be used for the promotion.

14. Select the Use Deal Items check box to indicate that the items on the deal should be
used for the promotion.

Note: The Use Deal Locations and Use Deal Items check
boxes are disabled if the promotion component already has
items or locations.

15. If you selected the Create Deals check box, add billing information for a deal to a
funded component.

16. Click Apply to add your changes to the table.

17. Click Done to save any changes and close the workspace.

Create a Buy/Get Component

Navigate: From the Task Pad, select Promotions > Create Component. The Create
Component workspace opens.

OR

From the Create Promotion workspace, click Add Component in the Promotion
Components pane. The Create Component workspace opens.

%3 create Component

‘-"(2 Promotion Component

* Gomponert Type  Firmpiz [}

ncel|[_save |[_ssve tRepest ][ _Dons

el
i

Create Component workspace
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1. In the Promotion field, enter the ID the promotion is associated with, or click the
LOV B button and select the promotion.

2. In the Description field, enter a description of the component.
3. In the Component Type field, select Buy/Get.
4. Click Next. The Promotion Component - Buy Get pane opens.
I@ Promotion Component - Buy Get
|
a8
Buy Item Get Item
Type Al * change Type n
® any
* Start Date & Time |01.-'01.-'2006 ||12:00 AM |
End Date & Time |12.-'31.-'2006 ||11:59 P |
¥ Item Selection
|
8
Ttern Type [tt=rn =]
Itern Level 'Transaction Level Itern lzl
—
8
Buy Items " & Get Items " &
Ttem | Description | Item Description |

¥ Location Selection

Promotion Component - Buy Get pane
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Define the Buy/Get Terms
1. In the Buy Item area, select how the items on the list of buy items must be purchased.
= AlL All the items on the Buy Items list must be purchased in order to receive the
discount
* Any: Any of the items on the Buy Items list must be purchase in order to receive
the discount.

2. In the Quantity field, enter the number of items that need to be purchased in order to
receive the discount.

3. Inthe Get Item area, select the type of discount received when the qualifying items
and quantity is purchased.

= Percent Off: A price for an item is changed by a percentage removed from the
original price. The percent of change is determined by the percent entered in the
Change Amount field.

= Amount Off: A price for an item is changed by an amount removed from the
original price. The amount of change is determined by the amount entered in the
Change Amount field.

=  Fixed Price: The price for the item will be at a specified retail that will be defined
in the change amount field.
4. In the Selling UOM field, enter the unit of measure for the items, or click the LOV
button and select the selling UOM.

5. In the Change Amount field, enter the amount, percent, or fixed amount the price
changes.

Note: There is no need to enter a negative sign before the
number entered in the Change Amount field. A promotion
can only exist as a decrease in price.

6. Update the Start and End Date & Time fields as necessary.

Add Items and Locations to a Promotion Component

Note: You may have to expand the Item Selection and
Location Selection area to view the criteria

1. In the Item Selection area, enter the criteria you want to use to select the items on
[—]
promotion, or click the LOV [l button and select the criteria.
2. Add the items to the Buy Items or Get Items table.

= (lick Add to Buy Items to add items to the list of items that qualify the
purchaser for the discount.

= (lick Add to Get Items to add items to the list of items that receive the discount.

Note: Depending on the system setting for Allow Buy/Get
Cycles you may be prohibited from entering the same item
in the buy and get lists. If cycles are permitted, then multiple
identical items may be added to both the buy and get lists.
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In the Location Selection area, select how you want to add locations to the
promotion, or click the LOV &l button and select the criteria.

Click Select. The locations are added to the Location Selection table.

In the Apply To field, select the types of item pricing that you want to apply the
promotion.

Click Apply. The promotion opens in the Promotion Component Detail Maintenance
pane.

Click Done to save any changes and close the window.

Add Funding to a Buy/Get Component

1.
2.

Create a buy/get component.

Expand the Funding pane.

(= Funding

Corparats Funding Percent

Uptake %
Create Deals
Wandor Type [Manufacturar =
vendar 333009853 WISE POTATO v,
Contribution % ‘1.]
Deal Billing clear |[Capply |

I

¥endor Type ¥endor ID Contribution % Deal 1D Deal Comp 1D ‘ Use Deal Locations

Funding pane - Buy/Get component

3.

In the Corporate Funding Percent field, enter the percent that the retailer contributes
to the promotion.

In the Uptake % field, enter the percentage of customers that you expect to take
advantage of the promotion at this threshold.

Select the Create Deals check box to create a deal based on this promotion
component and funding.

In the Vendor Type field, select the type of vendor that is funding the component.

In the Vendor field, enter the ID of the vendor, or click the LOV &l button and select
a vendor.

In the Deal ID field, enter the deal the promotion is associated with, or click the LOV
button and select a deal.

In the Deal Comp ID, enter the ID of the deal component field, or click the LOV
button and select a deal component.

Note: The Deal and Deal ID field are disabled if you selected
the Create Deals check box.
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10. In the Contribution % field, enter the percentage that this vendor contributes to the
promotion component.

11.

12.

13.
14.

Select the Use Deal Locations check box to indicate that the locations on the deal
should be used for the promotion.

Note: The Use Deal Locations check boxes are disabled if the
promotion component already has locations.

If you selected the Create Deals check box, add billing information for a deal to a
funded component.

Click Apply to add your changes to the table.

Click Done to save any changes and close the workspace.

Add Billing Information for a Deal to a Funded Component

1.
2.

3.

Click Deal Billing. The Deal Billing window opens.

Select the information about the deal that you require:

Deal Reporting Level: The frequency that the deal is reported.

Bill Back Method: The type of invoice that is created for the supplier. Select the
appropriate option.

Bill Back Period:The frequency that the vendor is charged for the bill back.
Select when to charge the vendor.

Invoice Processing Logic:The method used to create invoices. Invoices are
created automatically, manually, or not at all depending on the option selected.
Include VAT in Deal Billing: Select the check box to indicate that VAT should
be included in the invoice information.

Include Deal Income in Stock Ledger: Select the check box to indicate that deal
income accrual should be written to the stock ledger.

Click Done to save any changes and close the window.

Maintain a Promotion Component

Navigate: From the Task Pad, select Promotion > Maintain Component. The Maintain
Component workspace opens.

3 Maintain Component

®

in Promotion Component

B

Cancel || Save || Done

Maintain Promotion Component workspace
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In the Promotion field, enter the ID of the promotion that the component is
associated with, or click the LOV &l button and select a promotion.

In the Component field, enter the ID of the component you want to maintain, or click
the LOV El button and select a component.

Click Next. Additional component maintenance panes are displayed.

Note: Collapse and expand areas and panes to view the
information needed to complete the task.

Maintain Component Details

1.

w

N o o &

In the Promotion Component Detail Maintenance pane, edit the name of the
component as necessary.

Enter the consignment rate used for the item while it is on promotion, if necessary.

To edit a specific record, select a record, or click Select All to make changes to all
records on the table.

Click Edit.
Edit the enabled fields as necessary.
Click Apply.

Click Done to save any changes and close the workspace.

Delete Component Details

1.

a r DN

In the Promotion Component Detail Maintenance pane, select the record you want to
delete:

= To edit a specific record, select a record

= (Click Select All to make changes to all records on the table.
Click Delete.

You are prompted to confirm your decision.

Click Yes. The item location is removed from the table.

Click Done to save any changes and close the workspace.

Define Item Exceptions and Exclusions

1.

In the Promotion Component Detail Maintenance pane, select the record for which
you want to create an item exception or exclusion. The Item Exceptions and
Exclusion pane opens.

In the Location field, enter a location ID, or click the LOV &l button and select a
location.

Note: You can only create item exceptions or exclusions for
items above the transaction level.
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5.

Create the exception or exclusion:
= Click Create Exceptions to create an exception to the selected record.
= Click Create Exclusion to create an exclusion.

The pane closes. In the Promotion Component Detail Maintenance pane exceptions
and exclusions are indicated in the Exclusion/Exception Indicator column:

= A down arrow indicates that the item/location records contains an exception or
exclusion.

* An up arrow indicates that the item/location records is an exception or
exclusion.

Click Done to save any changes and close the pane.

Define Location Exceptions and Exclusions

1.

In the Promotion Component Detail Maintenance pane, select the record for which
you want to create a location exception or exclusion. The Location Exceptions and
Exclusion pane opens.

In the Location field, enter a location ID, or click the LOV &l button and select a
location.

Note: You can only create location exceptions or exclusions
for locations at the zone level.

Create the exception or exclusion:
= (lick Create Exceptions to create an exception to the selected record.
=  C(lick Create Exclusions to create an exclusion.

The pane closes. In the Promotion Component Detail Maintenance pane exceptions
and exclusions are indicated in the Exclusion/Exception Indicator column:

= A down arrow indicates that the item/location records that contain an exception
or exclusion.

= Anup arrow indicates that the item/location records that is an exception or
exclusion.

Click Done to save any changes and close the pane.
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Promotion Event

Create a Promotion Event

Navigate: From the Task Pad, select Promotion Events > Create/ Maintain Events. The

Maintain Promotion Events workspace is displayed.

B Maintain Promotion Events

‘/(—1 Maintain Promotion Events

Event 1d Event Dascription Theme Start Date & Time End Date & Time

Fall Event | ‘App\e ‘ ‘10114/2004 “12:00 A ‘ ‘10115/2004 “11:59 P ‘
Event 1d Event Description Theme Start Date End Date
67 The Never Ending Event 10-31-2004 10-31-200%
7z RF 21 testing I Don't Know 10-19-2004 10-31-2004
74 Alli Event 11-01-2004 12-01-2005
63 smm prama avant auent 06-02-2005 09-31-2005

EE Starts today Fun 10-01-2004

10-22-2004

Delate New Promction

cancel |[_save +Repeat |[_Done |

Maintain Promotion Events workspace
1. In the Promotion Events section, click New.

In the Event Description field, enter a name for the event you are creating.

2
3. In the Theme field, enter any additional informative information about the event.
4

In the Start Date and Time fields:

a. In the first field, enter the date the event starts, or click the LOV % button and

select a date.
b. In the second field, enter the time the event starts.
5. In the End Date and Time fields:

a. In the first field, enter the date the event ends, or click the LOV % button and

select a date.
b. In the second field, enter the time the event ends.
Click Apply. The promotion event is added to the table.

Click Done to save any changes and close the window.
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Add a Promotion to an Event
1.

In the Maintain Promotion Events pane, click Add Promotion. The Create Promotion
workspace is displayed.

%3 Create Promotion

I@ Promotion Header
e T ] commen=s @ * Start Date [ 1=
Description | | =] End Date |:|
Frere = s workoeet
* Currency uso B [us eallar Total Markup 3% [nra
Referenced Deals: None I:I Secondary Application of Discounts
*valid Departments I:l =5
I@ Promotion Components ‘
(=4
Component Id I Component Name Type Status Secondary Application Conflicts |
Conflict Check | [LAdd componant | [ creats from Existing | [ Dslets componsnt | [_Edit
Campaonant 1d
Camponant Hame
Type
Status Action [~ Salect - =1
Secondary Application of Discounts
e
conflicts, | [ Mansge cusraps I[ cancel |[_Save + Repeat ][ _Done |
Create Promotion workspace

Add the appropriate details to create a promotion.

214 Oracle Retail Price Management



Promotion Event

Maintain a Promotion Event

Navigate: From the Task Pad, select Promotion Events > Create/Maintain Events. The
Maintain Promotion Events workspace opens.

%3 Maintain Promotion Events

((—1 Maintain Promotion Events

Events

Event 1d Event Description Theme Start Date & Time End Date & Time
Fall Event | ‘App\e ‘ ‘10]14/2004 “12:00 A1 ‘ ‘10]15/2004 “11:59 Pr ‘

Event1d Event Description Theme Start Date End Date

&7 The Mever Ending Event 10-31-2004 10-31-2005
73 RF 21 testing I Don't Know 10-19-2004 10-31-2004
74 alli Event 11-01-2004 12-01-2005
6% smm pramo event event 08-02-2005 08-31-2005
66 Starts taday Fun 10-01-2004 10-23-2004

Delete |[_new pramation ||

cancel || save + Repest [[ pons |

Maintain Promotion Events workspace

1.

2
3.
4

Select the event you want to maintain from the table.
In the Promotion Events area, edit the enabled fields as necessary.
Click Apply. Your changes are added to the promotion event and appear on the table

Click Done to save any changes and close the window.

Delete a Promotion Event

1.

2
3.
4

Select the event you want to delete from the table.
Click Delete. You are prompted to confirm your decision.
Click Yes. The record is removed from the table.

Click Done to close the window.
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Threshold D

Create a Thres

efinition

hold Definition

Navigate: From the Task Pad, select Promotion Threshold > Create Threshold. The
Create Threshold workspace opens.

%3 Create Threshold

(@ Threshold create

Threshold Type Discoun t Type

L] L1

selling UoM

*n

ame

*

* Qualification Type | Select -

*Threshold Type | selact -

E1|ET|E]

* Discound t Type [ select -

cancel ][ save + Rapeat || Done

Create Threshold workspace

1.
2.
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In the Name field, enter a description of the threshold you are creating.

In the Currency field, enter the ID of the appropriate currency, or click the LOV
button and select a currency.

In the Qualification Type field, select how the threshold is met:

= Threshold Level: All items on the promotion can be counted together to meet the
terms of the threshold and have the promotion applied.

= Item Level: Each item on the promotion must meet the threshold to have the
discount applied.

In the Threshold Type field, select the measure that indicates how the threshold is
met:

*  Quantity: A number of units of an item must be purchased by the customer from
the retailer.

* Amount: A value of the item must by purchased by the customer from the
retailer.

In the Discount Type field, select the method used to determine the new price of the
item.

= Percent Off: A price for an item is changed by a percentage removed from the
original price. The percent of change is determined by the percent entered in the
Change Amount field.

= Amount Off: A price for an item is changed by an amount removed from the
original price. The amount of change is determined by the amount entered in the
Change Amount field.

=  Fixed Price: The price for the item will be at a specified retail that will be defined
in the change amount field.
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10.

If you choose Fixed Price in the Discount type field, you must enter the Selling UOM
for the item.

In the threshold area on the right, enter the amount or quantity that needs to be
purchased in the Threshold Type field.

In the Discount Type field, enter the percent off, amount off, or fixed price received.
Press Tab to add additional threshold levels.

Click Done to save any changes and close the window.

Vendor Funding Defaults

Create Vendor Funding Defaults

Navigate: From the Task Pad, select Vendor Funding Defaults > Create Defaults. The
Create Defaults workspace opens.

%3 create Defaults

I(:' ¥endor Funding Defaults Creation

*vandar Type - Salactk - lzl

Cancel || Save + Repeat || Lone

Create Defaults workspace

1.

In the Vendor Type field, select the type of vendor that is contributing to the
promotion.

In the Vendor field, enter the ID of the vendor, or click the LOV &l button and select
a vendor.

In the Deal Reporting Level field, select the frequency of deal reporting.

In the Bill Back Method field, select the type of invoice that is created for the supplier.

In the Bill Back Period field, select the frequency that the vendor is charged for the
bill back.

In the Invoice Processing Logic field, select the method used to create invoices.
Invoices are created automatically, manually, or not at all depending on the option
selected.

Select the Include VAT in Deal Billing check box to indicate that VAT should be
included in the invoice information.

Select the Include Deal Income in Stock Ledger check box to indicate that deal
income accrual should be written to the stock ledger.

Click Done to save any changes and close the window.
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Edit Vendor Funding Defaults

Navigate: From the Task Pad, select Vendor Funding Defaults > Maintain Defaults. The
Maintain Defaults workspace opens.

%9 Maintain Defaults

I“C—W Maintain Vendor Funding Defaults

| &,
¥endor Type ¥endor Deal Reporting Level | Bill Back Method Bill Back Period Invoice Processing Lo{ Inc ¥AT in Deal Billing| Inc Deal Income in S
Supplier Glassware Products ., [Manth Credit Mote Annual Autematic All Yalues (| O
B 320 supplier

s Ll R it Lo il [onth =l
* Invoice Processing Logic Lgutumauc Al alues E|
* Bill Back Mathod ‘Deh\t Mote E‘
* gill Back Period Lgrmua E|

Include WAT in Desl Billing O

Include Deal Incorne in Stock Ledger  []

Apply

Maintain Defaults workspace

1. On the table, select a vendor. The details area is enabled.
2. Update the enabled fields as necessary.

3. Click Apply to add your changes to the table.

4

Click Done to save any change and close the window.

Delete a Vendor Funded Default

1. On the table, select a vendor.

2. Click Delete. You are prompted to confirm your decision.
3. Click Yes.

4. Click Done to save any change and close the window.
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Promotion Constraint

Maintain a Promotion Constraint

Search for a Promotion Constraint

Navigate: From the Task Pad, select Promotion Constraints > Maintain Promotion
Constraints. The Promotion Constraints workspace opens.

E Maintain Promotion Constraints

I@ Promotion Constraint Search

Class .+

Subclass .+

Zone

Location

| B

[ I&-

Cancel

Maintain Promotion Constraints Workspace

1. Enter or select the criteria to limit your search.

2. Click Search. Your results appear in the Promotion Constraint list.

I@ Promwotion Constraints

Class B -

Sulodloss | B Location

¥ Constraint

B+

L 1&

Promotion Contraint List | &

DepartmentId | Department Class Id Class Subclass Id Subclass Location Id Location Constraint

Fitver byo | ¥ || Fitrer by | W || Eitrer by | ||| Fiter b ||| Firer by ||| Fiter by ¥ || Fiter by Fitrer by w || Fiker by: | w
1005 REPM QA TestD..[1015 RPM QA **ple.. (1025 RFM QA **ple.. (1000000007 Fresno 5| &
1005 RPM QA TestD..[1015 RPM QA **ple.. (1025 RFM QA **ple.. (1000000005 @akland s |
1005 RPM QA Test D..[1015 RPM QA **Ple., [1025 RPM Q4 **Ple.,. (1000000002 Madison - Inclu... 5
1005 RPM QA TestD..[1015 RPM QA **ple.. (1025 RFM QA **ple.. (1000000021 Duluth 5
1005 REPM QA TestD..[1015 RPM QA **ple.. (1025 RFM QA **ple.. (1000000020 aHanda 5
1005 RPM QA Test D..[1015 REM QA **Ple., [1025 RPM Q4 **Ple.,. (1000000013 Buffalo - Includi.. 5
1005 REPM QA TestD..[1015 RPM QA **ple.. (1025 RFM QA **ple.,. (1000000001 Minneapaolis 5
1005 RPM QA TestD..[1015 RPM QA **ple.. (1025 RFM QA **ple.. (1000000022 @mzha 5
1005 REPM QA TestD..[1015 REPM QA **ple.. (1025 RFM QA **ple.. (1000000008 Boston - largere.. 5
1005 RPM QA Test D.. 1015 REM QA **Ple., (1025 RPEM Q4 **Ple.. (1000000013 [lacksonuille 5
1005 RPM QA TestD..[1015 RPM QA **ple.. (1025 RFM A **ple.. (1000000018 Charlestan 5
1005 RPM QA TestD..[1015 RPM QA **ple.. (1025 RFM QA **ple.. (1000000017 Charlotre 5
1005 RPM QA TestD..[1015 RPM QA **ple.. (1025 RFM & **ple.. (1000000000 Fargo 5
1005 RPM QA Test D..[1015 REM QA **Ple., (1025 RPM Q& **Ple.,. (1000000004 Sioux Falls 5
1005 RPM QA Test D..[1015 REM QA **Ple., [1025 RPM QA **Ple.,. (1000000003 Pearia 5
1234 Glassware 1001 Decoration 1005 Gifts 1111111113 |Cent. Web YWH & 3]
1234 Glassware 1001 Decoration 1005 Gifts 5 Cent. Catalog V... 3
1234 Glassware 1001 Decoration 1005 Gifts 2222222524 W, Web WWH 12 3]
1234 Glassware 1001 Decoration 1005 Gifts 7 W, MalueMart U, 3| -
4 3

Promotion Constraint list
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Maintain a Promotion Constraint
1. Search for a Promotion Constraint.
2. Enter the ID of the merchandise level the promotion constraint should apply to, or
click the LOV B+ button and select the appropriate merchandise level
3. In the Location Selection area, select the locations the promotion constraint should
apply to.
=  Zone Group: Enter the ID of the zone group the constraint should apply to, or
click the LOV B button and select a zone group.
=  Zone: Enter the ID of the zone the constraint should apply to, or click the LOV
B+ button and select a zone.
= Location: Enter the ID of the location the constraint should apply to, or click the
LOV B+ button and select a location.
4. In the Constraint field, enter the number of days for the promotion constraint.
5. Click Apply. A row is added to the table.

Delete a Promotion Constraint
1. In the Promotion Constraints table, select the row you want to delete by clicking the

box :I to the left of the row. Press and hold the Ctrl key while selecting to select
multiple rows. Click Select All to select all the rows.

I
Department ID | Department Class Id Class Subclass ID Subclass Location ID Location Constraint
sitter by | w||[Eter by: [w| [mitter by [®|[Fter by [w| [t by [ [mitter e [ [Eter by [w]|[Atter by [w]|[ s by ]
22 DWW warking de..| 1 DW Test Clas.., |1 test subclazs 1 [ 1000001002 Mall of America ZZ
1414 Activewear 1000 Sports Clothes | 1000 Mens Sports . [ 1000000000 Farga 2
1414 Activewear 1000 Sports Clothes | 1000 Mens Sports .. | 1000000001 Minneapalis z
1414 Activewaar 1000 Sports Clothes | 1000 Mens Sports .. (1000000002 Madizon 2
1000 sp s 1000 2z
1414 Activewaar 1000 Sports Clothes | 1000 Mens Sparts .. [ 1000000007 Fresno 2
1414 Activewear 1000 Sports Clothes | 1000 Mens Sports .. (1000000014 Baltimore 2z
1414 Activewear 1000 Sports Clothes | 1000 Mens Sports .. [ 1000001000 |Edina 2
20 Merch Extract., | 201 Merch Ext 1 2001 Merch Ext Sub,.| 1000000000 Fargo 10
20 Merch Extract., [ 201 Merch Ext 1 2001 Merch Ext Sub..[ 1000000001 Minneapolis 10
20 Merch Extract., | 201 Merch Ext 1 2001 Merch Ext Sub,.,| 1000000002 Madison 10
20 Merch Extract., | 201 Merch Ext 1 2001 Merch Ext Sub..| 1000000007 | Fresno 10
20 Merch Extract.. | 201 Merch Ext 1 2001 Merch Ext Sub...| 1000000014 Baltimore 10
20 Merch Extract.,, | 201 Merch Ext 1 Z002 Merch Ext Sub,.[ 1000000000 | Fargo 10
20 Merch Extract... | 201 Merch Ext 1 200z Merch Ext Sub...| 1000000001 Minneapolis 10
zo Merch Extract., | 201 Merch Ext 1 zooz Merch Ext Sub,..| 1000000002 Madizon 10
20 Merch Extract.., [ 201 Merch Ext 1 2002 Merch Ext Sub..| 1000000007 | Fresno 1o
20 Merch Extract., | 201 Merch Ext 1 zoonz Merch Ext Sub,.,| 100000001 4 Baltirmare 10
20 Merch Extract.,., | 202 Merch Ext 2 2003 Merch Ext Sub..[ 1000000000 Farga 10[
[4] 3

Promotion Constraints table
2. Click Delete. You are prompted to confirm your decision.
3. Click Yes.
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